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Foreword

Dear Participants,

First of all, | would like to extend my warm welcome to you all to this in-country training workshop for
Sudan. The Greater Horn of Africa region is a land of contrasts. If you look at the two most common
hazards in the region notably droughts and floods, they are characterized by severe shortage or
excess rainfall, respectively. Disasters pose multifaceted challenges in our region. Drought, for
instance, is a phenomenon that not only puts the lives and livelihoods of the communities in the
region at risk but also destroys the hard-earned development gains of communities and countries at
large. The resources that countries are investing for years in drought disaster response and recovery
could have significant contributions to advance sustainable development. There is a strong need to
put in place all the necessary mechanisms to prepare for and respond to disaster risks. One of such a
mechanism is understating hazards/risk and putting in place monitoring and early warning systems
that would enable us to reduce their adverse effects.

This training is organized with the objective of strengthening the capacity of national DRM institutions
and relevant sector ministries through technical training on hazard assessment, monitoring, and early
warning. Such technical training sessions provide a platform for sharing good practices in DRM
practices among member states. In this five days training, you will have practice sessions and also an
opportunity to discuss recent methods and tools in hazard assessment which are believed to strengthen
your national efforts in disaster risk reduction.

The IGAD/ICPAC DRM Program will continue to support the efforts of Member States to develop
national DRM strategies, regional frameworks to integrate DRM and Climate Change Adaption,
including in the schools’/education curricula and other relevant sectors; from organizing DRM
technical training activities to supporting the incubation of climate-resilient agricultural practices; and
so on.

With those few remarks, | wish you a successful training workshop and | assure you our continued
support to strengthen national DRM institution to achieve effective disaster risk reduction as enshrined
in the global, continental and national DRR strategies and frameworks.

Dr. Guleid Artan,
Director
IGAD Climate Prediction and Applications Centre (ICPAC)
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INTRODUCTION TO GEOGRAPHIC
INFORMATION SYSTEMS (GIS)
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1.1 Theories and Concepts of GIS

Learning Objectives: At the end of this module you will be able to;

e Understand the theory and concepts of GIS

e Get familiar with ARCGIS software along with geo-processing tools and spatial analysis
e Identify main open GIS data sources in relation to Disaster Risk Management(DRM)

e Baseline data analysis and information extraction in ARCGIS

1.1.1 Introduction

Geographic Information System (GIS) helps to manage spatial and non-spatial information in a very
efficient way. Properly managed data and information helps in better territorial planning and decision
making. In GIS, data about real-world objects is drawn quickly and can be displayed using the different
attribute fields stored in GIS databases. A typical GIS data is shown in Figure 1.

Source: Senseable City Laboratory, MIT

1.1.2 Source and Nature of Spatial Data

The sources for spatial data can be from different sources including Field observation/measurement,
GPS based data collection, Remote sensing and software based derivations like map digitization. Now
days Satellite based data acquisition is providing continues image products for almost all areas of the
world at different spatial resolutions. The field based data collection also remain important in providing
ground based accurate measurements which often helps to calibrate space based products.
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1.1.3 GIS Data Models and Coordinate Geometry

The nature of the spatial data can be of vector or raster format. Vector data formats are used to
represent discrete type of data and often represented by point, line and/or polygon. Raster data types
are used to represent continuous data types like rainfall, temperature, topography...etc. The smallest
entity of a vector is a point whereas for raster it is a pixel. The type of data modeling depends on the
nature of the data, scale of the map, and our preference for the analysis that follows. However, it is
good to remember that conversion of raster to vector or vise-versa is always possible although it might
compromise the quality/form of the original data. For example, if you convert a raster to vector the edge
may be generalized and may not follow the exact boundaries. It is highly recommended to avoid back
and forth conversion of your data between vector and raster unless you are required to do so. It is also
worth to remind you the many raster file formats which sometimes creates obstacles to data processing
as all data formats are not compatible to the softwares we may choose to use.

Raster Data Model Vector Data Model

-3-
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Attributes shows characteristics of a feature; any additional information that are associated with each
vector feature such as land cover class or area or administrative division. So every field (column) in an
attribute table refers to the attributes. Raster consists on only of a cell value associated with that pixel.

Coordinate systems: Any data that represent the location/position is called spatial data. The most
common ways of representing spatial data is through the use of X and Y or longitude and latitudes
which are obtained through the system called coordinate system. There are two categories of
coordinate systems and these are Geographic coordinate systems (uses degrees minutes and
seconds) and projected coordinate systems (uses meter as a unit of measurement often with
six/seven digit numbers).

a) Geographic Coordinate Systems

It uses Latitudes (0-900N-S) and Longitudes (0-1800E-W) and the Latitudes are measuring the
distance from the equator( Y-dimension) and Longitudes are measuring distance from Greenwich (X
dimension) either be positive on the north hemisphere or negative on the south Side of the equator are

measured using degrees, minutes and seconds (°, ‘, ).
90°
0
-90°
-180° 0 180°

b) Projected Coordinate Systems

This system by Mercator divides the globe in to 60 grids called zones and uses meter as a unit of
measurement.
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- Universal Transverse Mercator (UTM) System .

1.2 Introduction to ARCGIS

1.2.1 Brief Introduction to Geospatial Technology

Geospatial refers to a technology/advancement made in the areas of spatial data capture, processing,
store, visualize, present and sharing using both hardware, software and methods. The advances made
in space technology opened the way for spatial data capture which revolutionizes the geospatial world.
Recent advances in space born and air borne (including drones) technologies make the way for high
resolution data capture in near real time.

GIS helps to manage spatial and non-spatial information in a very efficient way. Properly managed data
and information helps in better territorial planning and decision making. In a GIS, data about real-world
objects is drawn quickly and can be displayed using the different attribute fields stored in GIS
databases. ArcMap is one of the main component of ESRI’s ArcGIS Desktop software package, and it
is used primarily to view, edit, create and analyze geospatial data. ArcMap allows the user to explore
and analyze data from different datasets, symbolize features accordingly, and create maps.

1.2.2 Learning Objectives

By going through this exercise you will become familiarized with some basic tools and functionalities
of
ArcMap and you will be able to:

> Recognize ArcMap interface and toolbars

Add, Manipulate data layers and attribute tables
Download baseline data.
Label features, create spatial bookmarks and save a map using relative path

Create an Area Of Interest known as AOI.

Y Y VY VYV

Clipping baseline data to AOI.
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1.3 GLOSSARY

Geographic Information System (GIS): A system for capturing, storing, checking and
displaying data related to positions on Earth’s surface. GIS can handle data as several
layers, in two predominant data models.

Raster consists of matrix of cells (or pixels) organized into rows and columns (or a grid)
where each cell contains a value representing information, such as temperature. Rasters
are digital aerial photographs, imagery from satellites, digital pictures, or even scanned
maps.

cell

A
-~

-
-
.\
N\
“\
\

Source: ESRI

Vector consists of geographic features such as point, line and polygon.
Attributes shows characteristics of a feature; any additional information that are
associated with each vector feature such as land cover class or area or administrative

division. So every field (column) in an attribute table refers to the attributes. Rasters
consists on only of a cell value associated with that pixel.

Source: ESRI

Layer Files (layer_name.lyr) saves all of the symbolization (colours, symbols etc) and
labelling that you have defined for that layer. Layer files do not contain the actual
datasets.
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1.4 Basic Geoprocessing and Spatial Analysis

1.4.1 Getting Familiar with ArcMAP

e Start ArcMap by double-clicking on the ArcMap icon on your desktop Q . If anicon is not
present, you can use the Start Menu: Programs > ArcGIS > ArcMap.
e You can specify, whether or not to start with a new empty map, a template or an existing map

We will start this exercise by opening an empty map document:
e Select Blank Map and click OK.

1.4.2 ArcMAP Interface and its main Elements

Your ArcMap window should look similar to the one shown below. Do not worry if the interface displayed
on your screen looks different. The toolbar will probably have a different layout but it may be easily
customized according to your needs.

g& ¥: An initiative of the African, Caribbean and Pacific Group, funded by the European Union and managed by GFDRR United Nations Institute for Training and Research

e Main Standard Tools Céti;log
Bar Menu Window
QUnmled-Au{n'p~m<1mc STers
File Edit View Bookmarks Insert Selection Geoprocessing Customizd Windows Help
Osg@a B x b- 7 EEERRD I QMO L ] 2R Bg
Table Of Contents 3 x < S s
580884 e @ -
= Location: £ L:\Courses|2011-03_CostaRica\Modules ModA2\20s2' v
(&) Home - Documents\ArcGIS
(3 Folder Connections
£ C:\Users\Idelloro
® & E\
# £ L\Courses\2011-03_CostaRica\Modules\ModA2\20s2\Pr:
® &P\
Data # £ TAEOdata
B B \veemehdh
Frames - || ® & \cemunosatos\data
! Toolboxes
and Layers 3 Dotabase Servers
(5 Database Connections
. 3 GIS Servers
Map Display {8 Ineropesity Comnections
(&l Tracking Connections
Table of
Content
(ToC)
@ n <
' 362.282 650.565 Unknown Units
{_ Toggle between Data SEtus
view and Layout view ar

1.4.3 Set Data Frame Properties

From the Data Frame Properties dialog box, you can set the reference scale of your map, map units,
coordinate system and assign a hame to the data frame.
e From table of contents, right click on the data frame name “Layers”

-7-
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e Select Properties > General tab
e Inthe Name section, type “Sudan Data”
e In the Units section, select Decimal Degrees for both Map and Display Units and click Apply

Data Frame Properties =
notation Groups Extent Indicators Frame Size and Position
Data Frame i Coordinate System . Ill‘uminaﬁon Grids
Sien Do J ]
Description:
Credits:

Decmal Degrees w

Dedmal Degrees v

Tip:  See Customize » ArcMap Options > Data View tab for
additional options for displaying coordinates in the status bar

Reference Scale: | <Mone = v ‘
Rotation: | 0 |
Label Engine: Standard Label Engine -

[ simulate layer transparency in legends
[Jalow assignment of unique numeric IDs for map service publishing

o [ o

e Select the Coordinate System tab and notice that no projection is selected
e Expand the Geographic Coordinate Systems > World > WGS 1984
e Click Add to Favorites (so it will be easy to find next time) and click Apply

T v | Type here to search v

Note: To display data correctly, each data frame uses a coordinate system which determines the map
projection. The data frame coordinate system might be different from your layers coordinate system.
ArcMap can project your data on the fly, but it can take longer to draw.

When ArcMap is started with a new, empty map, the coordinate system for the default data frame
is not defined.
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1.5 Working with Baseline data

1.5.1 Add datainto ArcMAP

S

+
From the standard toolbar, click the Add Data button ™
Browse to: X:\Module1\Admin
You might need to connect to the data folder for this exercise by clicking the Connect to

Folder button in the Add Data dialog box A
e In the vector folder, select Sudan_Admin0.shp, Sudan_Adminl.shp and Sudan_Admin2.shp.

You can select multiple files by pressing “Ctrl” key while selecting the files.

O
2 B Sudan_Adminl

Q
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
[HEI=]- - B x|o o b [Bosm [ ZEEE [ edorr ] Dawing~ k O-A-clfdre [0 “[B 1 yulA->- 2
QA il e» E-0 KO /E I NSSTIR oo B
Table Of Contents ax L
EEEL = [?
[ &7 Sudan Data gl
E . o

]
5] Sudan_Admin2
)

[l ArcToclbox | (5 Table Of Contents NI > |
38.97 19.054 Decimal Degrees |

The selected layers are added to the Table of Contents and displayed (if checked) in the Data View.
Layers are displayed with random colors and can always be changed.

1.5.2 Change Layer Color

The layer’s symbol is the point, line or rectangle displayed below the layer name in the Table of
Contents. To change the color or the size of a layer:

e Double click on the symbol(s) below the layer name.
e From the dialog box that appears, select your preferred color.

e You can also edit an existing symbol and save it.

-9-
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1.5.3 Arrange the Table of Content

Data layers are drawn in the order they appear in the Table of Contents. Layers at the bottom are drawn
first and layers at the top are drawn on the top of the map. If a layer on top is hiding a layer underneath

you may not be able to see the lower layer.

In the Table of Contents, you can move a layer up or down by dragging it to the desired position.

1.5.4 Creating a Group Layer

To improve the organization of the different data layers, you can create Group Layers to sort your data
by category. A Group Layer behaves similar to other layers in the Table of Contents. To create a Group

Layer:

e Right click on the Data Frame > New Group Layer

e Right click on the new group layer and select Properties

e Enter “Administrative Boundaries” as Layer Name. You can change the name of the new group

layer by single left click

e Select “Show layer at all scales” and Click OK

e Drag the displayed layers into the “Administrative Boundaries” Group Layer.

1.5.5 Zoom and Pan

Use the ArcMap toolbar to zoom in, zoom out and pan over a region of interest within the data view.

Zoom In

Fixed Zoom Out

Pan

Go Back To Previous Extent
Select Features

Identify

Measure

Tool BT
@ e

ELELY.]
AR wu

O @
=
&
il

2 7
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Zoom Out

Fixed Zoom In
Full Extent

Go To Next Extent
Select Elements
Find

Hyperlink
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Notice that as you move the cursor around the map, the cursor position displayed at the bottom left of
ArcMap window changes respectively.

1.5.6 Labeling Features

Labels are text items on the map that are dynamically placed and whose text values are defined from
one or more feature attributes.

e Right click on one of the admin layers > Properties and choose Labels tab

e Check " Label features in this layer

e Select “Label all the features the same way”

e Select label field that is the most appropriate.

e Click Symbol...

e Select from the Symbol Selector dialog box one of the predefined text labels

e You can always modify your text labels by changing color, size and style. Click OK

e Click Apply and OK

-
Symbol Selector (7=
Type here to searc v @ g 22, CurrentSymbol
Search: @ All Styles (7) Referenced Styles
ESRI - Enugu
L
AaBbYyZz F
Country 1
R Color: @
AaBbYyZz @) arial =
Country 2 Size: 8 v
U s
AaBbYyZz
Country 3
Edit Symbol...
Capital
[ Style References... ]
AsBbYyZz
b [ OK ] [ Cancel ]

e Right click on any layer, check or uncheck label features to have it on or off

-11 -
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| purce  Selection Display Symbology Fields Definition Query élﬁs & Relates Time  HTML Popup
bel )eatures in this layer
Method: Label all the features the same way. v
All features will be labeled using the options specified. »
Text Sting ‘—J
Label Field: l[sm's v |l Expression...
Text Symbol
0] Arial v|[8 v
ABc
H-38 ru
Other Options Pre-defined Label Style
Placement Properties... | Scale Range... [ Label Styles...
Apply
i#
Red Sea
Northem
River Nile
North Darfur

MNorth Kordofan

o r ik
|‘ Kordofan | ¢ outh Kordofan

1.5.7 Creating Spatial Bookmarks

Blue Nile

To save a specific extent of the map, you can use Spatial Bookmarks. Once saved, you can click the
Bookmark button from ArcMap main menu bar, point to the saved bookmark and the map display will
automatically zoom to that extent.

-12 -
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e Zoom to one place of interest (choose any State(s) from Sudan_Adminl.shp)
e From the main menu toolbar, click Bookmarks > Create

e In the Spatial Bookmarks dialog box, type the name of the place you have chosen

e Zoom to full extent o and then click Bookmarks > “placename”

=

2

-

STEP (3)
1.6 Information Extraction

1.6.1 Measure Distances

To measure horizontal distances on your map you can use the Measure Tool.
e Add “Sudan_Capitals” data to ArcMAP from X:\Module1\Admin

e Label the Capitals using “Namel” you can also change point symbols.

+
e From the ArcMap toolbar, click the Measure button

The Measure window opens with the measure line tool enabled as shown below

o -|—|E"r|}('r

{ro measure a distance, draw a line.

To measure an area, dick 'Measure An Area’ then
draw a polygon.

To measure a feature, dick 'Measure A Feature'
then dick a feature.

e Click the Choose Units button and choose Kilometers for distances
e Draw a line between two different Capitals in your layer (Port Sudan and Kassala)
e Click once to fix the line’s starting point and move your mouse to the desired ending point

e You can see the distance automatically appearing in the Measure toolbar

p
ﬂ;‘; What is the Distance between Port Sudan and Kassala in Kilometers?

-13-
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P P B

!ine measurement {Geodesic)
Segment: 468. 263624 Kilometers
Length: 468. 263624 Kilometers

Port Sudan
Dongola

&

Ed Damer

Wad Medani
Gedaref

1.6.2 Identify Features

To display the data attributes of a map feature, click over the feature with the Identify tool.

e Zoom to full extent

e From the ArcMap toolbar, click the Identify button @
e Click inside an y boundary

|dentify
Identify from: .7 Sudan_Admin2

[=)-Sudan_Admin2
Ad Dabba

Location: 31.305510 17.080078 Decimal Degrees ‘ i

Field Value [l
Shape Polygon

OBJECTID 69

State Northern

names_  AdDabba

Arabic_nam aul

Shape_Leng 9.217524

Shape_Area 3.845313

< >

Identified 1 feature

The identified feature temporarily flashes and its attributes appear in the Identify dialog box
e Right click on the layer in the Identify window and click “Zoom to”

-14 -
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e Choose the Identify from: to be the layer that you want to work with

1.6.3 Create an Area of Interest (AOI)

One of the key steps in managing and analysing geospatial data is to identify one or more areas of
interest (AOI) which allows you to focus and limit your search over a specific area.

e Click on Customize menu > Toolbars > Make sure Draw tool is checked

e By using the drawing tool, Click on O - and draw a new rectangle so that Kassala
region/town falls inside the rectangle (Click on the top-left vertex and drag to the vertex in

bottom-right corner)

e From the Drawing toolbar click Drawing > Convert Graphics to Features, activate
“Automatically delete graphics after conversion”. Name the output layer as
“AOIl_Kassala.shp” and save it on: X:\Module1\Output\Vector

Convert:
Polygon graphics w
[#]5elected araphics only (1 selected)

Usge the same coordinate system as:

(®) the data frame

| () this layer's source data:

Graphic Operations »

O Convert Graphics To Features Il{;’ Sudan_Capitals LI

Convert point, line, polygon or the feature dataset you export the data into
text graphics into features in a (only applies if you export to a feature dataset in a geodatabase)

| new shapefile or festure class. () the annatation groups in this data frame

Rl Disabled in layout view, Output shapefile or feature dass:
I_1\Pmctical 1.1"0utput \Vector\ AQI_Kassala shp

[] Automatically delete graphics after conversion

About converting graphics Cancel

e Click Yes in the next dialog box to export the layer.

e From the table of contents, double click in the icon of the layer you just created and change
the layer style to hollow and outline red.

-
‘ ‘;ﬁ
- What is the purpose of creating an AOI layer?
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1.6.4 Select Features

This tool lets you select the features on which you want to perform certain operations (e.g. move, delete,

edit, copy, etc.). You have multiple options for selecting features (i.e. by rectangle, circle, polygon, etc).
e From the ArcMap toolbar, click on the Select Features button e

e Hold down the shift key on your keyboard and select few features in any layer by clicking on
them. In order to make the layer of interest to be the only layer that could be selected, right
click on the layer > Selection > Make this the only selectable layer).

At this stage you cannot edit the selected features (you will learn later how to edit features later), but
you can perform some basic operations such as zoom and pan, clear and switch selection and create
new layers from selected features.

e From the Table of Contents, right click on the feature of interest

e (o to Selection > Create a Layer from Selected Features

-16 -
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Copy
Remove
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Joins and Relates

» Zoom To Layer
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QR ® o

Label Features
Edit Features

Convert Labels to Annotation...
Convert Features to Graphics...

Convert Symbology to Representation...

Data
Save As Layer File...
Create Layer Package...

Properties...

A0 E 2%

©) GFDRR

[RTR———r—

Zoom To Selected Features

Pan To Selected Features

Clear Selected Features

Switch Selection

Select All

Make This The Only Selectable Layer
Copy Records For Selected Features

Create Layer From Selected Features

Opl Create Layer From Selected

""" Features

Create a new layer containing the
selected features

Uncheck the Administrative Boundaries group layer

Right click on the layer created from selection

Click on Zoom to layer

Jj’ Z3)

g/j;?unitar

The layer you have created is stored by ArcMap as a temporary file. If you want to create a new
dataset from the selection you need to export the layer:

Right click on the layer > Data > Export Data...

&
x

@

Copy
Remove

Open Attribute Table

Joins and Relates »

» Zoom To Layer

Visible Scale Range »
Use Symbol Levels '
Selection »
Label Features

Edit Features »

Conven Features to Graphics,,,
Conven Symbology to Representation..,

» Save As Layer File..,

Create Layer Package...

Properties...

[y Biport Data...

Export To CAD...

Export Data

M View Rem D Save this leyer's data as a shapefile
] Viewkem Descripth o geadatabase feature class

¥

In the dialog box, under the title, ‘Use the same coordinate system as’ choose “this layer’s

source data”
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e Save the file in the following location: X:\Module1\Output\VVector

e Name the feature class to export as “ Practice_Selection ”
e Save as type “shapefile” and click save then click OK
A prompt window will ask you if you want to add the exported data to the map as layer

e Click Yes and explore the newly created dataset (zoom in, pan and identify features).
When you are done, remove the two data layers that were created from the selected features

e Right click on the layer > Remove

e Check/activate ™ the Administrative Boundaries group layer

e Right click > Zoom to layer

1.6.5 Working with Attribute Tables

In GIS, a feature on a map may be associated with lot of information (attribute values) stored in a table.
A layer’s attribute table contains a row (or record) for each feature and a column (or field) for each
attribute or category (attribute field).

To explore the attribute of a layer, open its attribute table to select and find features with a particular
value.

e Right click on “Sudan_Admin2” administrative layer
e Click Open Attribute table

The table opens, containing one record for each division. The FID field contains a unique identification
number for every record (or every feature in the map). The intersection of a record and a field is a cell.
A cell contains an attribute value. The total number of records stored in the table is displayed at the
bottom of the attribute table.

With the selection tool, select one or more records/features from either the Attribute Table or the Data
View (from the map).

BRG] Sudan Adrriz) 1
= [ Copy
= O Sudan_Adm X Remove
O o x
[E] Open Attribute Table
2 O Sudan Ad—— - —————— ol
Joins and Relates Open Attribute Table
=) P x
@ [ SON1SV3if] @ Zoom To Layer Open this layer's attribute table.
st | E State names_ _Arabic_nam _ | Shape_Leng [ Shape_Area ~
layer name OR CTRL + T, 1 [Gedaret Butana ) 5952923 1.263774
Visible Scale Range 2|Gedaref AlFao S 2.331669 0.276619
olygon 3|Gedaref Gedaref ) 1713971 0.177795
Use Symbol Levels olygon 3|Gedaref Fashaga =) 5397383 0.700301
Selection , Polygon 4|Gedaref Gureisha =2 2732211 02928
olygon 5|Gedaref Basonda = 2385123 0288643
Label Features olygon 13|Red Sea Dordieb 4.872587 1.148295
W . B
A olygon & |Gedaref V. Gallabat 4576247 0.457053
olygon 7|Gedaref Gala Ainahal 2715101 0.309891
olygon 3| Gedaref C. Gedaref 4612343 0.489257
& Convert Featives ts Grahics.. olygon 10| Gedaref Vafaza 2621192 0.206028
. olygon 11| Gedaref E. Galiabat 1.750576 0.148034
Convert Symbology to Representation... olygon 23 North Darfur Dar As Salam 2084084 0247719
Dats , Polygon 27 |North Darfur s Sireif 3273707 051819
olygon 12|Gedaret ArRahad 3.131498 0.193407 S
> Save As Layer File... - e —— ~—— =
| S
> Create Layer Package... 1 E §13 out of 380 Selected)
iriin2:
& Propeties,. 2

Notice that when a record is highlighted in the table, its corresponding feature is highlighted on the map
(and vice versa).

e Right click on the selected record from the table

e Click on Zoom to selected or Click on this icon ! D@
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To sort attribute values stored in the table:

e Right click on a field name and click Sort Ascending
By clicking on the Options menu on the top of the attribute table, you can perform more operations
such as Find and Replace, Select by Attributes, Clear Selection, Switch Selection, Add Data, and so
on.

1.6.6 Advance Selection

The Select by Attributes dialog box allows you to select features on a given layer using a SQL
expression.

e From the Main Menu Toolbar, click Selection > Select by Attributes
The Select by Attributes dialog box appears

e Select “Sudan_Admin2” under Layer

e Select Create a new selection

e Select the attribute field “State” and

e Double click on “State” , click “ =" and click on Get Unique Values.

A list with all the values will appear. Double
click on an area of interest from the right.
Scroll down to find your area of interest e.qg.
“Kassala”.

In the dialog box below, the expression should "EID" | NI

appear as follows: "State" = "Kassala” (Choose
a State of your interest, Ex: “Blue Nile”).

& Sudan_Admin2 v
[ TORNSHOW SEIECTDIE Tayers T TS 1S

e Click Verify and then click OK
e Click Apply

‘Blue Nile’ A
Central Darfur’

e From the Main Menu toolbar, click ‘East Darfur

Selection > Zoom to Selected Features. 2 i [y s
e Click Clear Selection and then Full —i[® 16| [Nt
Extent s | [ | [N A
SELECT * FROM Sudan_
"State" = 'Kassala’

The Select by Location dialog box lets you select features based on their location relative to other
features. You can use a variety of selection methods to select the point, line, or polygon features in one
layer that are near, or overlap the features in, the same or another layer.

We will now select populated places that are located inside our boundary.
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e From the standard toolbar, click the Add Data button. Alternately you can also drag and drop
using the Catalog Window.

e Select the Sudan_settlement.shp from the vector folder under Input (same as above).

e Using either the selection tool or the Select by Attributes dialog box, select a feature (in this
case, any country) from the Sudan_Adminl.shp layer.

e From the Main Menu toolbar, click Selection > Select by Locations

The Select by Locations dialog box appears:

e Select features from “places” data layer, choose Source Layer as Sudan_Admin2.
Make sure that Use selected feature box under the source layer is checked.

e Under Spatial selection method for target layer feature(s) choose “intersect the source layer
feature”
e Click OK

Select features from one or more target layers based on their location in
relation to the features in the source layer.

Selection method:
select features from v

Target layer(s):

rative Boundaries
[0 Sudan_Admin2
O Sudan_Admin1
[0 Sudan_Admin0

[[Jonly show selectable layers in this list

ISource layer:

12> Sudan_Admin2 L]
eatures “ (11 features selected)
patial selection method for target layer feature(s): ]
3 7
intersect the source layer feature v ]
Apply a search distance

0.200000 Decimal Degrees
[ 7 [ o=

e Click Selection > Zoom to Selected Features

About select by location

e Right click on places > Open Attribute Table

e Click Selected (at the bottom of the Attribute Table) to display in the table only selected

attributes.
This is how your map should look (of course, depending on the country of your selection):
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A
Table O x
ERE- LR R
- places X

FID | Shape | osm_id | code fclass population name A

» | 102 |Point 300066939 1001 | city 436000 | ==
108 | Point 321230444 1003 |vilage 0 |\ e Sebderat
110 | Point 321230811 1003 |vilage 0 [ = L= Aligider
111 | Point 321230831 1030 | farm 0 |Barattolo cotton plantation
197 |Point 1150887470( 1050 |locality 0 |Khumera
200 | Point 1150890807| 1050 |locality 0 |Sidr
208 |Point 1150899820 1050 |locality 0 |Rauiyan-Shet
224 (Point 1150920352 1050 |locality 0 |Khor El Boval
226 | Point 1150820587| 1050 |locality 0 [Khor Elm El Ahdar
402 | Point 2050780659 1002 |town D [dazis
D67 | Point 2487361785 1002 [town 0[S e
968 | Point 2487357426{ 1002 [town 03 <ol o
968 | Point 248735744‘31 1002 town 01yl L=
570 | Point 248?357659| 1002 [town 02 —ijpal e
1452 | Point 2323423335{ 1003 |vilage 0 |Maktab Ziraai v

o4 1 55|/ (75 out of 3250 Selected)

e Click Clear Selection button and then zoom to full extent

1.6.7 Joining Tables

Attribute tables contain predefined fields that hold data on geometry and the object ID. We can also
add excel table into ArcGIS workspace and view the table. This table can be joined with existing layer
or converted into a shape file.

Exercise

In this exercise you will be joining the 2010 Sudan population data to the level 1 (State) administration
boundary polygons.

e Add “Sudan_Adminl”and “StatePop2010” data to ArcMap from this location;
X:\Modulel\Baseline

Attribute tables for feature layers are automatically loaded when the layer is added to the map. Tables
without associated features only show up on the Source tab of the ArcMap table of contents.

Join the attributes of the “StatePop2010” table to the Attribute table of “Sudan_Admin1”.

e Right-click the layer or table you want to join (Sudan_Adminl), point to Joins and Relates >
click Join.
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Table Of Contents B x
%[0e 8 H
= = Layers P
= B3 EATRAININGS\UNOSAT ncountry\test
= Bl Copy

& B3 EnTRAINIY X Remove
B StatePq ] Open Attribute Table

Joins and Relates 3 Join. ”
.’32 Zoom To Layer Remnove Ininf<) N
Zoom To Make Visible Join

Join data to this layer or
standalone table based on a
Use Symbol Levels common attribute, spatial
location or existing relationship
class.

-

Visible Scale Range

-

Selection

Label Features >

-

Edit Features

e Click the first drop-down arrow and click Join attributes from a table.

e Click the second drop-down arrow and click the field name in the layer “STATE” on which the
join will be based.

e Click the third drop-down arrow to choose the table to join to the layer “StatePop2010.txt”.

e Click the fourth drop-down arrow and click the field in the table on which to base the join
“Region”.
e Click OK

Join lets you append additional data to this layer's attribute table so you ca@ —
for example, symbolize the layer's features using this data.

|2 statePop2010.6ct o
[ Show the attribute tables of layers in this list \j

3. Choose the field in the table to base the join on:

Join Options —t,
(® Keep all records
All records in the target table are shown in the resulting table.

Unmatched records will contain null values for all fields being
appended into the target table from the join table.

(O Keep only matching records

If a record in the target table doesn't have a match in the join
table, that record is removed from the resulting target table.

Validate Join

About joining data Cancel
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Open the attribute table of “Sudan_Adminl”. The attributes of the table are appended to the layer's

attribute table.

Table O x
B2

Sudan_Admin x
FID Shape * OBJECTID STATE name_arabi | Shape_Leng | Shape_Area Region TotalPop2010 ~

3 0 |Polygon 1|AlGezira Bl 8.7875811 2285638 Al Gezira 4001512

1 |Polygon 2 |Blue Nile Sl el 8.844899 3.160318l Blue Nile 81361

2 |Polygon 3 |Khartoum It 7.4043587 1. 790478 Khartoum S010186

3 |Polygon 4 |River Nile i e 17.850892 11.090258 River Nile 1448515

4 (Polygon 5 [Northern ERPE] 26.188226 31.3562 @ Northern 913256

5 |Polygon & |Morth Kerdofan B f Jas 19.179364 15.71 North Kordofan 2421785

G |Polygon 7 |Sennar o 12.368708 3.27927 | Sennar 1878368

7 |Polygon & |South Kordofan JEEF-REyLrY 11197204 5492 South Kordofan 1678253

& |Polygon 9 |White Nile < Jall 10487477 3.169574 White Nile 2164757

5 |Polygon 10 [Kaszala - 11.347523 4328 Kazzala 1944551

10 |Polygon 11|Red Sea [ 2370318 18572408 Red Sea 1636952

11 [Polygon 12 |Gedaref = il 12.40815 4.803 Gedaref 1166212

12 [Polygon 13 [Morth Darfur B s 27.508673 25. 740659 North Darfur 2224158

13 |Polygon 14 |Central Darfur SESEE ] 9317568 2.74517 @ Central Darfur 864759

14 [Polygon 15 [West Darfur L 5.185825 1.85517 48 West Darfur 1116456

15 [Polygon 16 |East Darfur BT B ARryL] 10.947125 4 47950 East Darfur 1096009

16 [Polygon 17 [South Darfur R 14.151857 6.91007 4 South Darfur 2003856
u 17 |Polygon 18 |West Kordofan LA e 14.576453 9470478 West Kordofan 1787485 w

o4 1 v » [E|S ] 0outof 13 Selected)

Sudan_Admin

e To sort values in an attribute field right-click the selected field's heading and click Sort
Ascending or Sort Descending.

2421794 ¥ Statistics...

. Table
BRI AL
Sudan_Admini
FID Shape* | OBJECTID STATE name_arabi | Shape_Leng | Shape_Area Region

0 [Polygon 1| Al Gezira el B8.787811 2285832 |Al Gezira
1|Polygon 2 |Blue Nile el B8.544899 3.160318 | Blue Nile
2 |Polygon 3 |Khartoum a5l 7.404357 1.790472 |Khartoum 501016{1
3 |Polygon 4 |River Nile bl 17.850992 11.080262 | River Nile 1446611
4 (Polygon 5 |Morthern el 25188226 31.358621 Northern 913254
S [Polygon & |North Kordofan B2 s 19.175354 15.7158 |Merth Kordofan
5 |Polygon 7 |Sennar o 12.368708 3.2759271 | Sennar 1878368
T |Polygon 2|South Kerdofan 21 E g 11.187204 5.492568 | South Kordofan 167825
8 |Polygon 9 |White Nile 1 Jall 10.487477 3.169576 | White Nile 2164757
S |Polygon 10 |Kassala e 11.347523 4325729 |Kassala 194465

Which state has the highest number of Population?

Which State has the least number of Population?

Advanced Sorting...

Summarize...

NOTE: You may want to remove the current join from “Sudan_Admin1”to do so, here is the procedure;
e Right-click the layer containing a join you want to remove and point to Joins and Relates.
e Point to Remove Join(s) and click the join you want to remove “StatePop2010.txt”.

=) o BT RAININ

B StatePog

Kemove

Open Attribute Table

I

Joins and Relates

Join...

% Zoom To Layer

Visible 5cale Range

1en Corembund | meenle

| Remove Join(s)

d|

Relate...

Remove Relate(s) »

StatePop2010.ct

Remove All Joins

r
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1.7 Basic Geoprocessing and Spatial Analysis

Rational: The main rational for using geoprocessing tools and spatial analysis is to try to answer some
spatial questions which are necessary to get more information out of your data to make an informed
decisions.

Geoprocessing: refers to an activity or set of activities in GIS used to manipulate spatial data. A typical
geoprocessing operation takes an input dataset, performs an operation on that dataset, and returns the
result of the operation as an output dataset. All data preparation and manipulation can be called
Geoprocessing. We will see some of the most important tools under this topic which really helps you
answer spatial questions. There are hundreds of tools in QGIS to handle the various chores of a day to
day GIS activities.

1.7.1 Spatial Analysis

The rationale for spatial analysis science is to understand the spatial distribution, variation, interaction
and relationships of features or phenomena. According to Carleton College definition spatial analysis
is a set of techniques for analyzing spatial data. The results of the spatial analysis are dependent on
the locations of the objects being analyzed. Software that implements spatial analysis techniques
requires access to both the locations of objects and their attributes. The other description is from ESRI
“Spatial analysis is how we understand our world—mapping where things are, how they relate, what it
all means, and what actions to take. From the computational analysis of geographic patterns to finding
optimum routes, site selection, and advanced predictive modeling, spatial analysis is at the very heart
of Geographic Information System (GIS) technology.”

The goal of the spatial analysis is to answer spatial questions which might be related to location, pattern,
change, scenarios and others. GIS software’s are designed to provide a state of the art tools to process
data and answer such complex space based questions.

There are hundreds of tools under the QGIS toolbox to help you carry out spatial analysis, however, it
is very important to first design a methodology or a model which needs to be supported with scientific
methods to reach at a conclusion.

1.7.2 Buffer Analysis

Buffer analysis is one of the most important Geoprocessing tools that help to identify proximity of
places from a reference layer. For instance, if you wish to identify road networks with in 3km of water
points you can easily identify them. Let’s create a buffer of 300m from a river and see how far people
should build of farm from the river.
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e Add the layer for River to ArcMap
e Click on Geoprocessing from the Menu Bar > then Click on Buffer

Q Untitled - ArcMap

File Edit View Bookmarks Insert Selection Customize

Ded& Bx|oc(b-
CYCNI- IEHR R R

Geoprocessing Wind
Buffer i % ; Editor - ; Drawing = K (= - A~ IE
o 3 [ ooz

s Help

Buffer

Intersect
Geoprocessing tool that creates
buffer polygons around input

features to a specified distance.

Union

Table Of Contents q

Merge

% Mizsnhee T

e Under Input Features select “Rivers”

e Save Out Feature Class as River_Buffer.shp X:\Module1\Output\VVector
e Linear Unit should be 300 meters > Click OK

e Zoom in to one river line to see the buffer area of 300m.

nput Features ~

| Rivers

G:\Sudan_Daiod_:l‘l,Ouu:ut\,\l'ector\,Riuers_Buffer.shp' | E-
Distance [value or fiel l

(®) Linear unit
| 300 | Meters w

O Field |

Side Type (optional)
|ELL i |

End Type (optional)
[ RounD v|

Method {optional)

PLANAR |
Dissolve Type {optional)

NONE v|

Dissolve Field(s) (optional)
O Fn
[ oBIECTID_1
[] oBIECTID
] name
[ navigaTION
[] orDER _
[ aGENCY
[ shape_Lena v
[ shane 12 1

Cancel Environments... Show Help ==

G
N What are the different areas this can be used?

ﬂfu
¥ What if we want deferent buffer distance like 1km, 5km, and 10km to show from most to least
areas at risk of flood hazard?
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1.7.3 Multiple Ring Buffer

Multiple Ring Buffer allows us to create multiple buffers at
specified distances around the input features. The different levels
of buffer distances can be used to define different elements at

risk.

e Click on Search tool and type Multiple Ring Buffer.
¢ Click on the Multiple Ring Buffer (Analysis) tool.
e Under Input Select Rivers

Bl O GFDRR

ACP-EU Natural Disaster Risk Reduction Program“‘i\it‘b

An initiative of the African, Caribbean and Pacific Group, funded by the European Union and managed by GFDRR United Nations Institute for Training and Research

7z
V&R

&unitar

Search 1>
«EV|@:||§' Local Search ~

ALL  Maps Data Tools Images

multiple ring buffer Q

Search returned 1 items v SortBy v

g Multiple Ring Buffer (aAnalysis) (Tool)
ates multiple buffers at specified distances arou...
olboxes\system toolboxes\analysis tools.thy\proximi...

e Save the Output as “River_Mult_Buffer.shp” to the path X:\Module1\Output\Vector
e Under Distances give the following three levels, 1, 5, and 10 km. Type each and click on the

plus button (+).

e Change the Buffer Unit option to Kilometers >> Click OK

e Now Zoom in to River_Mult_Buffer and see the different levels of Buffer distances.

Input Features

| Rivers

Qutput Feature

——

Table Of Contents

uffer Unit (optional)

Kilometers

distance

Dissolve Option {optional)
ALL

Outside Polygons Only {optional)

Environments. .. Show Help >>

= SEER
= Rivers

= Rivers_MultipleRingBuffer
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1.7.4 Intersect

This is an important geoprocessing tool to find the intersection between two or more layers. It has a
practical application, for instance if you wish you identify the total length of a railway line in the different
states of Sudan intersect works well.

Steps

e Open ArcMap and open railways layer and Sudan_Adminl from X:\Modulel\Baseline _data
and Admin/ folder respectively

¢ Now go to windows in the main menu and click on search. Key in intersect and search and
then open the intersect (analysis) tool

e Now give railways layer and Sudan_Admin1l as intersect features

e Save the Output feature class to X:\Module1\Output folder with the name railway_state.shp
and click Ok.

¢ Now you can open the attribute table of the railway_state.shp to see that the state names are
attached to the railway table. This means that you can also calculate the distance of a railway
line in each of the states. You can classify the railway_state.shp to see the railway map | each
states.

1.7.5 Merge

Merge is another important tool for combining two or more layers. This tool provide an opportunity to
compile data of similar nature. Take for instance five GPS survey crew working to collect oil well data
from the different parts of Sudan came up with their respective data layers. Now if you wish to merge
all the data layers in to one Sudan oil well data you need merge tool in ArcGIS.

Let's merge the roads and rail way layers in Sudan to show the transport infrastructure of Sudan.
1. Add the roads and railways layers from X:\Module1\Baseline_data
2. Search for a tool merge and open. Set the roads and railways as inputs layers
3. Save the Output feature class to X:\Module1l\Output folder with the name
transport_infrastracture.shp and click Ok
4. If you open the layer, you will notice that the two layers and their attribute tables are combined.

@ Uniites - Acchap

Deda B x| 0o b [
File Edit View Bookmarks Insert Selection G
CICE AN BH-HE ] Wl - L3 ) ] S o railways = [ B @[50 [F]g | Clasification -

Table Of Contents.
@ L
Layers . ,,;:_‘/‘ -
[ Sudan Settlements N & [ N e

41555 140
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1.7.6 Saving a Map

After you finish working on a map, you can save it and exit ArcMap. ArcMap saves your map as a
project document (.mxd). The Home folder available in the Catalog window is used by default in ArcMap
to save results, store new datasets, and to access file-based information. In addition, each map
document has a default geodatabase, which is the home location for the spatial content of your map.
This location is used for adding datasets and for saving resulting datasets created by various editing
and geoprocessing operations.

If you haven't saved the map project before and you want to save it into a desired folder location:

e Click File > Save As.
e Enter the name “Modulel_Intro_ArcMap.mxd” and save it on: X:\Modulel\Workspace

Savein | Workspace v | (< G il g | ar
~
i Mame Date modified Type
Mo iterns match your search,
Cuuick access
Desktep
Libraries
This PC
L >
Metwork
File name: Madule1_Intro_ArcMap mxd ~ | I Save
Save as type: ArcMap Document ~ Cancel

® STEP (4)
1.8 Open GIS data Sources

In the aftermath of a disaster it is very important to collect and review disaster related information from
media reports, OCHA situation reports, reports from government and local authorities. This would
enable you to get an understanding about the type and magnitude of the disaster event which is very
useful before doing any kind of geospatial analysis. When a first review of available disaster- related
information is completed, you can start searching and gathering relevant geo-data (i.e. pre and post
disaster satellite imagery and GIS baseline data) to be used for GIS analysis and mapping.

1.8.1 Baseline Geospatial Data for Disaster Risk Assessment

This section presents a list of free and commercial spatial available for download. Explore and
download some GIS and EO data by browsing different geospatial data portals, which provide access
to useful data sets for emergency response mapping.
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Y
==

Web Portal Web Link Data Description Data Type
ICPAC- http://geoportal.icpac.net/ Free regional data Vector/Raster
Geoportal
ArcGIS Online http://www.esri.com/software/arcgis/a Free online imagery, Web map, not

rcgisonline relief, topography, road editable, only
networks visual
Giovanni http://giovanni.gsfc.nasa.gov/giovann Free Precipitation data TIFF
il (TRMM, GPM)
MODIS Rapid http://earthdata.nasa.gov/lance/rapid- Free imagery from Multiband
Response response MODIS sensor raster
System
Digital Globe http://www.digitalglobe.com Commercialsatellite Preview
very high resolution imagery can be
imagery downloaded
USGS http://earthexplorer.usgs.gov Free Landsat, ASTER, Raster
earthexplorer SRTM, MODIS
Open Street http://extract.bbbike.org/ Free Baseline data Vector
Map OSM
Humanitarian https://data.hdx.rwlabs.org/ Free Baseline data Vector/Raster
Data Exchange
Sentinel https://scihub.copernicus.eu/dhus Free RADAR and high Raster
Scientific Hub resolution OPTICAL
data
WorldPop http://www.worldpop.org.uk/ Free Population data Raster
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MODULE: 2
INTRODUCTION TO EARTH
OBSERVATION/REMOTE SENSING
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2.1 Theories and Concepts on Earth Observation/Remote Sensing

2.1.1 Introduction

Remote sensing is a valuable data source to obtain information about the surface of the Earth. Several
platforms have been historically used to collect data, starting from kites to balloons, airplanes,
satellites and very recently, unmanned aerial vehicles. The applications of remotely sensed data are
extremely broad, and it is increasing exponentially due to recent improvements in data resolution and
availability.

In this module, we will explore the basics of remote sensing and how ArcMap tools could be used to
perform basic image pre-processing such us Composing, Mosaicing, and Clipping.

8 : = -

\ e~
3 i < — %
| ﬁ?’ AL
"

Wi a

10N

0 e DUSE Ve

Flooded areas over Khartoum State, Sudan. Image Source: UNOSAT

Learning Objectives

By going through this exercise you will be familiarized with basic image pre-processing involved in
remote sensing and you will be able to:
> Understand the concept of Remote Sensing.

Download Sentinel-2 data from the Web.
Load satellite imageries into ArcMap.
Perform band combinations (Composing).
Mosaicing for different screens.

Clip raster data with using AOI.

v YV VYV VY

Perform unsupervised/supervised image classification
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2.2 GLOSSARY

Remote sensing is the science of collecting and interpreting information about the
environment and the surface of the earth from a distance, primarily by sensing radiation that
is naturally emitted or reflected by the earth's surface or from the atmosphere, or by sensing
signals transmitted from a device and reflected back to it.

Platform is the structure or vehicle on which the remote sensing instrument (sensor) is
mounted.

Sensor is the instrument that detects and conveys the information that constitutes an
image. Sensors are of two primary types active and passive.

Active sensors provide their own source of energy to illuminate the objects they

observe. Example: Radio Detection and Ranging (RADAR) and Light Detection and
Ranging (LIDAR)

Passive sensors detect sunlight radiation reflected from the earth and thermal radiation
in the visible and infrared of the electromagnetic spectrum. They measure signals at
several spectral bands simultaneously, resulting in so-called multispectral images. When
an image consists only of one band, it is called panchromatic image.

The electromagnetic (EM) spectrum is the range of all types of EM radiation. Radiation
is energy that travels and spreads out as it goes — the visible light that comes from a lamp
in your house and the radio waves that come from a radio station are two types of
electromagnetic radiation.

The Electromagnetic Spectrum

wavelength (1 rara) (1)
()10 107 10* 10% w02 w! 1 10 10? 10® 10t 10° 10 10" 10® 10°
g aa b E: égé =2 ?é o
E g G srs 8 58 3%%
2 ﬁ aF & :b§ 5
g & & = =

after Lillescand and Kiefer, 1994

Resolution: Spatial (pixel size), spectral (wavelength interval size and number of intervals
or bands), temporal (amount of time needed to revisit and acquire data for the exact same
location), and radiometric (ability to detect differences in brightness).

Band: Multispectral remote sensors capture image data at specific frequencies across the
electromagnetic spectrum. When a multispectral sensor captures a scene, all data captured
at different range of electromagnetic spectrum are saved in different digital raster files. Each
of these raster refers to a specific band.
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Normalized Difference Vegetation Index (NDVI) is one of the most common indices used
to assess vegetation from satellite data. It is a uniqgue band combination that takes
advantage of the high reflectance properties of vegetation in Red and Near Infrared bands
(NIR).

2{“' STEP (5)
2.3 Image Pre-processing

Image Pre-processing is done prior to data analysis, it’s carried out to correct for any distortions. These
procedures include radiometric correction to correct for uneven sensor response, Geometric correction
to correct for geometric distortion due to Earth’s rotation or to conform to a specific map projection
system and Image Georeferencing where Ground Control Points (GCP’s) are used.

2.3.1 Searching, exploring and downloading sentinel-2 imagery

From the Earth Explorer https://earthexplorer.usgs.gov/ you can download radar and optical data.
For first time users, you need to register and create an account. Make sure you select Sentinel-2
satellite or Landsat 8 on the data search, specify the cloud cover percentage and define area of interest.

bcience for a changing world o = ‘.
Steps

arthExplorer - Home

Home Save Criteria Load Favorite » Manage Criteria

IEZEXEETN | oatasets | Adaitional Criteria || Results T P 1) Enter Sea rch Criteria
1. Enter Search Criteria

To narrow your search area: type in an address or place : f “ \ : 2) Deﬂne Area Of Inte I‘est
name, enter coordinates or click the map to define your R e s P e
: : 3) Set the date Range
4) Select the data Sets —
i.e Sentinel-2 or Landsat 8

search area (for advanced map tools, view the help
documentation), and/or choose a date range

PathRow | Feature

== dditional Criteria, select cloud cover 9
[ reommores e 5) Additional Criteria, select cloud cover %
[ Deseeinsersecns JEZT 6) Results —displays the available images
‘1 Lat: 14 10'01" N, Lon: 033° 11 18" E /R as per the set parameters
2. Lat: 14° 10' 01" N, Lon: 039° 52' 31" E /%

ID:L1C_T36PYS_A017192_20181007T080716

3. Lat: 07° 43'27" N, Lon: 039° 52' 31"E /R
4. Lat: 07° 43'27"N, Lon: 033° 11'18"E /R

™| Acquisition Date:2018/10/07
Platform:SENTINEL-2A
2 . Tile Number:T36PYS
"\
Ydd /L AV

ID:L1C_T37PBQ_A017192_20181007T080716

Acquisition Date:2018/10/07
4 Platform:SENTINEL-2A
3 Tile Number:T37PBQ
- Ydd /AW

ID:L1C_T36PWR_A017192_20181007T080716
W | Acquisition Date:2018/10/07
Platform:SENTINEL-2A
& Tile Number:T36PWR
purchase or for for refere = .
Ydd¥ I av0

Click on the download option

D R e
T Resutt options

Search from: |mm/ddlyyyy 2 to: [mm/ddlyyyy

Search months: (all) -

I e

For Sentinel-2 data, the downloaded product contains multiple folders. Within the Granule folder you
will find all the subsets that conform the whole scene downloaded. Each folder (subset) contains (within
the IMG_DATA folder) the 13 raster layers (13 spectral bands) for such subset. Layers 4,3,2 and 8 are
the Red, Green, Blue and Near Infrared(NIR) respectively.
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2.3.2 Compositing, Mosaicing, and Clipping

Image Composing allows you to combine raster bands to create various RGB band combinations.
e In ArcMap, navigate to Geoprocessing > ArcToolbox > Data Management Tools > Raster
> Raster Processing > Composite Bands.
e Click the browse button and search for the desired input raster bands.

ArcToolbox O x & Composite Bands
+ %5 Feature Class ~
+ & Features Input Rasters
+ & Fields |
+ B File Geodatabase
+ By General D:\WUNITAR \Training'Sudan_21st to 25th October 2018\Images\Sudan'\S2A_MSIL1C_20180907T...
¥ % Generalization D:\WUNITAR \Training'Sudan_21st to 25th October 2018\Images\Sudan'\S2A_MSIL1C_20180907T...
+ % Geodatabase Administration D:\WUNITAR \Training'Sudan_21st to 25th October 2018\Images\Sudan'\S2A_MSIL1C_20180907T...
+ B Geometric Network
+ & Graph
+ B Indexes
+ & Joins
+ B LAS Dataset
+ & Layers and Table Views

|
u]
X

[€] 2] [x] [#] [@]

+ B Package Output Raster

¥ & Photos | D:WUNITAR Training\Sudan_21st to 25th OdnberZDlsumages\Sudan\SZA_MSIL1C_2018090?'I‘0?5611| IEI
+ & Projections and Transformations

= & Raster

+ B Mosaic Dataset
+ By Raster Catalog
+ By Raster Dataset

=] @ Raster Processing OK | | Cancel | |En\-'|ronmems... | | Show Help ==
#, Clip
& Compaosite Bands
Output Rast x
#, Compute Pansharpen Weights LR
;\ Create Ortho Corrected Raster De Look in: |EIMG_DATA v‘ b3 £ By On By
;\ Create Pan-sharpened Raster Dat
#, Extract Subdataset and1,jp2 5 Band7 jp2
#, Raster To DTED and10jp2 ﬁaandsdp_z
"k Resample and11.jp2 5 BandaA jp2
., Split Raster and12,jp2 B Bando jp2
=1 B Racter Pronerties v and2,jp2 8 T37PBT_20180907T075611_TCljp2
< > and3,jpd
andd.jp2
and3.jpl
andf.jpd
Narme: ‘ Imagel 432 | | Save ‘
Save as type: ‘Raster datasets v| | Cancel ‘

Another option is to use the Composite button in the Image Analysis window,
e Load the different bands in ArcMap in our case bands 234 > Navigate to Windows >
Images Analysis
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e o
= 11 Image Analysis
= £ layers LB §
= @ T37PBS_20180922T075619. B02jp2 | [ | V1 @ rapes_201s002zro7s619_s02, 2| | -S€lect the
Value [Vl @ T37pBS_20180922T075619_B03.jp2
Highi:3203 | | (V19> 137785 _20180922T0756 19_B04.jp2 bands y.ou
3 would like to
Low: 0 P
composite
= B T37PBS_20180922T075619_B03,jp2
Value = .
High 3304 . -Then click on
Low:0 = j Layer merge
Icon =
= B T37PBS_20180922T075619_B04.jp2
Yalue
;Ilgh :3831 Clora Dlreptis
Low: 0 [[Background

Percent Clip v| M
Nearest Neighbor

+§ 3 500

<
Processing

Layer Merge Icon

A multi layered true color image is automatically displayed, composite the other image provided using
the same procedure above.

Note: The composite image is added as a temporary layer. To save the output layer as a raster
dataset, click the export button on the Image Analysis window and specify the output location.

Image Mosaicing allows you to combine two or more images into one.
¢ Navigate to Geoprocessing > ArcToolbox > Data Management Tools > Raster > Raster
Dataset > Mosaic
e Click the browse button and load the two images.
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1aie Ut Lontents -

R R 1) S A

2s8|3 ArcToolbox oxf| “ Mossic
B = Layers # & File Geodatabase ~
Composite_T37PI 1809227075619, i & General Input Rasters.

# & Generalization

MM Red: Band_1 & Geodatabase Administration —
[ Green: Band_2 @ & Geometric Network < Composite_T37PBT_20180907T075611_B02.jp2
MEBlue Bond 3 5 & Graph & Composite_T37PBS_20180922T075619_B02.02
= [ Composite_T37PBT_20180907T075611_B02,jp2 # & Indexes
RGB @ & Joins

MNRed: Band_1 5 & LAS Dataset
[0 Green: Band_1 5 & Layers and Table Views L]
MM Blue: Band_1 = & Package
& [ Composite T37PBS_20130922T075619_B02jp2 = & Photos
RGB # & Projections and Transformations
Red: Band_1 = & Raster

reen: Band_1
M Blue Band_1
= [ T37PBT_20180907T075611_B02jp2

5 & Mosaic Dataset
& & Raster Catalog
= & Raster Dataset

Value #, Copy Raster

High: 2574 4 Create Random Raster
4 Create Raster Dataset

Low: 1015

“, Download Rasters
“#, Generate Raster From Raster Function
Mosaic
“, Mosaic To New Raster
#, Raster Catalog To Raster Dataset
“#, Workspace To Raster Dataset
& Raster Processing
&y Raster Properties
@ & Relationship Classes
@ & Sampling
i & Subtypes
& & Table
# & Tile Cache
# & Topology
# & Versions.
Value & & Workspace
High: 3203 @ Data Reviewer Tools
. @ Editing Tools

= [ T37PBT_20180907T075611_B03p2

Value
High: 2765

Low:973

= [ T37PBT_20180907T075611_B04,jp2

Value

High : 3407
= [ T37PBS_20180922T075619_B02.jp2

Low: 722

Low:0

= [ T37PBS_20180922T075619_B03p2

Value

High: 3394

Low: 0

Image Clipping allows you to clip a smaller area of interest from a bigger Image.
e Create an Area Of Interest (AOI) by drawing a polygon shapefile. Use it to clip the Image that
you have just mosaicked.
¢ Navigate to Geoprocessing > ArcToolbox > Data Management Tools > Raster > Raster
Processing > Clip

Table Of Contents. oo =
ool Ciip

8.08|2 # & Photos.
WA Layer = & Projections and Transformations InptRaster

=R ] I:Alm = & Raster [Composite_T37PBS_20180922T075619_B021.tif

5 & Mosaic Dataset
= B Composite T37PBS_20180022T075619_B021.tif & g S Output Extent (optional)
iy 9 [DAUNITARTrair 215t to 25th

MMRed: Band_1 5 & Raster Dataset =
ed: Ban
i = & Raster Processing s .
‘ ¥ Maximum
reen: Band_2 ol

= O Composite_T37PBT_20180907T075611_B02,p2 £ Compute Pansharpen Weights
RGB

4, Create Ortho Corrected Raster Dataset bl
M Red: Band_1 ., Create Pan-sharpened Raster Dataset 261816.07265 | | 277691.612717 |
reere Bandi] #, Bxiract Subdataset
MBlue Band 1 3  Raster To DTED " Hinimam
= [0 Composite_T37PBS_20180922T075619_B02,jp2 “ Resampl
ple 1693198.0643%8
RGB %, Split Raster |
M Red: Band_1 5 & Raster Properties [] Use Inpus Features for Cipping Geomelry (optiona)
reen: Band_1 # & Relationship Classes
W Blue: Band 1 . Dataset
e A = & Sampling I e
= [0 T37PBT_20180907T075611_B02jp2 5 & Subtypes C
Value . NoData Value (optiona]
High: 2574 @ Table
igh: i [214738%47
o0l # & Topology [[] Maintain Cipping Extent (optional)

# & Versions
i & Workspace
@ Data Reviewer Tools

= [ T37PBT_20180907T075611_B03jp2

Jf": -12755 = @ Editing Tools
e @ Geocoding Tools
Low: 973 = @ Geostatistical Analyst Tools

i @ Linear Referencing Tools
= @ Multidimension Tools

= [J T37PBT_20180907T075611_B04jp2 5 @ Network Anslyst Tools

Value 8
High : 3407 % @ Parcel Fabric Tools

@ @ Production Mapping Tools
Low: 722 % @ Schematics Tools

= @ Server Tools

"| @ EP Space Time Pattern Mining Tools
& O T37PBS_20180922T075619_B02p2

Value
I High: 3203

Low:0

= [ T37PBS_20180922T075619_B03jp2

Value

High' 3394
& O T37PBS_20180922T075619_B04,p2

Value

Low: 0

High' 3831

Low: 0

Output Extent, input the AOI Shapefile.
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2.4 Image Classification

Image classification refers to extracting information from multiband raster. The resulting raster
from image classification can be used to create thematic maps.

2.4.1 Unsupervised Classification

Unsupervised classification works well when the user doesn’t know how many classes are present in
the image. The computer uses the spectral signature to determine which class to place the pixel in.

e Go to Customize > Extensions > Make sure the spatial analyst box is checked.
e Go to ArcToolbox > Multivariate > Iso Cluster Unsupervised Classification.
e Place the Image to be classified in the Input Raster Bands.

Table Of Contents
3983 B 57 150 Cluster Unsupenvised Classification
[ & Layers T
=0 AOL2 Input raster bands Number of classes
(=] ey | |
=0 401 Y
]
1= O Composite_T37PBS_20180922T075619_8021if
RGB
M Red: Band_1
M Green: Band_2

|_JBlue: Band 3

[=1 O Composite T37PBT_20180907T075611_B02,jp2

Number of classes into which to group the cells.

<> Composite_T37PBS_20180922T075619_B02.jp2

RGB
M Red: Band_1 Number of classes
I Green: Band_1 20 ‘
M Blue: Band_1 Output classified raster
151 & Composite T37PBS_20180922T075619_802jp2 [ Ciusers\gichehar\Documents\ArcGIS\Default gdblisoclus] @
RGB

Minimum class size (optional)
M Red: Band_1 ‘ 2 ‘

IH Green: Band_1

Sample interval (optional)

I Blue: Band_1 | ‘ 10 ‘
1 O T37PBT_20180907T075611_802,p2 88 ¥ | vt sgrotre e foptora))
Value ¥ ‘ | @
High: 2574

Low: 1015

[=1 O T37PBT_20180907T075611_8B03 jp2
Value
High: 2765

[ cancel | [Envionments...| [ << e el | [ Tool Help

Low: 973

(=1 O T37PBT_20180907T075611_B04jp2
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20 SPECTRAL CLASSES 100 SPECTRAL CLASSES

Supervised Classification

Supervised classification uses the spectral signatures obtained from training samples to classify an
image. The image interpreter determines the classes and identifies the training samples for different
land cover types. The process involves

Creating training areas

Creating signature file

Classifying the image

Go to Customize > Extensions > Make sure the spatial analyst box is checked.
On the tool bar, make sure the Image Classification is checked.
Create training areas of the following classes

1)
2)
3)
4)
5)

Farms
Shrub land
Bare
Grassland
Built up
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EH Traini g Sample Manager

D Class Name
Shrubl
Barel
Farm1
Grassland1
Bare2
Farms2
Built up1
Build up2
Shrub2
Shrub3
Grassland2
Grassland3
Bare2
Bare3
Farm3
Built up3

N UM A WN -

Ap@rExtuhlzn

Value Color Count
606
128
1504
388
29
1977
1367
1945
9083

Merge the classes using the
Merge Training Sample Icon

e Save the training signature as Training Sites.gsg

To Classify the Image, Use Maximum Likelihood on the classification window

# Maximum Likelihood Classification

Input raster bands

<> Composite_T37FPBS_20180922T075619_B02.jp2

Input signature file

| D:\composite_t37pbs_20180922t075619_b02.gsg

| (]

Output classified raster

[ DA\UNITAR\Training\Sudan_21st to 25th October2018\Ime| @

Reject fraction (optional)

[0.0

Output confidence raster (optional)

v]
A priori probability weighting (optional)
| EQUAL - |
Input a priori probability file (optional)

| [&]

Output confidence raster (optional)

Output confidence raster dataset showing the
certainty of the classification in 14 levels of
confidence, with the lowest values representing the
highest reliability .

It will be of integer type.

| OK | | Cancel | | Environments... | | << Hide Help |

| Tool Help |

e |nput Raster Bands -Input the Image you would like to classify and Input the signature file,
e Then click Ok. An Image will be displayed with the 5 classes.
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Exercise 2.1: Analysis of Elements at Risk

Introduction
In this session, analysis of the elements at risk within the area of interest will be carried out.

Learning Objectives
In this session, the participants will be able to analyse the elements at risk with the area of interest
near Khartoum.

e Understand the geographical extent of area of interest near Khartoum.
e Understand the elements at risk database given.
e Quantitative assessment of the exposed elements at risk within area of interest near

Khartoum.
Data Input
The input data used in this module is,
Description Data path Data Type File Name
Area of Interest X:\Module3\Floods\Exposure | Vector (polygon) TX_2060811_Khartoum_A
Boundary nalysis_Extent.shp
Road Network X:\Module3\Floods\Exposure | Vector (polyline) Roads_Sudan.shp
Settlements X:\Module3\Floods\Exposure | Vector (point) Settelments_Sudan.shp
Land use X:\Module3\Floods\Exposure | Vector (polygon) Landuse_Landcover.shp
Population (Grid) X:\Module3\Floods\Exposure | Raster Sudan_Population_WP.tif
data
Output
Output expected in this session is,
. Types of Roads and their length within the Area of Interest
. Land use categories and their area in sq.km within the Area of Interest.
. Number of Settlements within the Area of Interest.
. Number of Population within the Area of Interest.

Understanding the elements at risk

Open ARC GIS software and add all the data given and view each of the data and answer these
guestions:

Hint: Use Attribute Table tool to answer.

e How many Road types are exiting within the Area of Interest, what are they and what is the total
length of each road category within the Area of Interest?
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e How many settlements exists within the Area of Interest?

e How many land use categories exist within the Area of Interest and what are they and the area of
each land use category?

e What is the range of population within the Area of Interest and total population within the Area of
Interest?

Exercise 2.2 Selection and Download Sentinel-1 data for a Flood Event g

Introduction:

Floods are one of the most, widespread, frequent, and recurring natural disasters. Floods are a
consequence of the increasing frequency of heavy rains, changes in upstream land-use, and a
continuously increasing concentration of population and assets in the flood plains. Floods can occur
anywhere because of heavy rain and can be of different intensities—from small flash floods to sheets
of water engulfing huge areas of land, causing destruction either way.

Over the years, advances have been seen in remote sensing measurements, which are gradually
replacing or compensating in situ measurements. Aerial reconnaissance has been effective for
determining the spatial extent of river flooding in detail for relatively small areas.

Even though the use of image data from optical satellite sensors (like Pan, LISS, etc.) in the visible or
infrared portion of the spectrum is very useful for studying land features, their usefulness is limited
during the rainy season due to cloud cover being visible on the image. On the other hand, the
microwave portion of the spectrum gives cloudless images even during the monsoon season.
Microwave remote sensing data can penetrate clouds, which is important for monitoring flood events
because they commonly occur during periods of extended rainfall or cyclonic storms. However, for most
remote sensing solutions, the revisit frequency (i.e., the time between two measurements in the same
place) is too low for monitoring purposes, or the spatial coverage is limited. Both active and passive
microwave data have been extensively explored for flood monitoring.

In this exercise, you will be exploring the freely available microwave satellite data from the first of the
Copernicus Programme satellite constellation conducted by the European Space Agency, which
consists of two satellites, Sentinel-1A and Sentinel-1B that carry a C-band synthetic-aperture radar
instrument which provides a collection of data in all-weather, day or night.
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Learning Objectives:

The objective of this module is to familiarize with Sentinel-1 satellite data sets for flood studies. After
completing this session, the course participants will be able to download the Sentinel-1 satellite data of
flood affected area and will learn how to use it in the next sessions.

e |dentify an area of interest (AOI) which was flood affected recently (Sudan or your country)
e Search the Sentinel-1 satellite data coverage in the AOI.

e Select and download the Sentinel-1 satellite data for the AOI.

Data Input:
Area of Interest (to be selected by the participants) Example: Abu Hamed, River Nile State, Sudan
was flooded on 29 May 2016.

Output:
Sentinel-1 satellite data covering the AOI

Accessing the Sentinel-1 satellite data

Create a User Account

Go to Copernicus Open Access Hub (https://scihub.copernicus.eu/dhus) . In the top-right of the
web map, click the SIGN UP button. Insert valid entries for your name, email and location. Click
register. Validate your email and Login using the username and password.

Copernicus Open Access Hub SIENUPT OGN @

= Insert search criteria

Nefteyug

N Bereznikiy Serovy,
4 Kirovg {
Yarohvid Perty lehngTa:‘I
Izhevsk  _Yekaterinburg yumen.y
Moscow, Flekirostal Oy ir ”ww =% R
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e Rma" Ulyamvsk‘ L Chelyabinsk-
k3 Bryansk Penza, Samara,  Magnitogorsky i
(e Bering Fsatrecing (Otopiys L SnERS o pes, % e
1 ! o poland opinsk . Pomel . Voronezh Sy Srentaiy
= Leszno i X{ 2 - % e 4 o
Belglim Germany ~_U " oWrxclaw o o Kivg Belgorad, | “Stary Oskol oa hio orad 2
‘ y'e ° ! Kara
Wisioger | Ceoch Republc Ave o Ukraine | Kharkiv Famyshin

° Slovakia Vinyieat
aris {Munich . Vienna, o W lsa
/ ¢ Do elllaxTsi " Voigag

2urich®) *“Kustria Kazakhstan
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§ Astrakhang atyrau
. Romania. ¢

—
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Nukusy Shymkent,
£ o
Dasoguz . Uzbekistan yo 5,

Prorto . o g Bolly 0 : e
IAngrado) J ~ V. “m”e erbaij ; -
} PR Simalde STurkey Turkmenistan:. @ =+
She L i o) Mallorca =) - oS Bingol oy aj
g RS Sins. ©0,. ., Tehran_ ECLTEk e

With a few clicks of the mouse, you will gain access to ESA’s Sentinel data.

Select Your Area of Interest (AOI)
Where is your study area?

Answer:

Using the SEARCH CRITERIA text box in the top-left, type in your area of interest.
Example: Type ‘Sudan’ and Click search option.
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Using the Map Layer option (on right side) you can change the background map / image. Use PAN
option (at the bottom of the screen) to PAN to the area of interest and zoom into the ‘Abu Hamed’ in
North-East Sudan and use BOX option draw a rectangle in the area of interest. (You are free to select
any other area of interest, if you know which area is flooded?)

Click on the top left corner of the search window as shown for the advanced options.

Now select the below given options of selecting suitable data.

Sort by: Ingestion Date

Order By: Descending

Sensing Period: Select 28 May 2016 to 30 May 2016 (if your AOI is different, please select suitable
date)

What is Sensing Period?

Satellite Platform: S1A_*
Product Type: GRD
Sensor Mode: IW

What are these parameters? Explore the Sentinel Product Catalogue at
https://sentinel.esa.int/web/sentinel/missions/sentinel-1/data-products

Click Search option.
From here your search will yield results for all the Sentinel satellite data available (S1A is Sentinel-1A).

Sentinel-1 (Synthetic Aperture Radar C-Band) swaths are depicted in red.
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See the product thumbnails for more details of the search results.

=3 esa Copernicus Open Access Hub
opermicus
? a
~—
Display 1 to 1 of 1 products. SelectAll O &

Order By: Ingestion Date ¥

Request Done: ( footprint:"Intersects(POLYGON((32.56024582622477
18.954221766586272,33.789481554230925
t 18.954221766586272,33.789481554230925

E

ISR X4 s1A_IW_GRDH_1SDV_20160529T033856_20160529T033921_.
=
\ BEE owniosd URL

# Mission: Sentinei-1

% v page:[ 1 [of1 3 close

vodataA 1/Pr

SAR-C Sensing Date: 2016-05-29T(

INg \1-
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As we are working with large data sets, you will have to be patient with download speeds. It's easy for

the server to timeout during the download.

Select the product you want to download. S1A is Sentinel-1A.

Go through the search results and select this Sentinel-1A data (Abu Hmad, North-East of Sudan).

S1A_IW_GRDH_1SDV_20160529T033856_20160529T033921_011468_01178C_73B0.zip

Why this data is selected?

Before downloading, click on the icon ‘eye’ in the selected data window to preview the data, as shown.
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What additional information you can get from this preview window?

Click on Download URL next to the product thumbnail or Download Arrow @bottom right corner to
download the data. Since it will take time to download, we have downloaded the data and provided
for use in this session.

SENTINEL — 1 SAR DATA PRE-PROCESSING

e Download SENTINEL Toolbox

Download and install the latest ESA-SNAP-SENTINEL Toolbox (Open source software from ESA)
Link: http://step.esa.int/main/download/
The webpage will look like this.
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S
science toolbox exploitation platform \\\&\? esa

ESA STEP TOOLBOXES WullWIKeEINl GALLERY DOCUMENTATION COMMUNITY THIRD PARTY PLUGINS

SNAP

Sentinel 1 Toolbox

Sentinel 2 Toolbox
> Download 9
Sentinel-3 Toolbox »

SMOS Toolbox

Proba-V Toolbox Download
Download
Community Here you can download the latest Installers for SNAP and the Sentinel Toolboxes 2018
Useful Links
Data provision Is avallable to all users via the Sentinel Data Hub

Current Version

he current version is 6.0.0 (15.01.2018 15:25 UTC)

Current Version

.
The current version is 6.0.0 (15.01.2018 15:25 UTC). '

Mapping Urban Areas from Space
(MUAS 2018)

For detailed information about changes made for this release please have a look at the
release notes of the different projects: SNAP, S1TBX, S2TBX, S3TBX, SMOS Box, PROBA-V
Toolbox

We offer three different installers for your convenience. Choose the one from the following
table which suits your needs. During the installation process, each toolbox can be excluded
from the Installation. Toolboxes which are not initially installed via the installer can be later
downloaded and installed using the plugin manager. Please note that SNAP and the
individual Sentinel Toolboxes also support numerous sensors other than Sentinel.

Windows 64-Bit Windows 32-Bit ‘ Mac 0S X ‘ Unix 64-bit

ontain the Sentinel-1, Sentinel-2, Sentinel-3 Toolb

Sentinel

Toolboxes Download Download { Download { Download sth Advanced Land Training Course

the SMOS Toolbox.

rih piarer i NGHCDF) 5nd the ke 2017

‘ > Cesa
These installers contain the Sentinel-1, Sentinel-2, Sentinel-3 Toolboxes, SMOS .
and PROBA-V Toolbox + EO OPEN SCIENCE 2017

SMOS Toolbox

Download Download

Download ‘ Download

All T

Download Download ‘ Download l Download

EO Open Science 2017
If you later decide to install an additional toolbox to your installation you can follow this s

step-by-step guide. ° 3 Cesa

Install the downloaded SNAP software for using the downloaded Sentinel-1A satellite data,
downloaded previously.

Displating, exploring and analyzing crisis satellite data for flood water extraction

ORTHORECTIFICATION

In this section you are going to perform the main image processing operation required prior to analysing
an image. The most appropriate software to process Sentinel-1 imagery is the Opensource software
from the European Space Agency (ESA) called Sentinel Application Platform (SNAP) TOOLBOX. This
platform reunites all Sentinel Toolboxes in order to offer the most complex platform for this mission.
The basic functions include: opening a product, exploring the product components such as bands,
masks and tie point grids. Navigation tools and pixel information functionality also represent some of
the basic capabilities.
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e To Open SNAP toolbox, Double Click the SNAP software shortcut on your desktop, which
will be as given below.

M snap O X
File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help Q-
A ) GCP @ ) GCP B B <7
agdtiLsexBwre AN\ RYO R
Product Explorer X | Pixel Info - %
>
3
g
T
L]
2
=)
£
a
z
H
%
1
Maviga... X Colour M... Uncertain... World View  — =
=
L i
2 3
Q H
3
-
N,
<]

e Import the downloaded SENTINEL-1A image
“‘S1A_IW_GRDH_1SDV_20160529T033856_20160529T033921_011468_01178C_
73B0.zip”

(select “.safe” file or “.zip”) from X:\Module_2\Sentinel-1
Please note that SNAP reads automatically .zip files (no need to unzip):

Import the Sentinel-1A data downloaded using File — Import — SAR Sensors — SENTINEL-1 as shown
below.

File| Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help
&CP — GCP
=1 Open Product... o % ?;c == [N ] @§, )?‘_ &

Reopen Product 3

I
4 Product Library &l
| 50122T030752_20150127T030817_004278_005347_CA41

Close Product

Close All Products
Close Other Products

Save Product

Save Product As...
Session 4
Import L3 DEM 4
Export b Generic Formats »
Exit Optical Sensors »
SAR Formats 4
SAR Sensors b ALOS PALSAR CEOS
Vector Data 4 ALOS 2 CEQS
Cosmo-Skymed
ENVISAT ASAR

ER51/2 CEOS
ERS1/2 SAR (1, E2)
JERS CEOS
RADARSAT-1 CEQS
RADARSAT-2
SENTIMEL-1
TerraSAR-X
TanDEM-X
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e Optional Step: Radar > Radiometric > Calibrate

e The most important step after importing the data is to orthorectify the image(not optional!)

Tools Window Help
Apply Orbit File . p [ ? @ & S I
Radiometric 3
Speckle Filtering »
Coregistration 3
Interferometric >
Polarimetric 3
Geometric b Terrain Correction b Range-Doppler Terrain Correction
Sentinel-1 TOPS L3 Ellipsoid Correction 4 SAR Simulation
ASAR WSS L SAR-Masaic SAR-Simulation Terrain Correction
Feature Extraction r ALOS Deskewing
SAR Utilities b Slant Range to Ground Range
Complexto Detected GR Update Geo Reference
Multilooking |

e There are five steps in the Geometric SAR-Simulation Terrain Correction — it is highly
recommended to do as little modification as possible, to make the process faster:

o 1-Read:Choose “Any Format” or “Sentinel-1"under Data Format
o 2-SAR-Simulation: Select “Amplitude VV”

@ SAR-Simulation Terrain Correction X

Read SAR-Smulation CrossCorrelation SARSIm-Terrain-Correction Write

Amplitude_VH
Intensity_VH

|Source Bands:

Intensity_WW
Digital Elevation Model: SRTM 3Sec (Auto Download) v
[DEM Resampling Method: BICUBIC_INTERPOLATION 2

[] Save Layover-Shadow Mask

@ Help [> Run

o 3-GCP-Selection: GCPs can be reduced to a desired value if it fails to find enough
points (default value is 2000). It is advised to leave it as default

GCPs or the Ground Control Points are defined as the points on the surface of the
earth of known location that could be used to geo-reference remotely sensed data

o 4-SARSim-Terrain-Correction: Recommended to leave it as default

o 5-Write. Give a proper Name and Save as: “Geotiff-BigTIFF” and navigate to the
output folder and click Run

¢ Note: Processing can take quite a while, feel free to go grab your cup of coffee and walk
around. However for this exercise the output image (“Post_20160529.tif” ) is provided at
X:\Module_2\Sentinel-1\Input
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Itis the processed image obtained after the orthorectification procedure (terrain correction) and
the speckle filtering.

@& SAR-Simulation Terrain Correction K

Read SAR-Simulation Cross-Correlation SARSim-Terrain-Correction Write
Target Product

Name:
51B_IW_GRDH_15DV_20180507T151540_20180507T151605_010817_013Ca3_FF38_TC
Save as: | GeoTIFF-BigTIFF w

Directory:

EN_ICPAC_GIZ_UMOSAT_2018\Rapid Flood Impact AssessmentiMod-Dls3s4s S\Fractlcal\Input\Rasher\PosnEIoad| o

@ Help [> Run

e |n most RADAR products, one of the must do corrections is to remove speckles (salt and
pepper effect). Again, this step will take few minutes but it is highly recommended. Go to Radar
> Speckle Filtering > Single Product Speckle Filter

@ Single Product Speckle Filte X

File Help

1f0 Parameters  Processing Parameters

Tools Window Help Source Product

source:

y N
Apply Orbit File - v .+ % & E"; g \ [1] S1B_IW_GRDH_15DV_20180507T151540_20180507T151605_010817_013C63... | ...
Radiometric 3
Speckle Filtering » Single Product Speckle Filter Target Product
i 1 Name:
Coregistration Y Multi-temporal Speckle Filter
Interferometric N 516_IW_GRDH_1SDV_20180507T 151540_20180507T 151605_010817_013C63_FF38_TC_Spk
Polarimetric v Save as: | GeoTIFF-BigTIFF v
Geometric » Er=imys
SIS R 2018\Rapid Flood Impact AssessmentMod-D\s3s4s5\Practical\Input\Raster \PostFlood | | ...
entinel-
ASARWSS N Open in SNAP
Feature Extraction 3
SAR Utilities r
Complex to Detected GR
Multilooking Close

e Inthe I/O Parameters tab:

o Select as Source the output image of the SAR-Simulation Terrain Correction

o Give a proper Name and Save as: “Geotiff-BigTIFF” and navigate to the output folder
e Inthe Processing Parameters tab :

o select as Source BandsSigmaO_VV
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o choose Gamma Map Filter, the Filter Size X: 3 and Y:3 can be used. Feel free to
compare with 5x5 and 7x7 as Filter Size

¢ Single Product Speckle Filter *
File Help

10 Parameters Processing Parameters

Source Bands:

Filter: samma Map P
Filter Size ¥ {odd number): 3
Filter Size ¥ {odd number): 3

Estimate Equivalent Number of Looks
Mumber of Looks: 1.0

Run Close

e Click Run and be patient.

e Given that the process may take sometime to be completed, as already stated previously, you
can find the processed image (“Post_20160529.tif") at
X:\Module_2\Sentinel-1\Input

Opening ArcMap and exploring crisis satellite data

Once the image has been processed, before quantitatively analyzing the data, it is important to do a
visual interpretation of the input data available.

e Open the existing ArcMap project (workspace) “Flood_Hazard_Analysis.mxd” stored on:

X:\Module_2\Sentinel-1\Workspace

In the ToC,make sure that “Post_20160529.tif” is turned on.
e For your convenience, a smaller tile is provided for this exercise.
e From theToC,right click on AOI >Zoom to layer

What is the coordinate system of the image?
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HAZARD, VULNERABILITY, AND RISK ASSESSMENT
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3.1 Introduction to Disaster Risk Management (DRM)

Learning objectives
By the end of this module you will be able to:
= Elaborate basic terminologies and concepts in DRM together with Global and Continental
DRM frameworks
= Demonstrate how to undertake hazard assessment and derive some of the indicators
and thresholds on drought and flood hazards
= Grasp methods used to produce drought and flood hazard vulnerability and risk maps

3.1.1 Basic Concepts and Terminologies

The following are some of the common concepts in Disaster Risk Management (DRM)
which are useful to understand DRM as a process. Some of the following materials are
excerpts from Asian Disaster Preparedness Center (ADPC).

1. A disaster occurs when a hazard impacts a vulnerable community causing damage,
casualties and disruption.

2. Vulnerability is a set of prevailing or consequential conditions, which adversely affect
the community’s ability to prevent, mitigate, prepare for and respond to hazardous
events.

3. Capacities are resources, means and strengths, which exist in households and in the
community and which enable them to cope with, withstand, prepared for, prevent,
mitigate or quickly recover from a disaster.

4. Disaster Risk = Hazard x Vulnerability

Capacity

5. Disaster risk reduction includes all measures, which reduce disaster-related losses of
life, property or assets by either reducing the hazard or vulnerability of the elements at
risk or by increasing the capacity of at risk communities.

6. DRM is multi sectoral and Multi-hazard by its very nature

The common definitions given to the main terminologies in DRM are as follows;

The glass & the water in this example are the hazard — In this example, an unstable glass of water
is the hazard threatening our laptop on the table.

The position of the laptop represents the exposure — Exposure in this example is determined by
the position of the laptop right under the shelf: our laptop is situated in a “hazard prone” area.
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The characteristics of the laptop represent its vulnerability — the laptops is vulnerable to water
falling from the glass because it is an electronic device that can be heavily damaged by water. If we
had a plastic bowl on the table, instead of a laptop, vulnerability levels would be much lower, or even
non-existent.

Disaster Risk — The combination of hazard, exposure and vulnerability generates a risk of disaster: if
the glass full of water falls from the shelf, it is likely to spill water on the laptop and, in consequence,
affect the functioning of the laptop, which is very sensitive to water, being an electronic device.

DISASTER

A disaster is a serious disruption on the functioning of a community or a society involving widespread
human, material, economic or environmental losses and impacts, which exceeds the ability of the
affected community or society to cope using its own resources (UNISDR, 2009).

A disaster happens when a hazard impacts on a vulnerable population or community whose capacity
is inadequate to withstand or cope with its adverse effects, resulting in damages, loss and disruption in
community/society functioning. An earthquake in an uninhabited desert cannot be considered a
disaster, no matter how strong the intensities produced. An earthquake is only disastrous when it affects
people, their property and socio-economic activities.

HAZARD

A hazard is a dangerous phenomenon, substance, human activity or condition that may cause loss of
life, injury or other health impacts, property damage, loss of livelihoods and services, social and
economic disruption, or environmental damage (UNISDR -2009).

The hazards of concern to disaster risk reduction as stated in footnote 3 of the Hyogo Framework are,
“hazards of natural origin and related environmental and technological hazards and risks.” Such
hazards arise from a variety of geological, meteorological, hydrological, oceanic, biological, and
technological sources, sometimes acting in combination. In technical settings, hazards are described
quantitatively by the likely frequency of occurrence of different intensities for different areas, as
determined from historical data or scientific analysis. (UNISDR, 2009)

Hazards can be single, sequential or combined in their origin and effects. For example, an earthquake
causes landslides, which dams a river and then causes flooding. A community may be exposed to
multiple hazards when there is simultaneous occurrence of different hazards.

VULNERABILITY

Vulnerability refers to the characteristics and circumstances of a community, system or asset that make
it susceptible to the damaging effects of a hazard. (UNISDR, 2009)

Vulnerability is a set of prevailing or consequential conditions that adversely affect people’s ability
prevent, mitigate, prepare for and respond to hazardous events. These long-term factors, weaknesses
or constraints affect a household’s or community’s ability (or inability) also to absorb losses after a
disaster or to recover from the damage. Vulnerabilities precede disasters, contribute to their severity,
impede disaster response, and may continue to exist long after a disaster has stuck.

Anderson and Woodrow (1989) categorize vulnerabilities into three areas, namely:

1)  Physical/Material Vulnerability:

For example, poor people who have few physical/material resources usually suffer more from disasters
than rich people. People who are poor often live on marginal lands; they don’t have any savings or
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insurance; they are in poor health. These factors make them more vulnerable to disasters and means
that they have harder time surviving and recovering from a calamity than people who are better off
economically.

2)  Social/Organizational:

Experience shows that people who have been marginalized in social, economic or political terms are
vulnerable to suffering from disasters whereas groups that are well organized and in which there is a
high commitment to each other suffer less when catastrophe strikes. Weakness in social and
organizational areas may also cause disasters. For example, deep divisions can lead to conflict and
war. Conflict of resources due to poverty can also lead to violence. The second area of vulnerability
then, is the social/organizational and economic realm.

3)  Attitudinal/Motivational Vulnerability:

Experience also shows that people who have low confidence in their ability to affect change or who
have “lost heart” and feel defeated by events they cannot control, are harder hit by disasters than those
who have a sense of their ability to bring about the changes they desire. Thus, the third area of
vulnerability is the attitudinal and motivational realm.

CAPACITY

Capacity refers to the combination of all the strengths, attributes and resources available within a
community, society or organization that can be used to achieve agreed goals.

Capacity may include infrastructure and physical means, institutions, societal coping abilities, as well
as human knowledge, skills and collective attributes such as social relationships, leadership and
management. Capacity may also be described as capability. Capacity assessment is a term for the
process by which the capacity of a group is reviewed against desired goals, and the capacity gaps are
identified for further action (UNISDR, 2009).

Capacity (in contract to Vulnerability) has been included in disaster management initially as a guide for
both international and local agencies who work with vulnerable communities to link disasters to
development even in emergency situations disaster survivors have capacities. They are not helpless
victims but have coping mechanisms on which to build on for emergency response and recovery. As
the developmental and risk reduction paradigms in disaster management emerged, for many vulnerable
groups, the viable track to reduce vulnerabilities has been by increasing their social/organizational
capacities.

Capacities are resources, means and strengths, which exist in households and communities and which
enable them to cope with, withstand, prepare for, prevent, mitigate, or quickly recover from a disaster.
People’s capacity can also be categorized in the same categories as was done with vulnerabilities in
the previous section.

1) Physical/Material Capacity:

Even the very people whose houses have been destroyed by a typhoon or whose crops have been
destroyed by floods can salvage things from their homes and from their farms. Sometimes they have
food in storage or crops that can be recovered from the fields or farm implements for planting again.
Some family members have skills, which enable them to find employment if they migrate, either
temporarily or permanently.

2) Social/Organizational Capacity:

In most disasters, people suffer their greatest losses in the physical and material realm. Rich people
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have the capacity to recover soon because of their wealth. In fact, they are seldom hit by disasters
because they live in safe areas and their houses are built with stronger materials. However, even when
everything physical is destroyed, people still have their skills and knowledge; they have family and
community organization. They have leaders and systems for making decisions. They have tribal
loyalties or church affiliations. They have capacities in the social and organizational realm.

3) Attitudinal/Motivational Capacity:

People also have positive attitudes and strong motivations such as the will to survive, love and concern
for each other, bravery and willingness to help each other. These are also important capacities, and
form the basis for development just as much as the physical resources that people have. Coping
mechanisms/strategies are generally considered capacities for survival.

DISASTER RISK REDUCTION (DRR)

Disaster Risk Reduction is the concept and practice of reducing disaster risks through systematic efforts
to analyze and manage the causal factors of disasters, including through reduced exposure to hazards,
lessened vulnerability of people and property, wise management of land and the environment, and
improved preparedness for adverse events (UNISDR, 2009).

DISASTER RISK MANAGEMENT (DRM)

Disaster Risk Management is the systematic process of using administrative directives, organizations,
and operational skills and capacities to implement strategies, policies and improved coping capacities
in order to lessen the adverse impacts of hazards and the possibility of disaster (UNISDR, 2009).

PREVENTION

Prevention refers to the outright avoidance of adverse impacts of hazards and related disasters
(ISDR, 2009).

MITIGATION

Mitigation refers to lessening or limiting the adverse impacts of hazards and related disasters (ISDR,
2009). Mitigation can broadly be divided into structural mitigation and non-structural mitigations.
Structural mitigation includes engineering measures such as retrofitting, retaining walls, flood barriers
etc. Non- structural measures include land-use zoning, building codes, construction policies and
bylaws, training on structural mitigations etc.

PREPAREDNESS

Preparedness refers to the knowledge and capacities developed by governments, professional
response and recovery organizations, communities and individuals to effectively anticipate, respond to,
and recover from, the impacts of likely, imminent or current hazard events or conditions (UNISDR,
2009).

EMERGENCY MANAGEMENT

Emergency management is the organization and management of resources and responsibilities for
addressing all aspects of emergencies, in particular preparedness, response and initial recovery steps
(ISDR, 2009).
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RESPONSE

Response is the provision of emergency services and public assistance during or immediately after a
disaster in order to save lives, reduce health impacts, ensure public safety and meet the basic
subsistence needs of the people affected (ISDR, 2009).

RECOVERY

Recovery is the restoration and improvement where appropriate, of facilities, livelihoods and living
conditions of disaster-affected communities, including efforts to reduce disaster risk factors (ISDR,
2009).

DISASTER RESILIENCE

Disaster resilience is the capacity of a system, community or society to resist or to change in order to
obtain an acceptable level in functioning and structure. This is determined by the degree to which the
social system is capable of organizing itself, and the ability to increase its capacity for learning and
adaptation, including the capacity to recover from a disaster.

3.1.2 Disaster Risk Management Process

Disaster Risk Management, as a process can be seen from different points of views; some of these
include processes from the hazard, disaster governance, and disaster cycle points of views. According
to a training manual prepared by ADPC, DRM process in general requires the following:
e Establish the context and build partnerships and rapport based on the mandates and context;
e |dentify the hazards (Hazard Assessment);
e Determine the elements at risk (people and health, property, livelihoods,
Community structures, critical facilities, environment etc.) (Exposure Assessment);
e Determine conditions and factors of vulnerability. Why can the elements at risk be
damaged? (physical, economic, social, motivational reasons) (Vulnerability
Assessment);
e Identify existing coping strategies and capacities/resources (material, human,
institutional/organizational, motivational etc.) (Capacity Assessment);
Assess risks (based on the Hazard, Vulnerability and Capacity Assessment);
Identify measures or solutions to reduce the vulnerability of the elements at risk.
How to protect and strengthen the elements at risk and how to reduce the impact of
the hazard?;
e Prioritize risk reduction measures to undertake: immediate, short-term, medium-
term, long- term;
Implement the risk reduction measures as planned;
Monitor and evaluate the programs

The Disaster Risk Management Cycle takes the form indicated below.
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3.1.3 Global, Continental and National Frameworks/Platforms on DRR
a) The Sendai Framework for Disaster Risk Reduction

The Sendai Framework is a 15-year, voluntary, non-binding agreement which recognizes that the State
has the primary role to reduce disaster risk but that responsibility should be shared with other
stakeholders including local government, the private sector and other stakeholders. It aims for the
following outcome: The substantial reduction of disaster risk and losses in lives, livelihoods and health
and in the economic, physical, social, cultural and environmental assets of persons, businesses,
communities and countries.

The Sendai Framework for Disaster Risk Reduction 2015-2030 (SFDRR) stresses that there has to be
a broader and a more people-oriented preventive approach to disaster risk. DRR practices needs to be
multi-hazard and multi-sectoral, inclusive, and accessible in order to be efficient and effective.
Governments should engage with relevant stakeholders, including women, children and youth, persons
with disabilities, people living under poverty, migrants, indigenous peoples, volunteers, the community
of practitioners and older persons in the design and implementation of policies, plans and standards.

3.1.3.1 Priorities for Action

Priority 1: Understanding disaster risk

Disaster risk management should be based on an understanding of disaster risk in all its dimensions
of vulnerability, capacity, exposure of persons and assets, hazard characteristics and the environment.
Such knowledge can be used for risk assessment, prevention, mitigation, preparedness and response.

Priority 2: Strengthening disaster risk governance to manage disaster risk

Disaster risk governance at the national, regional and global levels is very important for prevention,
mitigation, preparedness, response, recovery, and rehabilitation. It fosters collaboration and
partnership.

Priority 3. Investing in disaster risk reduction for resilience
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Disaster risk governance at the national, regional and global levels is very important for prevention,
mitigation, preparedness, response, recovery, and rehabilitation. It fosters collaboration and
partnership.

Priority 4. Enhancing disaster preparedness for effective response and to “Build Back Better”
in recovery, rehabilitation and reconstruction

The growth of disaster risk means there is a need to strengthen disaster preparedness for response,
take action in anticipation of events, and ensure capacities are in place for effective response and
recovery at all levels. The recovery, rehabilitation and reconstruction phase is a critical opportunity to
build back better, including through integrating disaster risk reduction into development measures.

Based on the experiences from the implementation of the HFA, and in order to reach the targets and
goals, there is a need for focused actions within and across sectors by States, at the local, national,
regional, and global levels in four priority areas. An enabling international environment and means of
implementation are needed to stimulate and contribute to developing the knowledge, capacities and
motivation for disaster risk reduction at all levels, particularly for developing countries.

3.1.3.2 The Seven Global Targets

1. Substantially reduce global disaster mortality by 2030, aiming to lower average per 100,000
global mortality rate in the decade 2020-2030 compared to the period 2005-2015.

2. Substantially reduce the number of affected people globally by 2030, aiming to lower average
global figure per 100,000 in the decade 2020 -2030 compared to the period 2005-2015.

3. Reduce direct disaster economic loss in relation to global gross domestic product (GDP) by
2030.

4. Substantially reduce disaster damage to critical infrastructure and disruption of basic
services, among them health and educational facilities, including through developing their
resilience by 2030.

5. Substantially increase the number of countries with national and local disaster risk reduction
strategies by 2020.

6. Substantially enhance international cooperation to developing countries through adequate and
sustainable support to complement their national actions for implementation of this Framework
by 2030.

7. Substantially increase the availability of and access to multi-hazard early warning systems
and disaster risk information and assessments to the people by 2030.

The Sendai Framework document is provided for you under X:\DATA\Module 3\DRM reading
materials folder.

3.1.3.3 African Programme of Action

Programme of Action for the Implementation of the Sendai Framework for Disaster Risk Reduction
2015-2030 in Africa was crafted in line with the Africa Regional Strategy for Disaster Risk Reduction.
The Program of Action (PoA) details the need to align all DRR activities in the continent of the four
priority areas of the Sendai Framework. The document explains the role of key stakeholders from the
UN to AU and national to Sub-national actors in the implementation of the programme. Issues related
to resource mobilization strategies and monitoring of the progress are all covered.

The document is provided for your additional reading under DRM reading documents folder.

National DRR Platforms
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Countries have been striving to put in place functional institutions and DRR strategies, policies, plans
and acts which are all aimed at reducing the negative impacts of disasters and building the resilience
capacity of their respective communities to Disaster risks. In the region several countries have already
developed national strategies/policies in DRM and this is a very positive step towards resilience building
in the region.

Please discuss and share the status and processes in developing a national strategy for DRM
in your respective countries.

. wae

& STEP(7)

3.2 Hazard, Vulnerability and Risk Assessment

3.2.1 Introduction to Hazard Assessment

According to Caribbean handbook on disaster risk information management, Hazard data is generally
the most difficult to generate. For each hazard type (e.g. Drought, flooding, landslide, etc.) so- called
hazard scenarios should be defined, which are hazard events with a certain
magnitude/intensity/frequency relationship (e.g. flood depth maps for 10, 50 and 100 year return
periods). Different types of modelling approaches are required for the hazard scenario analysis,
depending on the hazard type, scale of analysis, availability of input data, and availability of models.
Generally speaking a separate analysis is required to determine the probability of occurrence for a
given magnitude of events, followed by an analysis of the initiation of the hazard.

Under this section we are going to work on two scenarios on the main hazards in the greater Horn of
Africa region and Sudan namely drought and floods.

3.2.2 Drought Hazard Assessment

Drought is an insidious natural hazard that results from lower levels of precipitation than what is
considered normal. When this phenomenon extends over a season or a longer period of time,
precipitation is insufficient to meet the demands of human activities and the environment. The east
African region is susceptible to recurrent droughts that immensely devastated lives and livelihoods for
millions of people in the region. The drought cycle in the region is cyclical and when strike often
sustained for more than one season which often end up in catastrophic damages both to life and
property. The trend in number of people affected by drought from 1900 to 2015 is given below (Source:
EM-DAT/CRED).
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The American Meteorological Society (AMS) categorizes drought in to meteorological/climatological,
agricultural, hydrological and socio-economic drought. Meteorological drought refers to monitoring
of rainfall conditions and where rainfall is below normal conditions. Meteorological and climatological
drought is defined in terms of the magnitude of a precipitation shortfall and the duration of this shortfall
event. Agricultural drought links the various characteristics of meteorological drought to agricultural
impacts, focusing on precipitation

Shortages, differences between actual and potential evapotranspiration, and soil moisture deficits.
Hydrological droughts are related to the effects of periods of precipitation shortfall on surface or
subsurface water supply, rather than to precipitation shortfalls directly. Socioeconomic drought is
associated with the supply and demand of some economic good with elements of meteorological,
agricultural, and hydrological drought. For monitoring and mapping of drought in the greater horn of
Africa region meteorological and agricultural drought conditions are considered in this training.

Meteorological Drought: Monitoring of the meteorological drought can be done in different ways and
one of the most common ways is the Standard Precipitation Index (SPI). McKee, Doesken and Kleist
(1993) developed the Standardized Precipitation Index (SPI) for the purpose of defining and monitoring
drought. The SPI was designed to quantify the precipitation deficit for multiple time scales, and to reflect
the impact of drought on the availability of different water resources. Soil moisture conditions respond
to precipitation anomalies on a relatively short time scale, while groundwater, stream flow and reservoir
storage reflect longer-term precipitation anomalies. Akinremi, McGinn and Barr (1996) state that the
spatial and temporal dimensions of drought create problems in generating a drought index because not
only must an anomaly be normalized with respect to location, but the anomaly must also be normalized
in time if it is to produce a meaningful estimate of drought; the SPI accomplishes both. It also provides
spatial and temporal drought vulnerabilities from the point of rainfall scarcity.

For you to make meaning to your SPI data there need to set a standard intervals as proposed by the
developers. For now let’s set it to 9 classes as follows;
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Table 1. SPI values

2.0+ extremely wet
1.5t0 1.99 very wet
1.0 to 1.49 moderately wet
-99to .99 near normal
-1.0to -1.49 moderately dry
-1.5t0-1.99 severely dry
-2 and less extremely dry

A regionally blended (observed rainfall with Chirp satellite data) at 5km resolution is used to produce
seasonal SPI for 1984, 2009, 2011 and 2015. One distinct seasons are used in this analysis for the
region and these are March to May (MAM), June to August (JJA) and September to December (SOND).
The MAM is the main rainfall season for GHA countries in the equatorial and some parts in the northern
sectors. JJAS is the main rainfall season for countries in the northern sector. A sample map of SPI at
seasonal scale of greater horn of Africa is given below;
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A sample SPI for Sudan in August 2018 is given below.

NOTE: The weakness of SPI is over estimation in Dry and Desert areas.
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In drought hazard assessment we are going to use two indicators of drought severity, namely the
rainfall anomaly as calculated through SPI and the Vegetation Anomaly as VCI and VHI.

3.2.2.1 SPl based drought hazard assessment

Standardized Precipitation Index (SPI) can be calculated as a function of the difference between current
rainfall condition and Long Term Average (LTA) and normalized by standard deviation of the rainfall for
the years under consideration. World Meteorological Organization (WMO) recommends to use data
from 1981-2010 to calculate long term average.

. =
i‘" STEPS (8): Working with SPI
For this exercise SPI data layers for Sudan are generated please open these layers
by following the steps;
1) Open ArcMap and add the following layers from X:\Module3\Drought folder
=  SPI_JJASO_2009.tif
=  SPI_JJASO_2011.tif
=  SPI_JJASO_2015.tif

2) The black and white images has got values and the symbology can be set manually or
import from the existing *.lyr file. For this exercise we import a symbology.

3) Double click on SPI_JJASO_2009.tif and go to symbology and under show click
classified.

4) Now click on import and go to X:\Module3\Drought folder and select
SPI_symbology.lyr file
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5) Click Ok and now your map view should look something similar to this.
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& STEPS (9):
Calculate Zonal Statistics to produce seasonal meteorological drought hazard map for

districts

1. Add the Sudan_Admin2 layer from X:\Module 1\Admin

2. Go to the main menu in ArcMap Windows >> Search now type Zonal Statistics and

5.

click on Zonal Statistics as a Table

“, Zonal Statistics a5 Table - o x

Irput raster or feathure Tone dats
| Adrmin_lewel 2 :I =

Zone fiekd
Names _
Input valse raster
[SPI_IASD_2009.tif =
Ouatput table
D:\DATASudan_data'Module Ji0utputZonal_statistics.cbf

m

=] lgrome NoData in calculations joptional)

Stabsbcs type (optional) -
MEAN r

o Cancel Emaronments. ... Show Help > >

|

I

Set Sudan_Admin2 as input raster or feature zone data and name_ as zone
field.

Select SPI_JJASO_2009.tif file as input value raster and save the output
table under X:\Module3\Output folder by the name Zonal_Statistics.dbf.

Select MEAN as statistics type and click Ok

Once the processing is completed you should be able to see table added to your table of
content. If you can open the table and see the values you can see which district has the
lowest mean SPI value.

If you wish to produce the drought severity map based on the rainfall anomaly as
measured by the SPI you can follow the following steps;

Now we are going to join two tables Sudan_Admin2 and Zonal statistics using the

common field “names_
6.
/.

Right click on Sudan_Admin2 layer and click on Join and relate >> Join

Select names__ in the first drop down field and Zonal statistics table in the

second and names__ under the third dropdown

Click Ok and you can open attribute table of Sudan_Admin2 and you find that the two
tables are joined. Now we are ready to produce drought severity map of districts based
on the SPI values.

To save the table merge you need to right click on Sudan_Admin2 and export data.
Save it under X:\Module3\Output with the file name Drought_hazard_severity.shp. Your
new map will be added automatically to the table of content.

10. Let’'s produce a drought hazard severity map based on the mean SPI with the
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11. Double click on the Drought_hazard_severity.shp layer and go to symbology
12. Go to Quantities and graduated colors. Now choose MEAN as value field and set the

number of classes to 10.
13. Choose a color (blue to red) and Click Ok

Now you should get a map something similar to this.
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BBl2xn <

48.45 22,

Downloading SPI Data

Standardized Precipitation Index (SPI) can be obtained from ICPAC Data library & Maproom

(http://digilib.icpac.net/). Step by Step on how to access the data is shown below:
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e Open this link (http://digilib.icpac.net/) and click on Data by Source.

&éunitar

[

Climate Data Library

The Data Library is a powerful and freely
accessible online data repository and analysis
tool that allows a user to view, analyze, and
download hundreds of terabytes of climate-

related data through a standard web browsgse

Itis a powerful tool that offers the following o
capabilities at no cost to the user:

access any number of datasets;
create analyses of data ranging from
simple averaging to more advanced EOF
analyses using the Ingrid Data Analysis
Language;

monitor present climate conditions with
maps and analyses in the Maproom;
create visual representations of data,
including animations;

download data in a variety of commonly-
used formats, including GIS-compatible
formats.

h.

'ICPAC Map Room

The maproom is a collection of maps and other figures
that monitor climate and societal conditions at present ~ #=
and in the recent past. The maps and figures can be
manipulated and are linked to the original data. Even if you
are primarily interested in data rather than figures, this is a

1) |good place to see which datasets are particularly useful for

=enionag cuentcondiions

' Data by Source

Datasets organized by source, i.e. creator and/or
provider.

A%

Navigating Through the IRI Data Library: A

The goal of this tutorial is to introduce you to the
structure of the Data Library and the many ways to

Tutorial
i

navigate through it.

[ﬁin*gme‘

[Con(actUs}.

| statistical Techniques in the Data Library: A

Tutorial

Statistical techniques are essential tools for analyzing
large datasets; this statistics tutorial thus covers
essential skills for many data library users.

[ Function Index

Index for functions that can be used to analyze
data within the Data Library.

'Help Resources

The Help Resources include basic and statistics tutorials,

function documentation, and other resources to help you
get the maximum utility out of the Data Library

@)

e Click on ICPAC>>CHIRPS-BLENDED>>monthly>>

Datasets and Variables

ENACTS

Enhancing National Climate Service initiative.

KADI AN

KADI ANTEYTENNDEN 1

Datasets and Variables

CHIRP-BLENDED

ICPAC CHIRP-BLENDEE'._

0recasis
Projections

Datasets and Variables

ICPAC Projections[RCA-MPI ]
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! 1 1
Data lerary T} X} Y}

/{} [ICPAC CHIRPS-BLENDED monthly ra pi [Jan 1981 - Aug 2018 [21 JB3E - 51.48E [11 .85 -23.15N
6

[ Description I Views | Data Filters | Data Selection Data Files | Data Tables | Expert Mode |

-

e Change Time, Longitude and Latitude as shown below
e Then Restrict Ranges > Stop Selecting

Data Selection

You can interactively pick out the data you would like with the Data Viewer.

You can reduce the amount of data by restricting the range of the grids.

Setting Ranges

If you want to restrict the range along a grid. choose here.

Jun 2009 to Oct 2009
21.5E to 39.0E
06.0N to 24.0N

Restrict Ranges

e Click on Data Flies > then Click on GeoTIFF Image as shown below
e Once you are sure of the month, Click on e.g. 200908 GeoTiff for GIS

e Download all the four months to make a season.
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Data Library | T} X} Y}

ICPAC CHIRPS-BLENDED monthly rainfall spi [Jun—Oct 2009 [21.83E -39.03E [5.999999N -23.15N

I Description | Views | Data Filters | Data Selection | Data Files I Data Tablesl Expert Mode |

ICPAC CHIRPS-BLENDED monthly rainfall spi Data Files

This dataset has bytes (4719680 4.5010376MB) of data in it, which should give you a rough idea of the size of any file that you ask for.

(GIS-Compatible Formats

IThere are three GIS-compatible formats available.

2-Dimensional Table A 2-dimensional ascii file that includes an Arcinfo Header

IDA Image File(s} in the Image Display and Analysis format. Typically used with WinDisp.

LAN Image File(s) in the ERDAS LAN format Txeica\\x used with various GIS proqrs;ms including ArcView and F apper
IGeoTIFF Image File in GeoTIFF format. Typically used with various GIS pregrams, including ArcView and ENVI. ‘—J

GeoTIFF Image Format Downloads
(@ ICPAC CHIRPS-RLENDED monthly rainfall spi

p—

Data Library TimeJAug 2009 Jul 2009 | Sep 2009

- 23.156N
Finding Data
Tutorial

Questions and
Answers =

Function
ntation

ICPAC
CHIRPS-
BLENDED
monthly
rainfall spi
dataset

help

Latitude
15'N

10N

25E 30°E 35'E
Longitude

£999999N | auq 2000
2183E 39.038

false color image ¥ || reloads

EOOQOS GeoTiff for GIS i J

3.2.2.2 Vegetation anomaly based drought hazard assessment

Vegetation Condition Monitoring is an important activity and can be done in many different ways. The
Vegetation Health Index (VHI) represents overall vegetation health and it is a combination of Vegetation
Condition Index (VCI) and temperature condition index (TCI). While VCI indicates the short-term
weather-related NDVI fluctuations from the long-term mean, the TCI shows the relative change in
thermal condition of brightness temperature (NOAA Star).

Compared to ground-based and NDVI-based (two-channel algorithm) detection systems, this new
method provides earlier drought warnings. It also makes it possible to estimate areas under droughts
of different severity, and to diagnose the potential for drought development prior to the actual start of
drought conditions. One of the important advantages of this method is that it makes use of a
combination of the normalized difference vegetation index (NDVI), normally used alone, and the 10.3-
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11.3-um thermal channel. Assessment of temperature conditions permits one to identify subtle changes
in vegetation health because the effect of drought is more dramatic if a shortage of moisture is
accompanied by excessive temperatures. This method was validated in all major agricultural countries
around the world. (Kogan 2002)

The VCI and TCI were useful to assess the spatial characteristics, the duration and severity of drought,
and were in a good agreement with the precipitation patterns. (Ghosh 2007). NOAA STAR website
stated that the VHI reflects indirectly a combination of chlorophyll and moisture content in the vegetation
health and also changes in thermal conditions at the surface. This new approach combines the visible,
near infrared, and thermal radiances in a numerical index characterizing vegetation health. This
approach is extremely useful in detecting and monitoring such complex and difficult-to-identify
phenomenon as drought. The VH values below 40 are used for identifying vegetation stress which is
an indirect drought indicator. The VH is very useful for early drought detection, assessing drought area
coverage, duration, and intensity, and for monitoring drought impacts on vegetation and agricultural
crops. Vegetation condition index (VCI). VCI was first suggested by Kogan (1995, 1997). It shows how
close the NDVI of the current month is to the minimum NDVI calculated from the long-term record.

(NDVI-NDVI_, )
VCl, = *100
(NDVI__ — NDVI

min )

Where, NDVImax and NDVImin are calculated from the long-term record (e.g., 18 years) for that month
(or week) and j is the index of the current month (week).

For compositing the weekly VHI values a maximum of the season is calculated and the following map
presents the results for the three seasons from 2009 to 2016 in the atlas map of IGAD/ICPAC. For
compositing the weekly VHI values a maximum of the season is calculated and the following map
[presents the results for the three seasons from 2009 to 2016.

An initiative of the African, Caribbean and Pacific Group, funded by the European Union and managed by GFDRR United Nations Institute for Training and Research
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March to May
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|

June to August

Seasonal Vegetation
¢ Condition

High vegetation stress

September to December l

B 8> I Good vegetation condition
|

T T T T T T T T
2009 2010 2011 2012 2013 2014 2015 2016

Extream vegetation stress

Moderate vegetation stress

Normal vegetation condition

To generate the agricultural drought using VHI the techniques used for SPI are similar except
the range of the values and thresholds
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5"’ STEPS (10):

Classify VHI values to standard classes

1. Open ArcMap and add the following VHI layers from X:\Module3\Drought\VHI folder

e VHI_August_20009.tif
e VHI_August_2012.tif
e VHI_August_2015.tif

2. Now classify the layers. Right click on the VHI_August_2009.tif layer and go to
symbology. Under show click on classified and set the number of classes to 5 and click
on classify to set upper limits of the classes.

3. Set the class interval 20,40,60,80,100 and click Ok
4. Now choose the color range from the color ramp and click Ok.

Your map looks something like this.

@ untitled - ArcMap

DBSE& LABx (0 (& [mm ] EEES0 P,
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
HORCRE - TR MR T Eluno mmm:é,?;\m@ ﬁ;\dmmwelc ) BB o0 R usfictior

dorc| » *a |/ G 3 IS e HIEH

BEINED B EEE - Eaaky
[TableOf Contents B x ,r{»,.”
EBEELE p ALy

B < Layers
£ O Admin_level 2

)
= O Admin_level 0

20- 100
= O VHL_August 2015.tif
<VALUE>
mo-20
[m20-40
[740- 60
16080
20 100
5 O VHL_August 2018.tif
<VALUEs
mo-20
m20-40
[]40- 60
[160- 80
20- 100

j@le| & n <

g Exercise 3.1

Produce the agricultural drought map for August 2015 for all the districts of Sudan
and identify top ten districts under severe vegetation stress conditions during this
month.
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Downloading vegetation Health Index (VHI) data

Vegetation Health Index (VHI) data can be obtained from NOAA’s Advanced Very High Resolution
Radiometer (AVHRR). Note that this is available at 4 km resolution and if higher resolution is needed,
consider to use data from other sources such as MODIS.

e Open the webpage for downloading VHI's from NOAA’'s AVHRR.
ftp://ftp.star.nesdis.noaa.qgov/pub/corp/scsh/wguo/data/Blended VH 4km/geo TIFF/
e Scroll to the bottom of the page (note that this is a weekly data, each TIFF file is for the
entire world, the naming convention includes the year followed by the week). For Example:
P201801 is the first week of January

e Download all the required weeks to average if you need monthly data.

Index of /pub/corp/scsb/wguo/data/Blended VH 4km/geo TIFF/

# [parent directory]

Name Size Date Modified

|| VHP.G04.C07NC.P1981035 SM.SMN tif 290 MB 12/10/15, 3:00:00 AM
|| VHP.G04.CO7TNCP1981035 SM.SMT.tif 213 MB 12/10/15, 3:00:00 AM
|| VHP.G04.CO7NCP1981035 VH.TCLtif 284 MB 12/10/15, 3:00:00 AM
|| VHR.GO4.C0O7NCP1981035 VH VCLuf 280 MB 12/10/15, 3:00:00 AM
|| VHP.GO4.CO7T.NCP1981035 VH.VHLuf 32.1MB 12/10/13, 3:00:00 AM
|| VHP.G04.CO7.NC.P1981036. SM.SMN tif 28 E MB 12/10/15, 3:00:00 AM

I WVHP GO CNT NC P19R103A S SNT 1if " 2MR 121015 3-00-00 AN

3.2.3 Drought, vulnerability and risk assessment

Elements at Risk

One of the most important aspect of vulnerability assessment is to identify the elements that are at risk
of an impending disaster. Depending on the nature of the hazard we can list a number of elements that
can be at risk and in this case we are working on drought hazard. Let’s consider human and livestock
population as two elements at risk to further make a meaning to our hazard and risk assessment. These
information are also key for preparedness, mitigation and response plans.

2

&  STEPS (11):
Human Population Counts from Worldpop Data Layer (100 meter resolution)

1. Load the Sudan_district_population2015 vector layer from X:\Module1\Population folder

2. Double click on Sudan_district_population2015 and go to symbology >> quantities and
import a pop_symbology from X:\Module1\Population folder

3. Now your district population map should look something like this
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Editor ~
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= 0O Admin_level 2

= B Sudan_district_population2013
Pop2015

I 7916.68 - 25000.00
2500001 - 50000.00
50000.01 - 100000.00
100000.01 - 250000.00
250000.01 - 500000.00

I 500000.01 - 750000.00

I 750000.01 - 1288586.41

< >

1. Now load the Drought_hazard_severity.shp layer you produced earlier under Step 10

2. You have hazard and population layers. Now in order to identify population vulnerable to the
drought hazard based on August 2015 SPI values you need to blend these two layers.

3. Right click on Sudan_district_population2015 layer and Join and Relate >> Join

4. Setnames_ as common field and drought_hazard_severity as a table to join with.

5. Click Ok and now open the attribute table of Sudan_district_population2015 and right
click on the field MEAN and Sort Ascending and select all records with SPI value <-100

6. Now go to the Pop2015 field and right click and click on statistics to see the total population
of districts with SPI value at less than — 100. (Total population 5,148,873)

X
{] .
“ Exercise 3.2

1) What is the total population under drought condition at less than -1507?

2) For an emergency response planning there is a need to identify districts that are “Very
Dry” and “Extremely Dry” for this season based on SPI grades. How many people are
in need of humanitarian assistance assuming that 60% of the population are
vulnerable in each of the districts? Hint: Select target SPI grades and calculate the
total population.

Vulnerability

The conditions determined by physical, social, economic and environmental factors or processes,
which increase the susceptibility of a community to the impact of hazards. Some countries are more
vulnerable to a certain hazard than others. Even in one country some regions and districts can be more
vulnerable to a specific type of hazard than the others. This is due to several factors including physical,
economic, social, environmental, cultural...etc. The east Africa region, for instance is vulnerable due to
over dependence on natural resources and primary activity, over reliance on rain- fed agriculture, low
level of development, inadequate institutional and economic capabilities.

Mapping vulnerability requires to look at several factors including those mentioned above and even
more. For now we will be using the following indicators;
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Factor

Indicator

Range/threshold/criteria

Remark

ENVIRONMENTAL

PHYSICAL

Land degradation
(data source: MESA)

Population Density
(data source: Worldpop)

Access to Roads
(data source: Roads/ICPAC)

High, Medium, Low

High, moderate, low

- very poor (>25km)

- Poor Access(20-25km > 4/5hrs)

- Medium Access(15-20km3/4hrs),

- Good Access(120-15km-2hrs)

- Very Good Access (<10km) 1 %
hrs

ECONOMIC

Livelihoods
(data source: FEWSNET)

Level of Poverty

Very highly,
High

low

Very low
Null

Very high (>50)
High (40-50%), Medium (20-
40%) Low (<20%)

You can combine all of these layers to produce a vulnerability map that shows a combined effects of
factors across the country.

e

5-‘-" STEPS (12):

How to Combine Several Layers to Produce Vulnerability Map

Important: Before you start, make sure that all the layers are important indicators and represented with
a correct data. All you GIS data needs to be in raster format and the layers have same number of
classes. It is also important to make sure the number ranking reflects or measures the level of

importance or level of severity for vulnerability.
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>

<

l Level of Poverty '

Ec.

1. Load the following five layers from X:\Module3\Population\\Vulnerability folder
e Pot_land_degradation.tif
e Livelihood_rank.tif
e Population_distribution.tif
e Access to Roads.tif
2. Goto Windows >> Search >> raster calculator. Open rater calculator

3. Add each layer and use multiplication (*) operator to combine all values from all the
layers.

#, Raster Calculator — O *

Map Algebra expression

Layers and variables Conditienal ~

e IIB IEEI
<>Population_dish'ibution.ﬁf Pick
<>Livwalih»::»::I::I_rank.IJ']c Setiull
<>Pot_land_degradaﬁon.ﬁf Math
Abs

Exp

Euemdit

"Pot_land_degradation. tif™ * "Livelihood_rank. tif™ * "Population_distribution. if™ * "Access_to_Roads. tif™

Output raster

D:'\DATAVSudan_data'Module 3YOutputivulnerability_map. tif | @

| oK | | Cancel | |Er‘|\riror1mer1ts... | | Show Help == |

4. Name the output raster as vulnerability_map.tif and save it under X:\Module3\Output
folder and click Ok

5. The values of the pixels indicate level of vulnerability and go to symbology and use
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Vulnerability

Magh : 300

— Low: 1

% Can you explain this map with the necessary precaution for preparedness
planning? What are the strength and weaknesses of this map?.

You can also take this result further to combine it with drought hazard map (SPI) for August 2015 to
produce Drought risk map for Sudan. The poverty and related layers can stand to depict the lack of
capacity indicated in the risk equation.

&
STEPS (13):
How to Produce a Risk Map (Example)

3.2.3.1.1 Riskis afactor of hazard exposure and vulnerability. You have both layers

1. Open the hazard map and vulnerability map from X:\Module3\Risk folder

2. As you can notice the two layers are standardized and classified in to four classes. Now go to
Windows >> Search for Raster calculator and open it

3. Inthe Raster calculator double click on hazard and give it a weight of 0.75 and
click on multiplication (*) sign and double click on vulnerability and multiply
it with 0.25. This is to indicate that the hazard map is by far the important
determining factor (3/4") compared to the vulnerability. This is to say where there
is no hazard vulnerability alone can’t produce a risk.

4. Set the output name to Drought Risk.tif and save it under X:\Module3\Outputs folder and
click Ok to run the operation

5. Now you can open the drought risk layer and classify it in to three natural break classes for
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— Drought_Risk

Augus2015
[ B
Medium
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ﬂ?

k‘ Which districts are at high drought disaster risk for the given month?

3.2.4 Flood Hazard Assessment

Learning Objectives:
e Causes of Floods?
e Whatis a Flood Hazard?
e Flood Hazard Assessment Methods
o Use of Historical data (the past flood approach)
o Hydrological and hydraulic approach (flood modelling)
o Temporal Satellite Data Analysis

e Understand Flash Flood hazard assessment using using Flash Flood Potential Index (FFPI).
e Understand Riverine Flood hazard assessment using GIS Flood Tool (GFT)
e Understand the advantages and limitations of various flood hazard assessment methods

3.3 GLOSSARY

Cross section is the distance perpendicular to the direction of flow

Discharge is the rate of flow of water measured in terms of volume over time (i.e. the amount of water
moving past a point). Discharge and flow are interchangeable.

Flow Accumulation tool calculates accumulated flow as the accumulated weight of all cells flowing
into each downslope cell in the output raster. If no weight raster is provided, a weight of 1 is applied to
each cell, and the value of cells in the output raster is the number of cells that flow into each cell. The
result of Flow Accumulation is a raster of accumulated flow to each cell, as determined by accumulating
the weight for all cells that flow into each downslope cell.
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Flow direction tool calculates the direction water will flow using slope from neighboring cells. This is
usually determined by the direction of the steepest descent in each cell. The result is a raster of flow
direction from each cell to its steepest downslope neighbor.

Flood level is the height or elevation of floodwaters relative to a datum.

Source:Environment and Climate Change Canada

Floodplain is the land adjacent to a river or creek that is periodically inundated due to floods. The
floodplain includes all land that is susceptible to inundation by the probable maximum flood event.

Hydrologically conditioned DEM(Hydro DEM) is a DEM whose flow direction defines expected flow
of water over the terrain (DEM).

Peak flood level, flow or velocity is the maximum flood level, flow or velocity occurring during a flood
Runoff is the amount of rainfall from a catchment that ends up as flowing water in the river or creek.

Watershed is the area where all the water that is under it or drains off of it goes into the same place.

Source: NASA
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Causes of Floods?
Causes of floods can be due to various reasons, such as natural, man-made and Effect of climate
change. These are categorized into,

Natural: Flash floods, Flood, Coastal Flood (due to cyclones/typhoons)

Man-made: Urban development/ drainage congestion, Dam failures, Watershed activities
(deforestation)

Climate Change Effect.

Flood: An overflow or inundation that comes from a river or other body of water and causes or threatens
damage. Any relatively high stream flow overtopping the natural or artificial banks in any reach of a
stream is known as flood.

Flash flood: The result of heavy or excessive amounts of rainfall within a short period of time, usually
less than 6 hours, causing water to rise and fall quite rapidly.

What is a Flood Hazard?

To analyse the nature and mechanisms of flooding including frequency, velocity and magnitude. Floods
need to analyse floods qualitatively and quantitatively with the aim of gaining an understanding of the
nature of flooding to:

* Identify the probability of a flood occurring.

* Identify the specific future time period.

« Identify the area and intensity of impact.

Source: UNISDR, 2004.

Flood Hazard Assessment Methods
Flood hazard assessment can be conducted in various ways depending on the data availability. The
method of carrying out the assessment depends on the information, technology and resources
available. Most commonly used methods are

e |dentifying the probability of flood occurrence
e Flood Modelling (Hydrological and Hydraulic) approach
e Temporal Satellite Data Analysis

Identifying the probability of flood occurrence: The return interval, or return period, places
magnitude of floods in terms of their expected frequency giving a probability of a particular flood
occurring. There are a vast number of methods that can be used to calculate or determine return
intervals based on the data or lack of data available. This is assessed using the historical data of past
flood events and popularly known as flood frequency analysis.

The 100-year flood is a common design flood use delineate floodplains and design structures. Often
there are not enough records to determine the magnitude of the 100-year flood; this must then be done
by empirical extrapolation using frequency distributions (WMO 1999).

Output from the probability of flood occurrence (Flood Frequency Analysis) will be Flood gauge height
for different probability of flood occurrence. Different gauge heights can be used to map flood extents

of different probability of flood occurrences in a GIS environment to delineate flood hazard zones.

An example of flood frequency is shown in box below.
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Flood frequency calculations based on the annual maximum flood series

This method is widely used for determining the probability and return period for floods. Ideally there
should be records for more than 20 years for it to be more representative.

Data Required:
Peak Flood discharge (Q) every year for a particular gauging station Date and time peak discharge

occurred.

Rank the Data set with the largest discharge (Q) volume ranked as 1, second largest as 2, etc.

Q M (rank)
21 1
19 2
14 3
14 4
13 5
9 6
9 7
8 8

Compute the recurrence interval (or return period) of each flood using the formula:
Tr= (N+1)/M
M = rank; N = total number of floods; The units of Tr are years.
When Q =19m/sec, M=2, N=8
Tr=(8+1)/2= 9/2=4.5years

To determine the probability use the formula: P = 1/ Tr

Probability = 1/4.5 = 0.22 probability (22%) for any year that a flood of that size will be equalled or
exceeded.

Note: The probability information (0.22 or 22%) is most useful as it easier for the public to
understand. Using the recurrence interval (4.5 years) may confuse people and lead them to believe
that the flood will only happen at the given intervals.

The relationship between the return period and probability of occurrence, stage / water level and
damage is shown in the figure below.
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Flood Hazard is usually categorized as high, medium and low and very low intensity as per the
magnitude of maximum river discharge return period / probability indicated in the following table.

Table 3.7: Classification of Probability

Flood Hazard Category Return Period (years) Probability (%) of occurrence
High <10 > 0.1
Medium 10 to 50 0.1to 0.02
Low 50 to 200 0.02 to 0.005
Very Low > 200 < 0.005

Source: Review of Flood hazard Mapping, EU, 2008.

Flood Modelling (Hydrological and Hydraulic) approach:

Models can be used to determine the occurrence of floods based on actual or hypothetical rainfall
events. Flood simulation is achieved by combining a hydrological model to predict flood flows with a
hydraulic model to predict inundation levels. Conceptually, hydrologic and hydraulic modelling is shown
in figure below.
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Hydrologic and Hydraulic Modelling

Many hydrologic models exist in literature, however most popularly used models are given here.

Model Web Link Model Description
HEC-HMS /lwww.hec.usace.army.mil/ Hydrologic model which can be used to
software/hec-hms/ generate flood
hydrograph at any selected location in the river
system
HEC-RAS /lwww.hec.usace.army.mil/software | HEC-RAS Version 5.0 has the ability to perform
/hec-ras/ one-

dimensional (1D) and two-dimensional (2D)
hydrodynamic routing within the unsteady flow.

GIS FLOOD Provided to you in this course A software tool for rapid flood inundation
TOOL (GFT) mapping

Note: There are many more models are available. However more easily usable models are given
above.

Components of hydrologic modelling using HEC-HMS to predict flood flows is pictorially shown here.
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Components of Hydrological Model

Components of hydraulic modelling using HEC-RAS to predict inundation levels is pictorially shown
here.

Pre Processing - F 1 ’7 Post Processing
: TR STPVA /) Arc GIS
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Components of Hydraulic Model

Temporal Satellite Data Analysis:

The pre and post flood satellite data is quite useful for assessing the extent of flood. The pre and post
flood satellite data has to be rectified geometrically with a suitable projection system and registered
exactly. Otherwise errors will arise while composing and computation of statistics of flood inundation
areas. Always rectify a satellite scene with respect to a topographic map and use it as a master for all
other scenes so as to maintain the uniformity. The ground control points should be uniformly distributed
over the area of interest so that the registration will be perfect. In case of microwave data the speckle
has to be removed using filters. From experience it is found median filter will suppress speckle to the
satisfactory levels.
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Optical Satellite Data: Optical remote sensors measure the reflectance from objects on the ground.
Pure and deep-water bodies absorb most of the electro-magnetic energy and reflect very little energy.
Flood water, because of different sediment concentrations, reflects considerable energy in different
bands, including near infra-red (NIR) region. The flood water signature generally mixes with cloud
shadow and also with mixed pixels of cloud and cloud shadow. In some cases, it mixes with large urban
areas / built up lands. Flood inundation layer is extracted by various techniques such as visual
interpretation, unsupervised and supervised classification using satellite data acquired in optical
wavelengths. A sample flooded area represented in optical satellite data is shown below.

Flood area represented in optical satellite data

Using this data, either supervised or unsupervised classification techniques is to be used. In case of
supervised classification maximum likelihood classification can be used. Care must be taken to see the
different signature of water are given as training sets since the spectral signature varies with turbidity
of water. After classification check the classification accuracy. Since no ground information will be
available, it is better to overlay the classified layer over the image and check whether the classification
is proper or not. The flood image as well as the pre flood image has to be classified.

Using arithmetic operations the extent of water in the pre-flood image has to be subtracted from the
flood image so as to delineate the inundation due to flood. In this process, all the permanent water
bodies as well as pre Flood River courses will be subtracted resulting net flood inundation.

Microwave satellite data: The advantage of using radar data over the optical data is its ability to
penetrate cloud cover and also data acquisition during day and night. Water surfaces are generally
smooth at radar wavelengths and can be regarded as specular reflectors which yield small backscatter.
Hence, water is regarded as low intensity areas whereas the surrounding terrain corresponds to brighter
intensities, as shown in figure below.

Flood area represented in microwave satellite data
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In case of microwave data, back scatter (db) values have to be computed and the image has to be
classified. If the data is available in full resolution and with all other parameters only, the db values can
be computed. However in case of near real time flood monitoring the data will be received in
compressed format (Radarsat data) through ftp. In such case the data has to be classified using
threshold technique. Intensities below the threshold are regarded as flood or open water, whereas
pixels with intensities above the threshold are regarded as dry land. The threshold will depend on the
contrast between the land and water classes, and generally needs to be set for each SAR scene. The
backscatter depends on the frequency, incidence angle, polarization and is sensitive to the ripples on
the water surface induced by wind waves. The demarcation between water and land is distinct, at higher
incidence angle of 45° and is difficult at 23° incidence angle and may lead to error in classification. This
is because the contrast decreases with decreasing incidence angle.

Thresholding / density slicing technique are used for satellite data acquired in microwave wavelength.
It is most common when the data is classified there will be some scattered pixels will get misclassified
may be due to spectral overlap. These unwanted pixel has to be removed either manually or using
sieving techniques. Especially cloud shadows in optical data and hill shadows in microwave data will
interfere with water delineation. After necessary editing the final inundation layer has to be generated.

Exercise 3.3: Flash Flood Hazard Assessment using Flash Flood Potential Index (FFPI)
What is Flash Flood Potential Index (FFPI)?

Flash flooding is the top weather-related killer, responsible for severe damages including causality of
people in many countries. Although precipitation forecasting and understanding of flash flood causes
have improved in recent years, there are still many unknown factors that play into flash flooding.
Despite having accurate and timely rainfall reports, some river basins simply do not respond to rainfall
as meteorologists might expect. The Flash Flood Potential Index (FFPI) was developed (Smith, 2003)
in order to gain insight into these “problem basins”, giving meteorologists insight into the intrinsic
properties of a river basin and the potential for swift and copious rainfall runoff. Thus, the FFPI can be
added to the situational awareness tools, which can be used to help assess flash flood risk.

The concept of FFPI is fairly simple and the goal is to quantitatively describe a given sub-basin’s risk
of flash flooding based on the process involved acquiring or developing raster (gridded) datasets that
represent the type of physiographic characteristics i.e. slope, land cover, land use and soil
type/texture that influence the hydrologic response and flash flood potential. A relative flash flood
potential index ranging from 1 to 10 was assigned to each data layer based on the layer attributes
associated with the hydrologic response. By indexing a given sub-basin’s risk of flash flooding, the FFPI
allows the user to see which sub-basins are more predisposed to flash flooding than neighboring cells.
The values are unit-less.

This index was created utilizing GIS mapping software to overlay four physical elements that relate to
precipitation runoff. These properties are: slope of the terrain, land cover/use, soil type/texture and
vegetation cover/forest density. These elements were each scaled to create an overall indexed value
that forecasters could use to locate basins that may respond more quickly than expected. An index
value of 1 indicates a minimum flash flood threat and an index of 10 indicates a maximum flash flood
threat.
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The FFPI is composite index value the physiographic characteristics of a basin represented by the
layers of Slope, Soil and Land Cover/Use (L) and Vegetation Cover/Forest Density (V). These datasets
can be compiled from the available local or global datasets. FFPI is composite index value of the layers
of Slope, Soil and Land Cover/Use (L) and Vegetation Cover/Forest Density (V) index maps averaged
together, as given in the equation below by Smith (2003).

(M+L+S5+V)

N
1)
Where: M = Slope; L = Land Cover/Use; S = Soil Type/Texture; V = Vegetation Cover/Forest Density;
N = Sum of weightings.

FFPI =

Calculation of Flash Flood Potential Index (FFFI) for Sudan in ARCGIS.

Data Given:
Data Type of Data/ | Specifications Source Data Path
File Format
Digital Raster / Tif Resolution: 90 m | SRTM X:/Sudan_Data/Module
Elevation 3/Floods/Sudan_DEM.zi
Model (DEM) p
Land Vector / - http://www.fao. | X:/Sudan_Data/Module
Cover/Use Shapefile org/geonetwork | 3/Floods/Sudan_Lulc.zip
/srv/en/main.ho
me
Soil Raster / Tif Resolution: 1 FAO X:/Sudan_Data/Module
Type/Texture Km Harmonized 3/Floods/Sudan_Soil.zip
World Saoll
Database V
1.21
Sudan Admin Vector / - ICPAC X:/Sudan_Data/Module
Boundary (level | Shapefile 3/Floods/Sudan_Admin.
1 and level 2) zZip

Slope (M): Slope is an important component in flash flooding potential, due to the potential for rapid
runoff. Experience suggests that any slope exceeding 30 percent leads to extremely quick runoff and
a rapid response in local creeks and streams. Therefore, the formula below was created to reclassify
percentage slope into an FFPI value, setting any slope of 30% or higher to an FFPI of 10.

Slope index = 10™/3°
)

Where
n = percent slope < 30. If n > 30, then FFPI = 10.

1. Open a blank map in ARCGIS and add DEM.tif.
2. Open ARC Tool Box and Select Spatial Analyst Tools, Surface and Slope tool.
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3. Select DEM.tif as Input Raster, Slope_per.tif as Output Raster, PERCENT_RISE Output
measurement (optional). Select OK to generate Slope map.

4.  As given above the FFPI will change for slope < 30% and > 30%. So convert the slope map
into Slope index using the formula given above using Raster Calculator.

5. Select Spatial Analyst Tools, Map Algebra, Raster Calculator. In Map Algebra Expression
window, write the expression (use the available functional tools) given below.

Con("Slope_per.tif* <= 30,Power(10,"Slope_per.tif"/30),10)

@ sudan - ArcMap = a X

File Edit View Bookmarks |Insert Selection Geoprocessing Customize Windows Help

DRES Bx|oo|db- @ * ¢ Editor - |l 2 Classification~
® Q@ 3l K- T KO LR L sudyAe
Table Of Contents 2 x

4[8]G 8| =
[]<all other values> A
AGG_CODE1
[CIAG
mBs
W HCO
W SCO
W TCO
I URB
. WAT
= 3 G:\GIS_Data\Sudan\sd-lanc
@ O sd-landcover-ge
= 3 G\GIS_Data\Sudan
= [ Sudan
O
= E3 G:\GIS_Data\Sudan\

Value
M High: 10

‘u:ueagﬂ ﬁ“omwg‘u:_[ [

Low:1

= O DEM.tif
Value
High : 2971.03

Low: -30.1424

O Slope_per.tif
<VALUE>
MmO0-30
[ 30.00000001 - 136.63
= O Soiltif

m

v

< >

v
[ ArcToolbox | =] Table Of Contents aBe|en < >
Canceled 38.443 21.725 Decimal Degrees

Land Cover/Use (L) and Vegetation Cover/Forest Density (V): The land cover /use dataset includes
many different components, including biophysical settings, existing vegetation cover (EVC), existing
vegetation height and existing vegetation type. The FFPI uses solely the EVC component because it
was overall the most applicable to flash flood threat assessment. EVC essentially combines vegetation
cover and land use into one composite dataset, using the percentage of canopy cover for tree, shrub
and herbaceous canopy cover.

The land cover data set used is derived from the original raster based Globcover regional (Africa)
archive. It has been post-processed to generate a vector version at national extent with the LCCS
regional legend (46 classes).This database provides a user-friendly interface and advanced
functionalities to breakdown the LCCS classes in their classifiers for further aggregations and analysis.
More details are available at http://www.fao.org/geonetwork/srv/ien/main.home. The shape file's
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attributes contain the following fields: -Area (sqm) -ID -Gridcode (Globcover cell value) -LCCCode
(unique LCCS code). The land use data is assigned appropriate FFPI values based on the literature
review (Zogg and Deitsch, 2013) and given in table 1.The values were subjectively assigned because
it would be extremely difficult to scientifically document the contributions of vegetation to water runoff.
Some of these values were simply assigned based on tree, shrub and herb cover categories.

Table 1: Flash Flood Potential Index value for Land Cover/Use (L) and Vegetation Cover/Forest
Density (V)

Landsue Category (FAO LCCS Categories) PPl
Post-flooding or irrigated croplands (or aquatic) 5
Post-flooding or irrigated shrub or tree crops 55
Post-flooding or irrigated herbaceous crops 5
Rainfed croplands 5
Rainfed herbaceous crops 6
Rainfed shrub or tree crops (cash crops, vineyards, olive tree, orchards...) 55
Mosaic cropland (50-70%) / vegetation (grassland/shrubland/forest) (20-50%) 5
Mosaic vegetation (grassland/shrubland/forest) (50-70%) / cropland (20-50%) 3
Closed to open (>15%) broadleaved evergreen or semi-deciduous forest (>5m) 4
Open (15-40%) broadleaved deciduous forest/woodland (>5m) 3.5
Open (15-40%) need leaved deciduous or evergreen forest (>5m) 35
Mosaic forest or shrubland (50-70%) / grassland (20-50%) 4
Mosaic grassland (50-70%) / forest or shrubland (20-50%) 6
Closed to open (>15%) (broad leaved or need leaved, evergreen or deciduous) shrubland (<5m) 5
Closed to open (>15%) herbaceous vegetation (grassland, savannas or lichens/mosses) 6
Open Grassland 5
Sparse (<15%) vegetation 4
Closed to open broadleaved forest on temporarily flooded land - Fresh water 5
Closed to open (>15%) grassland or woody vegetation on regularly flooded or waterlogged soil - 4
Fresh, brackish or saline water

Closed to open (>15%) grassland on regularly flooded or waterlogged soil - Fresh or brackish 6
water

Artificial surfaces and associated areas (Urban areas >50%) 8.5
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Bare areas 8
Consolidated bare areas (hardpans, gravels, bare rock, stones, boulders) 7
Non-consolidated bare areas (sandy desert) 7
Water bodies 1

Note: FFPI values are assignedto each land use category using Table 1: FFPI values used for EVC
classifications from Zogg and Deitsc (2013). An index value of 1 indicates a minimum flash flood threat
and an index of 10 indicates a maximum flash flood threat.

6. Add Sudan_lulc.shp map to the ARC map window.

7. Select Arc Tool Box Feature to Raster from Conversion Tools, To Raster. Use Sudan_|lulc as Input
Features, select LINDEX (FFPI value for each land use category) as Value Field, provide
lulcIndex.tif as Output Raster Dataset and select slopeindex.tif as cellsize (option). Select OK to
create a Land Cover/Use (L) and Vegetation Cover/Forest Density (V) index map of Sudan.

@ sudan - ArcMap — [m| X

File Edit View Bookmarks |Insert Selection Geoprocessing Customize Windows Help

OpEdal L EB x |9 | b || 10127267 HEE B Editor~ | » %y L | ISH Classification =
iq Qe wrl e [T @ =N, | éi'l.StudyArea 2. Streams | Edit | Stop Editing | Relative DEM | 3.C
Table Of Contents 1 x A
308
B = layers
= O Sudan_Lulc
[
= O sdn_gc_adg
[
= [ Sudanlule
=
= Sudan
O
[ FFPI_Sudan.tif
g
Value
| N
3
4
s
=6
v
| ki
O soil_indextif
= [ SDN_admin1
[
= O SDN_admin2
[
= O SDN_admin3
[
= O buildings
[
O slopeindextif

s Sections =z

yaieag G | Goeeo &
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Soil Type/Texture (S): Sand and clay are very important components of soils when assessing runoff
potential. A soil type consisting of 100% sand will lend very little surface runoff, while 100% clay soils
will maximize runoff. The soil type raster was reclassified according to the equations below into two
new indexed rasters, one for percent clay and one for percent sand. These values were then averaged
to come up with an accurate FFPI.

Below are the equations used to determine the soil type index values for both percent clay and for
percent sand, as well as the equation to determine the FFPI based on those values.

Clay soil type index = IJ.S{(I + ﬁ) (9)}
®3)

Where n = percent clay.

100 —=
Sand soil type index = 0.5 {(1 (l—n))( )}

4

Where n = percent sand.

§ = 0.5(Clay soil type index + Sand soil type index)

©)
8.  Add Soilmap.tif to the Arcamap window.
9. Open Attribute table of Soilmap.tif and identify the attributes which represent the clay
(T_Clay) and sand (T_Sand) percentages?

10. Open ARC Tool Box and select Spatial Analyst Tools, Reclass and Lookup tool. Use clay
percentage attribute to create raster map clay.tif and sand percentage attribute to create
raster map sand.tif.

11. Use the clay.tif map to calculate clayindex using the above formula.

0.5 * ((1 + ("clay.tif" / 100.0)) * 9.0)
12. Use the sand.tif map to calculate sandindex using the above formula.
0.5 * ((1 + ((100.0 - "sand.tif") / 100.0)) * 9.0))
11. Soilindex.tif is calculated using formula,
0.5 * ("clayindex.tif" + "sandindex.tif")

Since soil index map is having a resolution of 1 Km, it is necessary to resample this data to same
pixel size i.e. 90 m, same as other datasets i.e slopeindex and landuse and vegetation index.

12. Select Resample tool from Data Management Tools, Raster and Raster Processing Arc
ToolBox. Select Soil_index.tif as Input Raster, output raster may be soilindex.tif and select
slopeindex.tif as Output Cell Size (option). Select Ok to resample the soilindex map. The
soilindex map is given below.

Note: You will notice that the cell size has changed from 908.5 m to 90.85 m.
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13. Now using the slopeindex.tif, soilindex.tif and lulcIndex.tif maps to create Flash Flood
Potential Index for Sudan, using atc Tool raster calculator.

FFPI = 0.5 * (slopeindex.tif + soilindex.tif + lulcIndex.tif) /3

14. As you observed the minimum and maximum range of FFPI is 1.14 and 4.25. For better
visualization, let us reclassify it into 3 classes (low, moderate and high) using the limits given

below.
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FFPI Class FFPI Min. Range FFPI Max. Range

High 3.0 4.25

Moderate 2.0 3.0

Low 1.14 2.0

Note: The classification ranges are subjective. Share your field experience in deciding them.

15. Use the above range of values to classify the FFPI map of Sudan. FFPI map of Sudan with
above classes is given below.

Q Sudan - ArcMap
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Exercise 3.4: Flood Hazard Assessment (river flood) using GIS Flood Tool
(GFT)

3.3.1 Introduction

The immediate effects of a flood event include loss of life, displacement of large numbers of people,
damaged and destroyed properties and infrastructure. Longer term, the floods lead to outbreaks of
disease, and the destruction of crops causing food insecurity. Displaced residents and the local
authorities must rebuild after every flood event and children are disrupted from schooling as the schools
and other critical infrastructure such as roads and health centers are either inundated or used as relief
centers. Hence it is of high importance for national governments as well as humanitarian actors from
international organizations to be aware of flood prone areas.

The Nile River Basin in Sudan is subjected to regular flooding, especially near the confluence of blue
and white nile. In August 2013, heavy rains in the region led to a massive flood, the worst in the past
25 years causing significant damages in the country. In this practical exercise, you will be running the
GIS Flood Tool (GFT) over the Nile River Basin 90 km downstream from the Blue and White Nile
confluence in Khartoum (Please note that river Nile flows South to North),in order to extract a series of
modeled flood extents. In this exercise, we will use a flood model to simulate the 2013 Khartoum floods
and compare the results with satellite-based data obtained during the flood event.

Source: Bertramz
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3.3.3 About GFT and SRTM-FM dataset:

The GIS Flood Tool (GFT) is a GIS based flood model made by USGS. The implementation of this
flood inundation tools is developed to work with the USGS/UNOSAT’'s SRTM-FM dataset. The
“SRTM-FM” is an extracted hydrological dataset from the CGIAR-CSI's global data v. 4.1 of the
NASA’s SRTM DEM. All the data processing is accomplished using several tools available in ESRI’s
ArcGIS that were mostly automated with coding in Python language (Arcorace M., Rusack E. and
Verdin K.). The SRTM-FM dataset includes: Conditioned DEM for flood modelling, Flow Direction
and Flow Accumulation DEM, Streamlines with Pfafstetter coding, and Catchment areas at 90 m
resolution.

Data Inputs

X:\Sudan_Data\Module 3\Floods\GFT\Input

3.3.4 Setting up the USGS’s GFT tool:
¢ Navigate to the following folder and unzip the file “GFT_Arc10v2.zip”.
X:\Sudan Training\Sudan_Data\Module 3\Floods\GFT\Software

Follow the instructions in the document “GFT for Version 10 Installation Instructions.docxto
install the GFT on your computer.This document explains how to install the tool and enable it in

ArcMap.
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If you have successfully completed the process, you should see the USGS Flooding Tools toolbar
when you open ArcMap. All of the options are currently greyed out.

USGS Flooding Tooks - %

Map Library = About GFT -

3.3.5 Loading Datainto the mxd:

Open a new ArcMap document and save it as “ModA5_s2 GFT.mxd” under the following location:
X:\Module3\Floods\GFT\Workspace

e Click add data button and browse to the following directory

X:\Module3\Floods\GFT\Input\Raster
e Select the following datasets from “SRTM_FM_220_SDN.gdb” and click Add.
e cond_dem (Hydrologically conditioned Digital Elevation Model)
o flow_dir (Coded representation of the direction of flow over the landscape)

o flowacc_km2 (Flow accumulation in the landscape in square kilometers)

T SETR_FH_T30_SDiLpds w | f S 3 M| B SO e

Shift clici lo select all

Mame: exraddirn; T o Mdwiee_lomd

Shven of It pgtpgets, Leyers and Rasults b [F=T]

-Once the three raster layers have been added, the first step in the GFT will be active.Uncheck all
the layers except “cond_dem”.

e Add layers “AOl.shp” and “Gauge_stations_Nile_Khartoum.shp” from
X:\Module3\Floods\GFT\Input\Vector

¢ Right click the layer “AOl.shp” and choose Zoom to Layer.
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e Double click the “AOI” layer’'s symbol and choose an appropiate symbology (e.g.Fill
color:No color; Outline width:1;Outline color;:Red). Repeat the same procedure for the Gauge
stations layer (e.g. Orange triangle).

In this exercise, we are going to make a simple flood modelling simulation using the GFT over this
area of Interest (AOI). The AOI includes a portion of Nile River Basin in the states of Khartoum and
River Nile. As explained in the following pages, we will assume for this AOI that the flow conditions
of the Nile River downstream at the Northen station of the AOI (first gauge station after the Sabaloka
Game Reserve, located in the city of Wad Hamed in Al Matammah province) are the result of the
open waters over the entire drainage areas above the gauge.

e

& STEP (14)
3.3.6  Running the GFT:

Step 1: Define the study area

Click on 1.Study Area in the GFT toolbar.

1. Study Arca |
Map Library | About GFT =

ClickOK on the pop-up window about the python toolbox

A window will appear asking you to select your workspace.

Navigate to the folder X:\Module3\Floods\GFT\Output, and select the folder “GFTOutput” as
your workspace, click Add. All of the outputs from the model will be stored in this folder.

Lok e L Cutped LR R TRy Y-
=GFTOutpt

= Rarsher

=eior

] [ A
how O Pe¥ . gl lmcabion Cameal

The Define Flood Inundation Study Area will then appear. Click on Draw Box Dialog

Define Flood Inundation Study Area

et ofingace || T UHOSAT Toprwg et ¥ o Practa-Didadd GFTC

Croabe Shudy Area

Cowes Bicm sl J
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A pop up window will appear asking you to select the conditioned DEM, the Flow Direction, and the
Flow Accumulation.

SELECT AFILLED OR CONDITIONED DEM TO CLIP TO THE BOX EXTENT
| DAUNOSAT Traring \ModAS a2\ Practca’input \ Raster SATM_FM_220_SON| F ed DEM

SELECT A FLOW DIRECTION DEM TO CLIP TO THE BOX EXTENT
DAUNOSAT\Traning'WodAS 2 Practcalinout \Raster\SATM_FU_220_SON| | Flow Direction

SELECT AFLOW ACCUMULATION DEM TO CLIP TO THE BOX EXTENT
|DAUNOSAT\Trarng ModAS a2 Practcaiout Ao SRT_FM_220_SON| | Piow Accumalot |

Draw Box Extent Tool

e Click on Filled DEM, navigate to “cond_dem” in the following GDB and click Add
X:\Module3\Floods\GFT\Input\Raster\SRTM_FM_220_ SDN.gdb

e Click on Flow direction and add “flow_dir” in the same GDB.

e Click on Flow Accumulation and add “flowacc_km2” in the same GDB.

e Click on Draw Box Extent Tool and draw a box around the AQO” (Click on the top left-hand
corner, holding the mouse button down, and drag the crosshairs down to the bottom right-
hand corner of the square).

e Let go of the mouse when you are at the bottom right-hand corner and the program should
begin clipping the datasets.Clipping the datasets can take few minutes.

Once it is finished you will see three new rasters in your Table of Contents: “Box_CondDEM”,
“Box_FDir”, and “BOX_FAcc”.Uncheck all the other layers. Your screen should look like this:
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3.3.7 Step 2a: Extract the streams

Flow accumulation is calculated using the flow direction raster. The output is a raster with the value
of each pixel signifying the number of upslope cells flowing into it. The flow accumulation threshold
defines the number of how many pixels, or area in kilometers squared, should be flowing into a given
pixel before it is extracted as a stream. The “Streams” step extracts the streams from the Flow
Accumulation raster according to the flow accumulation threshold that you set as input.

e Click on 2.Streams in the USGS Flood Tools Toolbar which should now be active.

e The Streams dialog box will appear. Under Input: Flow Accumulation Threshold enter the
value of 50000.Leave everything else as default and click OK

Wniiong Darediry
[ A RA T T raaing' Mod AT 2T Praschical Cutpef\ GFT Dutpss i

Il Lofadiorsed DM

B CondDEM *
Irgeat: Flow Dirsciion DEM
'pll, & [ - I_'

Irgeat; Flow Appamilsion

Pz, P » [
Inpuat; Flow pumidgtan T hepshad]
e

T

LHENURRISA T T ity M | il Dl T Uil S0P SETel. BN =

Qutped; Fagrad [aphonal]
O UHOSA T T rairing Mo A AT Fractical Dulpel | GFT Dulpa® Flow_A<cum_im I_'

e ] Lol Ereer sovbal Shiww Halg >

The threshold above is in Square Kilometers. What you are telling the program to do is to look at the
flow accumulation raster and extract as streams all of the pixels that have a value of more than 50000
(or in other words: an area of more than 50000 square kilometers flowing into them).

Once the streams tool has stopped running the dialog box will say completed. Click on close

and your screen should look like the picture below when you zoom in a little bit. Switch on
the gauge stations, if it is off.
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Our objective is to model the flood conditions over the AOI based on the river flow conditions at the
gauge located at the outflow point of the modelled river basin. For doing that, we will consider only
the river next to the gauge and we will trigger the simulation using the input data at the Northern
gauge station. For this exercise, we assume that the Nile River at this point is collecting the water
flow derived from open waters over the entire drainage areas above the gauge. Before we can run
the model we need to edit the stream segments according to the objective of our simulation by
deleting parts of the streamlines that we are not interested in.

In the USGS Flood Tools Toolbar, click on Edit,Do not use the “Start Editing” button of the
Arcmap “editor” toolbar!!

1. StudyAru 2. Streams Im

Map Library | About GFT ~

USE ONLY the USGS Flood Tools Toolbar for starting and finishing the streams editing. You can
only delete or split the streams using the ArcMap tools of the “Editor” Toolbox. Do not move them.

e ClickYes to the pop up window.
e You only have to edit the“Streams” layer. Make this layer the only selectable layer.
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The goal of this preliminary flood modeling is to obtain a flood extent estimation of the Nile River
Basin within the assigned AOI. As input data for the GFT model, we will use the discharge value at
the Northern gauge. In order to do that, we will simulate a flood scenario between the confluence of
the Blue and White Nile rivers and the gauge station located 90Km downstream. In particular, we will
not consider all the tributaries upstream and we will delete all segments of the resulted river branch
after downstream the gauge.

e According to this, select the river branch using the Edit tool.

e Once the river has been selected, right click and chooseEdit Verticesfrom the pop up
window.From a single blue line, it should change into a line with several green dots. Make
sure to switch on the gauging station layers, if it is off.

o Delete all existing vertices of the selected line using the Delete Vertextool = found in the
small window that appears. As shown in the picture below, you can delete all the points
downstream the Node 2 by holding the mouse button down and drawing a square that
encompasses all the points.
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OPTIONAL STEP:

After deleting the vertices downstream the Northern gauge, proceed to split the remaining stream
(This is due to substantial changes in the cross section of the two resulting streams). The spliting
point is the gauge station located in the middle of the stream.

e Click on Stop Editing in the USGS Flood Tools toolbar, then click Yesto save the changes.
Do not use “stop editing” button of editor toolbar!!
e Your screen should end up looking like this:

Step 2c: Create the relative DEM

The next step in the GFT is to create the Relative DEM on which the flood modeling will be based.
The relative DEM is essentially a Digital Elevation Model in which the streams have been set to have
zero meters elevation and the elevation of all other pixels is set relative to the stream pixel into which
it flows. The result is a Digital Elevation Model in which all elevation is relative to the stream, hence
the name, Relative DEM.

e Click on Relative DEM in the USGS Flood Tools Toolbar.
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Edit

1. Study Area 2, Streams

Map Library  About GFT ~

e Under Input: Flow Accum Threshold enter 50000. Leave everything else as default.
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e Click OK and this might take few minutes. When the tool finishes running, click Close
e Uncheck all the other raster layers. Your result should now look similar to the one below.
The new DEM is the relative DEM and step 2 is now accomplished.

Step 3: Creating and editing the cross sections
The following step after the creation of the relative DEM is the creation of the river cross section for
each segment of the stream network that we made.

In the USGS Flood Tools Toolbar, click on Cross Sections and enter the length of the cross
section.

1. Study Area | 2, Streams
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Note that the default value of 20 means a cross-sections of approximately 1,800 meters on either
side of the stream segments (the SRTM-FM data has a pixel size of 3-arc-seconds or approximately
90 meters). One cross section will be assigned to each stream. At this step your screen should end

up looking like this:
| LSty A 2 e Rawtos DUV ). Crone Sachmns bt Crome Sectons
Lot A Braton o £ 4y Umy - Maa 97 |

Following these guidelines you can rotate, move and edit the vertices of each cross section using the
ArcMap Editor Toolbar.

e Click on Edit Cross Sections.

1. Study Area = 2. Streams
4. Elevation | 5. Estimated Discharge tage 1 Floods | Map Library © About

e Make this layer the only selectable layer and edit the cross section layer and zoom to
the southern cross section.

e Select Edit Cross Section Click OK when the Elevation button advert appears) and
increase as necessary.

e Click Stop Editing on the USGS Flooding Tools toolbar and click Yes to save the edits.

Step 4: Elevation

After the creation of the cross section the tool will ask you to insert a value for setting the maximum
stage that will be considered for creating the Stage-Discharge relationship over each cross
section.Stage-discharge curves are generated using Manning’s equations.

e Click on 4. Elevation in the USGS Flood Tools toolbar.

USGS Flooding Tools v X

1, Study Area 2, Streams = tdit | Stop Editing | Relative DEM | 3. Cross Sections | Edit Cross Sections

tis l:.ﬂevatton ' Estimated Discharge tege | 7 Floods | Map Library = About GFT ~
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e Set 25 as a default value to the windows that appears asking to set a value in meters.
Click OK to the pop up window that appears.

Step 5: Estimated Discharge
In this step you are going to insert the flow data acquired from the field to the GFT flood modeling. In
general, at this step you should insert the value of discharge values measured during the flood event
at the location of the river gauging station. For this simulation, discharge data at the Northern gauge
station during the August 2013 Sudan floods is not available, thus the discharge value introduced
has been estimated considering average and peak discharge values obtained from various sources
(Around 11,000 CMS). The location of this gauge will be used for this exercise as the location point
of the GFT input flow data in order to trigger the simulation.
This value is for training purposes only
¢ Identify flow accumulation threshold at gauging station:
a) Turn off all the layer in the table of contents except the gauging station and the
“Box_FAcc” layer.
b) Right click the layer “Gauging_station_Nile Khartoum” and click Zoom to Layer.
c) Zoom in around the location of the northernmost gauging station (i.e. at 1:50,000
scale).The map document should look similar to the picture below
d) Click on Identify button in the Tools toolbar. Query the flow accumulation grid
(“Box_FAcc” layer) near the Northern gauge station using the identify tool by clicking on
the closest white pixel to the gauge. Make sure to choose the right layer in the identify
window. Under Identify from: Box_FAcc
e) Take note of the identified pixel value (1,981,062 sq km). This is the drainage area in
square kilometers above the gauge. This value will be used as input parameter (flow
accumulation threshold) for the following steps.

e Click on 5. Estimated Discharge in the USGS Flood Tools toolbar.

1. Study Area | 2. Streams Relative DEM 3, Cross Sections | Edit Cross Sections
4. Elevahovl 5. Estimated Discharge l Map Library  About GFT ~

e Insertthe 11,000 CMS, which is the estimated discharge at this gauge station during the
2013 Khartoum floods. The values used are for training purposes only.
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e Insert the flow accumulation value of 1,981,062 sq. km and click OK in the information pop
up window that appears.

Step 6: Stage
Step 6 is the calculation of all the stages at each cross section.

Click on 6. Stage in the USGS Flood Tools toolbar and launch the process (it will take few
seconds).Click OK in the information pop up window that appears

USGS Flooding Tools v X
1. Study Area 2, Streams t | St ©ng | Relative DEM = 3. Cross Sections = Edit Cross Sections
4. Elevation = 5. Estimated Om:ha Moap Library  About GFT ~

Step 7: Floods
The final step no. 7 is the calculation of the flood inundation extent based on the relative DEM.

e Click on 7. Floods in the USGS Flood Tools toolbar.

USGS Flooding Tools - X
1. Study Area = 2. Streams ! t Relative DEM | 3. Cross Sections | Edit Cross Sections

4, Elevation = 5. Estimated Discharge 6. Sugeap Library = About GFT ~

e Insert the parameters as following and click OK. This process can take few minutes.
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e When the inundation depth raster have loaded, look at the result. Output layers “inun_depth”
(raster of modeled water depth) and “inundation” (raster of inundation extent) will appear in the
Table of Contents.

e Right click on “inun_depth” and choose Zoom to layer.
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3.3.8 Compare modelled extent with flood observation

Once we get the result from the GFT we need to identify the good fit between model and satellite-
based observation.

e Activate the layer “MODIS_20130811_Flood_extent.shp”.

e Compare“inun_depth” (modelled) with “MODIS_20130811_Flood_extent.shp
(observation) and check the accuracy of the model. Use Swipe tool from the Effects
toolbar

If the final results are not satisfactory, repeat the process modifying the estimated values
introduced: Number and length of the Streams, Flow Accumulation Threshold and Elevation (the
values chosen are appropriate for this case study and do not need to be modified as the results will
not vary, unless extreme values are assigned), Manning’s Number, Cross Sections geometry and
Discharge.

*Note that Discharge and flow accumulation values can be modified in the present project by just
clicking and introducing new values, nevertheless GFT does not allow changes to values previous
to step 5. If this is the case, close the ArcMap project and start again.

107



7R\
Konrete el (DN
\ V
e 4

7
ACP-EU Natural Disaster Risk Reduction Program XX %73” un|tar

An initiative of the African, Caribbean and Pacific Group, funded by the European Union and managed by GFDRR United Nations Institute for Training and Research

DISCUSSION

GFT model lets the user to derive flood inundation data in the most simplistic and efficient way. The
results from the model can be utilized to identify the flood risk zones, and potentially contribute
towards better decision making at national and community levels. For instance, there is increasing
evidence that humanitarian actors such as Red Cross and Red Crescent Climate Center and Save
the Children, to name a few, are utilizing flood models to understand the risk and prepare for the
impending hazard.

But like all other mathematical and hydrologic models, it is not without limitations. The accuracy
greatly depends on the identified cross section, resolution of the DEM used, threshold values and
ground knowledge of the user.

In what case would the modelled flood extents be useful? Can you think of any cases where they
should not be applied?

What do you think are the advantages and disadvantages of a model such as the GFT?
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Can you think of any other ways to improve the accuracy of this model? Will using a higher resolution
DEM help?

In your country, what is the highest resolution of DEM available? Can you identify any possibilities to
acquire new data?

«
4

‘ :
2 Exercise 3.5: FLOOD WATER EXTRACTION USING SENTINEL-1 RADAR DATA

Thresholding

Through this process all pixels that belong to a range of pixel values corresponding to the feature
you want to extract are assigned a value 1. All other pixels in the image are assigned avalue 0.

Identification of initial threshold value

For this exercise you will now extract the pixel values likely corresponding to water. Before starting,

e Add “Post 20160529.tif"data into Arcmap ToC. (This is data from Exercise 3.4 output)

e Use the Identify tool @ on the Tools toolbar to view the attribute information of the raster image
including the pixel values corresponding to water, which is the feature you want to extract from
the image (make sure that the concerned raster layer is the selected layer in the Identifytool
Window)

What is the best threshold of pixel values to apply in order to identify and to extract those pixels likely
corresponding to water/flood areas?

Identification of Optimal threshold value

Now that we have an idea of what the threshold value can be, we are going to classify water and not
water pixels. First we are going to calculate the statistics of the raster dataset “Post_20160529.tif” :

e Bring up Arctoolbox by clicking the button
e Go to Data management tools > Raster > Raster properties > Calculate Statistics

e Select the raster dataset “Post_20160529.tif” from the following location:

X:\\Module2\Sentinel-1\Input
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e Click OK

#, Calculate Statistics - a x

Input Raster Dataset
[ _Flood_impact_sssessmilntiMod-0's3s4s5\Practical input\R aster PostFlood \Post_20180507. 6 \I =)

Mumber of Columns to Skip {oponal)
| |
Mumber of Rows to Skip (optional)

| |

Ignore Values (optional)

+
x
T
+
[ Skip Existing (optional)
Area of Interest (optional)
| CalculateStatistics::area_of_interest B
[Jarea_of interest v

cancel | |Environments... | | Show Help >>

This Calculate Statistics operation will allow us to apply classified visualization from the Symbology
tab.

Now that you have identified a suitable threshold of pixel values corresponding to water, you can
start to proceed with the pixel-based classification process using a raster calculator:

e Using the Search toolbox, open Raster Calculator

¢ Inthe Raster Calculator tab, double click on the raster layer‘Post_20160529.tif” and insert
the following mathematical expression using the most suitable identified pixel value
threshold:

“Raster Layer” <= Threshold Value

(Type the numeric value corresponding to the threshold value for water, identified by using
the Identify tool)

e To set the processing extent, click the Environments... >Processing Extent> AOI
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Output raster
| C_GIZ_UNOSAT_ZD18HRapid_Flood_Impact_AssessmentWod-D'ns354‘55'Pracﬁcal\,Ouh:ut'nRaster'nFIood_ext_SOM| B

(0]4 Cancel Environments. .. Show Help ==

e Name the output raster layer as “Flood_ext.tif“and save it in the output raster folder:

X:\Module2\Sentinel-1\Output
Pay attention to add also the extension(e.g. “.tif") in the name of the output raster.
e A new binary raster layer will be added in the ToC: Value 1 is assigned to the pixels values

with similar spectral characteristics corresponding to water (as defined by the formula you
typed in the Raster Calculator), and Value 0 is assigned to the rest of the pixels.

e Use the Swipe Toollﬂavailable from the Effect Toolbar and check your raster analysis
results by comparing the binary raster layer with the original image. To improve your results,
you will probably need to apply different threshold values in the Raster Calculator
and repeat the above process.

If at any point, your raster image is appearing to be completely black:

e Right click on that layer >Properties > Symbology >Under Stretch >Type: Standard
Deviation
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Filtering and convertING extracted flood water from raster to vector
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Filters are used to improve the quality of the raster image by eliminating spurious data or enhancing

and smoothing features in the data.

¢ From the Spatial Analyst tools>click on Neigh

borhood >Focal Statistics

e Select “Flood_ext.tif” as input raster and apply the filter parameters as below:

‘\ Focal Statistics

- O X
= & spatial Analyst Tools Input raster A
& Conditional |RASTER\F\ood_AnaIysis\F\ood_act_SOM‘tif LI ]
% Density Output raster

& Distance [ 7_UNOSAT_2018\Rapid_Flood_Impact

t\Mod-D\s3s4s5 Practical\Output\Raster FocalSt_Flood. i | %

& Extraction
& Generalization
& Groundwater
&y Hydrology

I Circle e I

Meighborhood Settings

& Interpolation Radius

& Local

& Map Algebra Units: @®Cel O Map
&y Math

& Multivariate
£ & Neighborhood
#, Block Statistics

#, Filter

‘\ Focal Flow
‘% Focal Statistics
#, Line Statistics
#%, Point Statistics

Statistics optional)
MAJORITY

Ignore NoData in calculations (optional)

Cancel Environments. .. Show Help =>

e Name the output raster layer as “FocalSt_Flood.tif “ and save it in the output raster folder:

X:\Module2\Sentinel-1\Output
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To convert your final flood analysis result from raster to vector:
e Search for the tool Raster to Polygon

e Add the raster layer from the previous step (“FocalSt_Flood.tif’) and name the vector file to
export as “Flood_ext.shp”

e Choose as output location:

X:\Module2\Sentinel-1\Output

e Uncheck the option Simplify polygons

#, Raster to Polygon - O *
Input raster
|RASTER\FIo0d_AnaIysiS\FocaISt_FIood.tif j Ef-‘

Field {(optional)
Value w |

Output polygon features
| MOSAT_2018\Rapid_Flood_Impact_AssessmelitiMod-D's3s4s 5 Practical\Output\Vector Flood_ext_SOM.shp | E;-

[ Simplify potygons (optional)

oK Cancel Environments... Show Help >>

e Add the exported vector layer to your ArcMap project.
e Right click on “Flood _ext.shp” > Edit Feature > Start Editing

e Right click on the vector layer “Flood_ext.shp” > Open Attribute Table

=

e From the bottom on the Attribute Table Dialog Box, click Table Options " > Select by

Attributes

e Double click on GRIDCODE and type in the following query expression:
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TR —_—r—

SR
y

&unitar

O x
Flood_ext_SOM 4 x
FID Shape * ID | GRIDCODE Select by Attributes. x -~
&7 |Polygon 8 1
28| Polygon 8 0 Enter a WHERE clause to select records in the table window.
T ! Method:  [Create a new seection =
91 Polygon 92 1 “FID
92| Polygon 9 1 e
92| Polygon 84 1 "GRIDCODE" ||
34 Polygon 95 0
95| Polygon 96 1
96| Polygon Erd 1
97 Polygon 88 o - o | [
98| Polygon 99 1
99| Polygon 100 1 > >= | | And
100 | Polygon 101 1
101 Polygon 102 1 < 3= Or
102 Polygon 103 1
103[Polygon | 104 1 —|(f [0 [ Mot
104|Polygon | 105 1
1o [Foygor 106 . Is in | | Nul | | Get Unique Values | Go To
108 |Polygon | 107 1 Sz |_exd_som WHERE.
107 |Polygon | 108 1 "GRIDCODE" =0
108 |Polygon | 108 1
108|Polygon | 110 1
110[Polygon__| 111 1
111|Polygon | 112 1
112 |Polygon 113 1 3
113 Polygon | 114 7 Clear Verfy Help Load ve
114 Polygon 115 [
115 |Polygon 116 1 Apply Close
116 | Polygon 117 1
117 [Dnhennn 112 £l hd
H o4 1T r 0 E /(9433 out of 74687 Selected)
Flood_ext_SOM

Once all the GRIDCODE values = 0 are selected you can delete them (step 4)

.

e Then in the Editor toolbar click on Editor >Save Edits>Stop Editing

e Change the symbology of the layer as desired_(It is recommended to choose Outline Color:
No Color).

e To add a new attribute field to the Attribute Table, open the Attribute Table >Table Options
=l - > Add Field and type-in Class as name and selectText as attribute type

e From the Attribute Table,right click on the field“Class”>Field Calculator and assign to this

attribute field the text label “Flood Water” (type the quotations marks as well):

Table ox
ERAE AL |
Flood_ext_SOM *
— —
FID Shape ID | GRIDCODE Class 1 ~

0[Polygon 2 1 Sort Ascending

1{Polygon 3 1 Sort Descending

2 |Polygon 4 1

2 {Polygon 5 7 Advanced Sorting...

4|[Palygon 6 1

5 [Polygon 7 1

6 |Polygon 8 1

7 [Polygon 9 1 Field Calculator...

&|[Palygon 10 1

3 Polygon Tl T Calculate Ge Field Calculator

10| Palygon 12 1 Turn Field O  Populate or update the values of

11 |Polygon 14 1 this field by specifying a

12 [Palygon 15 1 Freeze/Unfra . \culation expression. If any of

13 [Palygen 18 1 %  Delete Field | the records in the table are

14|Polygon 17 1 currently selected, only the values

15 |Polygen 13 1 [(Af Properties...| of the selected records will be

16 [Polygen 19 1 calculated.

17 |Polygon 20 1 T v

o 0 v 1 [E]S | ©0outof 65254 Selected)

Flood_ext_SOM
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RS A\

Field Calculator ﬁ
Parser
(®) VB Seript (O python . N
Fields: Type: Functions: Table 0 x
FID ) Abs () =
thape (® Number an () BB B
o ) 5tring g;;% ; Flood_ext SOM x
GRIDCODE Obate Fix () FID | shape* | 1D | GRIDCODE Class -
Class {”t() 0 |Palygon 2 7 |Fiood Water
s.nng(()) 1|Polygon 3 7|Flood Water
Sgr( ) h 2 |Polygen 4 1 |Flood Water
Tan{) 3 3| Palygon 5 1|Flood Water
i 4 |Polygon 6 1 |Flood Water
N 5 | Polygon 7 1 |Flood Water
[ Show Codeblock <17 e [+ 2= & | Polygon 8 1 |Flood Water
_ - 7 [Polygen 9 1| Flood Water
= 3|Poly 10 1| Flood Wat
olygon lood Water
it
“Flood Water 3[Polygen 1 1|Flood Water
10 | Polygon 12 1 |Flood Water
11 [Polygon 14 1 |Flood Water
12 |Polygon 15 1 |Flood Water
13 |Polygon 16 1 |Flood Water
14 |Polygon 17 1 |Flood Water
15 [ Polygon 18 1 |Flood Water
E 16 | Polygon 19 1 |Flood Water
i 17 |Polygon 20 1 |Flood Water v
o« 0 v [[EE ]| 0out of 65254 Selected)
About calaulating fields Clear Load... Save... Flood_ext_SOM
o

e . AX

Subtracting Pre flood layer from Post flood Layer

The post flood water also includes the pre flood water such as rivers and lakes. So before calculating
statistics, it is important to subtract the pre-water from post-water. For your convenience, using the
steps above, pre-flood water has been extracted and clipped to the AOI. (You will find the shapefile
in X:\Module2\Sentinel-1\Input).

e Use the tool Erase (Analysis )to remove the pre-flood extent from the post-flood extent,
selecting “Flood_ext.shp” as Input Features and “PreFlood_ext.shp” as Erase Features

e Name the output feature class as “PostFlood_20160529.shp”and save it in the output vector
folder:

X:\Module2\Sentinel-1\Input

"\ Erase - O *
Input Features
| VECTOR\Flood_Analysis\Flood_ext_SOM x| &
Erase Features
| VECTOR\Flood_Analysis\Pre\PreFlood_20180107 x| &
Qutput Feature Class
| \T_2018'Rapid_Flood_Impact_y ntMod-D's3s4s5\Practical\DutputVector \PostFlood _20180507.shp | B-

XY Tolerance (optional)
| Meters ~

Cancel Environments... Show Help ==

Satellite Analysis: estimated flood water extent by affected administrative units

115



. @ [ © GFDRR V,

Aftr
ACP-EU Natural Disaster Risk Reduction Programw‘@y };))w un|tar

An initiative of the African, Caribbean and Pacific Group, funded by the European Union and managed by GFDRR United Nations Institute for Training and Research

Within the immediate aftermath of a disaster, one of the most critical information needed by the
humanitarian actors is to know spatial distribution and estimation of the water extent (in case of
flooding). Using the Search tab, open the tool Intersect

e From the Intersect Dialog Box, select the two layers you want to intersect
(“PostFlood_20160529.shp” and “SDN_adm3_AOIl.shp”) and “NO_FID” as JoinAttributes

e Name the output layer file “Adm3_FloodWater” and chooseas output location:

X:\Module2\Sentinel-1\Output

#, Intersect - m} x
Input Features
RI=]
Ranks +
< PVECTOR \Admin\SOM_adm2_ACI 5
“_*VECTOR Flood_aAnalysis\Post\PostFlood_20180507
< >

Output Feature Class
| JSAT_2018\Rapid_Flood_Impact_Assessment\Mod-D\s3s4s5'Practical\OutputiVector\Adm2_FloodWater.shp | E;

JoinAttributes (optional)
NO_FID v|
XY Tolerance (optional)

Meters ~

Output Type {optional)
[ mpuT |

Cancel Environments... Show Help =

The output file “Adm3_FloodWater” will be automatically added to the ToC:

e Open the Attribute Table and you will notice that all records of the table have now the
corresponding Adminl and Admin2 names, which in this case are Name_1 and Name_2

To calculate the area (sgKm) for each polygon (record):

o=
o T

e From the Attribute Table, clickTable Options
Name and select Double as Field Type

> Add Field... Enter “Flood_sgkm” as

¢ Right click on the field “Flood_sgkm” >Calculate Geometry

e From the Calculate GeometryDialog Box, select the following parameters:
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LA
=

Property: Area ~
Coordinate System

(C) Use coordinate system of the data source:
GCS: WG5S 1984

|

|

|

|

|

|

@

(®) Use coordinate system of the data frame: |
PCS: WGS 1984 UTM Zone 38N I
|

|

|

|

|

|

|

|

Units: Square Kilometers [sq km] ks

Calculate selected records only

About calculating geometry Cancel

Each record of the attribute table “Admin3_FloodWater” will be filed out with the area in square
kilometers. Usingthe Summarize tool in the attribute table, you can summarize the total flood water
for each affected administrative unit.

e Right click on Admin2_Namefield (which in this case is Name_2) in the attribute table, click
Summarize, select the fields to be included in the output table (Area_sq_km and
Flood_sgkm) and check the operations

o Minimum for the field Area_sqg_km(you can alternatively check Minimum, Maximum
or Average and the result will be the same value, as this is a property coming from
admin level2 boundary and not from the intersect of admin level2 boundary and flood
water)

o  Sumfor the field Flood_sgkm.

Summarize X

Summarize creates a new table containing one record for each unique value Summarize creates a new table containing one record for each unique value

of the selected field. slong with statistics summarizing any of the other fields of the selected field, along with statistics summarizing any of the other fields.
1 i marize 1. Select afield to summarize:
DIST_NAME ~ ‘ I DIST_NAME I hd
2. Choose one or more summary statistics to be included in the 2. Choose one or more summary statistics to be included in the
output table: output table:

hape Ar=a - D ”
£ Area_sg_km GRIDCODE
Minimum Class
= Flood_sgkm
[ Average 1 1 Wirimum
] 5um [ Maztimum
[ Standard Deviation [ Averace
 Vatrce
Surf_sq_km T oaraan Deviation
D [ Vanance
= ~rineAne A hd
3. Specify output table: 3. Specify output table:
\Mod-D's3s4s5\Practical"Output \Vector'Flood_Adm2.dof | |2 [{Mod-Ds 35455 Practical\ Output Wector Flood_Adm2 dbf | |24
Summarize on the selected records onfy Summarize on the selected records only
About summarizing data = About summarizing datz oK ot

e Name the output .dbf table as “Flood_Adm?2” and chooseas output location:

X:\Module2\Sentinel-1\Output

Now you can calculate the percentage of flood water for each affected administrative unit within the
AOLI.
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e From the Attribute Table, clickTable Options - - > Add Fields... Enter “Perc_Flood” as
Name and select Double as Field Type
e Right click on the field “Perc_Flood™ Field Calculator

e Inthe Field Calculator Dialog Box, type-in the following formula to obtain the percentage of
flood area by administrative units (Level 2):

“(“Sum_Flood_sgkm”/ “Min_Area_sq_km”) *100”

Field Calculator *
Parser
(®) VB Script (O pythan
Fields: Type: Functions:
o ) Abs ()
(®) Number Am ()
DIST_MAME Cos ()
= 2. . Exp ()
Min_Area_s O pate Fix ()
|| Sum_Flood_ Int ()

Log ()
Perc_Flood "
i 1 Sin ()
)
[]5how Codeblock

Perc_Flood =

{ [Sum_Flood_] / [Min_Area_s] ) . .

About calculating fields Clear Load... Save...
Cancel

3.4 Exposure assessment of elements at Flood Risk

3.4.1 Introduction

In this session, the exposure assessment of the elements at risk co-located within the flood affected
area is assessed.

Learning Objectives
In this session, the participants will be able to combine the flood affected area and the elements at
risk data and assess the exposure of the elements at risk to flood.

1. Understand the geographical extent of pre-flood areas.
2. Understand the geographical extent of post-flood areas.

3. Assess the actual flood extent.
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4. Quantitative assessment of the exposure of elements at risk to flood, within the Area of

Interest.
Data Input
The input data used in this module is,
Description Data path Data File Name
Type

Area of Interest | X:\Module3\Floods\ | Vector TX 2060811 Khartoum_Analysis_Extent.s
Exposure (polygon) | hp

Pre-Flood Area | X:\\Module3\Floods\ | Vector TX_2060811_Khartoum_PreFlood.shp
Exposure (polygon)

Post Flood | X:\Module3\Floods\ | Vector TX 2060811 PostFlood Khartoum.shp
Area Exposure (polygon)

Road Network | X:\\Module3\Floods\ | Vector Roads_Sudan.shp

Exposure (polyline)

Settlements X:\Module3\Floods\ | Vector Settelments_Sudan.shp
Exposure (point)

Land use X:\Module3\Floods\ | Vector Landuse_Landcover.shp
Exposure (polygon)

Population X:\Module3\Floods\ | Raster Sudan_Population_ WP tif

(Grid) data Exposure

Output
Output expected in this session is,

Area of Flood Extent

Length of the road types inundated due to Flood

Land use categories inundated due to Flood

Settlements located in Flood area
e Population affected due to flood

Understanding the elements at risk
e Open ARC GIS software and add all the data given and view the data given.
e Open the Flood Inundation data and view the data and answer the question.
e Calculate the area of the flood extent in sg. Km within the Area of Interest?

Hint: Erase the pre-flood area from post-flood area.
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&  STEP (15)
Assessment of elements at risk exposed to flood

e Overlay Flood extent and road network maps to assess the type and length of the roads
within flood extent. Calculate percentage of road length exposed to floods.

Hint: Use Arc Tool Box Analysis Tools - Overlay - Intersect

e Length of the road types exposed to Flood

Road Type Length of the Road Exposed to Flood (Km)

Total

e Percentage of the Road length exposed to flood?

e Overlay Flood extent and settlements map to assess the number of settlements located
within flooded area. Calculate percentage of settlements located within the flooded area.
Hint: Use Arc Tool Box Analysis Tools a Overlay a Intersect
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e Overlay Flood extent and land use map to assess the land use categories exposed to flood.
Calculate percentage of total land use categories exposed to flood.
Hint; Use Arc Tool Box Analysis Tools - Overlay — Intersect

Land use type Exposed to Flood (sg. Km)
(Grid Code)

Total

e Overlay Flood extent and Population maps to assess the population exposed to flood.
Calculate percentage of population exposed to flood.

Hint: Use Arc Tool Box Spatial Analyst Tools - Zonal - Zonal Statistics as Table and use Statistics
type SUM’
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3.4.2  Flood vulnerability and risk assessment

Flood risk is then normally expressed in terms of the following relationship:

Flood risk = Likelihood of flooding x Consequences of flooding

The assessment of flood risk requires an understanding of where the water comes from
(i.e.the source), how and where it flows (i.e.the pathways) and the people and assets affected
by it (i.e. the receptors). Pictorially it is shown in figure below.

Pathway
e.g. flood defence Receptor

, . Overland
people / housing

,x’“f flooding

-

Source
river

Tt
Groundwater

flooding

Sewer flooding

Figure: Source-Pathway-Receptor Model

Source: From where the water comes? This is addressed in Flood Hazard Assessment, such
as flash flood or riverine or coastal storm surge?

Pathways: How and where it flows? This is also addressed in Flood Hazard Assessment,
which areas are inundated due to flood.

Receptors: The elements at risk such as population, infrastructure, critical facilities and
livelihood which are exposed to floods are considered as receptors.

Likelihood of Flooding which is the flood hazard, explained earlier.

Consequence of flooding is vulnerability of exposed elements at risk to flood hazard.
Exposure assessment of elements at risk is discussed earlier and an exercise was also carried
out. Now we will understand vulnerability of exposed elements at risk.

Flood vulnerability is one of the significant components in risk management and flood damage
assessment. Vulnerability measurement is a complex process because it influenced by
several environmental, economic, and social or even political elements in local scale. In other
words vulnerability is affected by numerous factors such as settlements conditions,
infrastructure, authority’s policy and capacities, social inequities, economic patterns, etc. So
flood vulnerability is varied for people in diverse circumstance.

Human systems are vulnerable to floods due to three vital aspects: Exposure, susceptibility
and resilience. Exposure refers to people and their surroundings and every element present
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in flood prone area being exposed to the flood impacts as a subject to potential losses.
Susceptibility is considered status of people, environment and infrastructure tendency to
influence by a hazard because of fragility of community or ecosystem and resilience, coping
and adaptation ability of a system in addressing disaster stress. Instance the vulnerability of
urban areas is reflection of the exposure and susceptibility of the city to flood risk and the

resilience of that region to cope and recover from the flood effects.

An example vulnerability curve is shown here, which indicates the relationship between flood

depth (m) and percentage of the damage for different types of buildings.

Let us use this vulnerability curve with a building footprint map and assess the flood risk in an

exercise.

1.00 %

090 H

080 4+

m—— DAt - 0% Vry - pew 19,0 & post
1050

—— !r-cohmm-!maa
Tmbar + teo Sorey - age class !

e Tmbar - beo Worey - age claal
—— OOy - O Aoy - pre 1000 &
s
—— XSO - O SO0y « 100030

= prw 1000 & post

3
Flood depths (m)

. 4

Flood Risk Assessment Exercise

Data: Combined building footprint and flood depth map and flood vulnerability curves
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Building footprint map and flood depth map

e Flood Depth categories in the given flood map are:

Flood Depth (m) Color Code in the flood depth map

1.0

15

2.0

e Attribute Table for Buildings with details of material, age class and cost of the building

S.No. ID Material Number of Stories Age class
1 3951 Timber 1 Class 1
2 3959 Timber 2 Class 2
3 3983 Concrete 1 Class 1
4 3985 Concrete 2 Class 1
5 4355 Concrete 1 Class 1

124



B O GFDRR

i-@ ACP-EU Natural Disaster Risk Reduction Program @ S un |ta r
P4 An initiative of the African, Caribbean and Pacific Group, funded by the European Union and managed by GFDRR United Nations Institute for Training and Research
6 4359 Masonry 2 Class 1
7 4366 Masonry 2 Class 1
8 4373 Masonry 1 Class 1
9 4443 Masonry 1 Class 1
10 4449 Concrete 2 Class 1

e Depth - Damage Ratio Curves

020 1+
0.10 {fi—

0007

mox- .
e LD « 0P S200y - 10020
w0 umbar + o Sorey - age class !

7] e trmSar - buo Worey - age clanel

U8 post

Methodology

e Using the building footprint map and flood depth map, find the percentage of damage
to the buildings using the depth - damage ratio curves.
e Using the cost estimate of buildings, calculate the damage ($) for each type of building.

Result: Using the above data calculate the Damage of each type of building and fill up the table.
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Flood Depth (m)

Damage Ratio

Cost of the Building ($)

Damage ($)

1000

1600

7000

10000

7000

6000

6000

3500

3500

10000
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Conclusions based on the analysis:
What is the important information in this analysis, based on your opinion?

To develop a depth-damage curve for Sudan / Khartoum, what data you need to collect and how do
you plan to collect?

&.‘;_:.

&~ STEP (16)

3.5 Hazard Monitoring and Multi-hazard Early Warning Systems

The topics, concepts, and techniques covered under module three above are very important inputs to
hazard monitoring. Some of the major disasters in the Greater Horn of Africa region are slow onset
disasters like drought and some others have rapid onset like earthquake and to some extent floods. If
DRM institutions have the capacity to identify major disasters, put in place key indicators and set
thresholds and finally monitor indicators at a certain time interval, this definitely contribute to a
significant reduction in loss of life and damage to property. The opportune time to put in place all the
preparedness, mitigation and response plans is the time before a disaster strikes. It is far cheaper to
invest in preparedness, mitigation and resilience building as compared to investment required to
respond to and rebuild after a disaster. From the historical disaster data and experience of the region,
disaster is ‘a matter of when and not if’ indicating the need to put in place functional mechanisms to
disaster risk reduction. One of such an important mechanisms to DRR is to put in place hazard
monitoring and early warning systems. Under this section we will be discussing a GIS based techniques
for monitoring two of the major disasters in the region, droughts and floods at a different time scale.

3.5.1 Drought Monitoring for Early Warning
Key indicators and thresholds for drought monitoring

There are several indicators and indices to drought monitoring and a reading material from World
Meteorological Organization (WMO) is provided for your reference under C/DATA/Module3/DRM
readings folder. For this training very relevant global experiences on drought monitoring will be
presented and we will limit ourselves to selected few, leaving the option for you to explore further. The
following table summarizes some selected examples of drought hazard indicators and monitoring from
different parts of the world.
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discharge

Joint Research
Center

Type of Key indicator(s) Institution Web page

Drought

Combined SPI, VHI, Water [National Drought U Oovon Moter . E=d

Drought level, temp., soil |Mitigation Center £ i &

moisture, field data |(USA) < {
S

http://drought.unl.edu/Home.aspx

Combined SPI, Soil moisture, [European

Drought \vegetation anomaly, [Drought

Indicator (CDI) [snow pack, river Observatory -

-
S

edo.jrc.ec.europa.eu/edov2/php/index.php?id=1000

Meteorological,

SPI, soil moisture,

The South Asia

http://dms.iwmi.org/app/

flood monitor

agricultural drought severity Drought
index Monitoring
System
(SADMS)
Sl «})v‘i

Meteorological, [SPI, stream flow, Princeton http://stream.princeton.edu/AWCM/WEBPAGE!/interfa
agricultural, \vegetation, and University: ce.ghg?localezen
hydrological many others African drought & Eag e |

agricultural

Meteorological,

SPI, vegetation
anomaly/condition

ICPAC:
Drought Watch

https /licpac.maps.arcgis.com/apps/CompareAnalysis/|
index.html?appid=622cfedde5304661bf606eacaa65d
7dc

Seasonal and Monthly Drought Monitoring

One of the key point in hazard monitoring is to decide the time scale which depends on nature of the

hazard, temporal resolution required, objectives of the monitoring, in addition to many other factors.
For drought monitoring for instance the common time scales are dekadal (10 days), monthly and
seasonal. For our case we will limit our exercises to monthly and seasonal monitoring of drought for
selected seasons in 2017. In hazard monitoring a threshold value or a reference year/ state/layer is
compared with the season under consideration. The anomaly or difference of these two values can be
calculated in one of the three ways. These are absolute difference (current — reference), relative
difference (current — reference/reference) and standardized difference (current-reference/standard

deviation).

For the purpose of demonstration and exercise, we run seasonal anomaly based drought monitoring

128


http://drought.unl.edu/Home.aspx
http://dms.iwmi.org/app/
http://stream.princeton.edu/AWCM/WEBPAGE/interface.php?locale=en
http://stream.princeton.edu/AWCM/WEBPAGE/interface.php?locale=en
https://icpac.maps.arcgis.com/apps/CompareAnalysis/

.G [ © GFDRR

Aff7
ACP EU Natural Dlsaster Risk Reduchon Program 4»<” un|tar

itiative of the African, Caribbean and Pacific Group, funded by the European Union and managed >/(fDR?UntedNanonsl stitute for Training and Research

4<\—

“tvq_b

\l

(meteorological drought). For that we will follow these procedures:

Choose your season for your country

Prepare seasonal total rainfall data for climatological years (1981-2010) WMO

Calculate Long Term Average (LTA) of your data

Subtract the Long term average from March to May2017 data (MAM2017 — LTA)

=Absolute difference

e Set the result in to reasonable classes to see the areas receiving excess and
deficit for the season as compared to long term average or a reference year.

NOTICE:

e For monthly monitoring you need to calculate monthly long term average
for all the twelve months and calculate the anomaly.

e For monitoring rainfall and vegetation anomaly you can also
consider calculating standardized difference (Current — Long
term average/Standard Deviation)

e Monitoring of drought requires monitoring anomaly at decadal, monthly,
seasonal scales depending on your needs

This is monthly vegetation anomaly map produced in the same way as rainfall anomaly.

VEGETATION ANOMALY
(April-December 2017)

April May June August

December

3.5.2 Multi-hazard Early Warning Systems
Early Warning Systems (EWS) is defined as:

“The set of capacities needed to generate and disseminate timely and meaningful warning information
to enable individuals, communities and organizations threatened by a hazard to prepare and to act
appropriately and in sufficient time to reduce the possibility of harm or loss.” (UNISDR, 2009)

Traditionally, many countries have been reactive to disasters experiencing significant losses in lives
and livelihoods of their citizens. Adoption of the Hyogo Framework for Action (HFA) 2005-2015 by 168
countries has led to a paradigm shift in disaster risk management from emergency response to a
comprehensive approach which also includes preparedness and preventive strategies to reduce risk,
according to WMO. The current Sendai framework (2015-2030) also stressed the need for multi- hazard
early warning system by placing it as one of the seven goals for an effective disaster risk reduction.
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The first of the four priority of the Sendai Framework is understanding risk which by implication is about
hazard assessment, monitoring and early warning to an effective understanding of risk and put all the
necessary mechanisms to prepare, prevent, mitigate and effectively responded to disaster risks.

Early Warning Systems (EWS) are well recognized as a critical life-saving tool for floods, droughts,
storms, bush fires, and other hazards. The recorded economic losses linked to extreme hydro-
meteorological events have increased nearly 50 times over the past five decades, but the global loss
of life has decreased significantly, by a factor of about 10, thus saving millions of lives over this period.
This has been attributed to better monitoring and forecasting of hydro-meteorological hazards and more
effective emergency preparedness, according to WMO report.

From their practice and experience, WMO identified ten common principles that have led to the success
of Early warning systems, irrespective of the political, social, institutional, and economic factors in each
country.

Political recognition. There is a strong political recognition of the benefits of early warning systems,
reflected in harmonized national and local disaster risk management policies, planning, legislation and
budgeting

Common operational components. Each effective system is built upon four components: hazard
detection, monitoring and forecasting; risk analysis and incorporation of risk information in emergency
planning and warnings; dissemination of timely and authoritative warnings; and community planning
and preparedness with the ability to activate emergency plans to prepare and respond, coordinated
across agencies at national to local levels.

Role clarification. Stakeholders are identified, their roles and responsibilities and coordination
mechanisms are clearly defined and then they are documented within national and local plans,
legislation, directives and memoranda of understanding, including those of technical agencies such as
National Meteorological and Hydrological Services.

Resource allocation. EWS capacities are supported by adequate resources (human, financial,
equipment, etc.) across national and local levels, and the system is designed and implemented for long-
term sustainability.

Risk assessment. Hazard, exposure and vulnerability information are used to carry out risk
assessments at different levels, as critical input into emergency planning and development of warning
messages.

Appropriate warnings. Warning messages are: clear, consistent and include risk information;
designed to link threat levels to emergency preparedness and response actions (using color, flags,
etc.); understood by authorities and the population; and issued from a single (or unified), recognized
and authoritative source.

Timely dissemination. Warning dissemination mechanisms are able to reach the authorities, other
stakeholders and the population at risk in a timely and reliable fashion.

Integration into response planning. Emergency response plans are developed with consideration for
hazard/risk levels, characteristics of the exposed communities (urban, rural, ethnic populations, tourists
and particularly vulnerable groups such as children, the elderly and the hospitalized), coordination
mechanisms and various stakeholders.

Integration in relevant educational programme. Training in risk awareness, hazard recognition and
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related emergency response actions is integrated in various formal and informal educational
programme and linked to regularly conducted drills and tests across the system to ensure operational
readiness at any time.

Feedback. Effective feedback and improvement mechanisms are in place at all levels to provide
systematic evaluation and ensure system improvement over time.

A concept note document by UNISDR also recognized early warning as an effective approach for
reducing disaster risk and the loss of life. There has been a paradigm shift from single hazard to multi-
hazard early warning and from providing hazard information to providing risk and impact information.
However, there are gaps in effective implementation of people-centered, multi-hazard warning systems.
In addition, risk knowledge and impact information are often not at all, or insufficiently, integrated into
multi-hazard early warning systems.

The development and hosting of a multi-hazard early warning system for your institution requires all the
technical skills covered under the previous modules of this training, in addition to other capacities like
hardware, resources and so on. However, it is very important to stress the importance of key issues to
a successful early warning system like institutions in disaster governance, multi-sector working
group(s), community participation, selection of appropriate methodology/technology, mainstreaming to
major sectors, partnerships (Government, Non-Governmental actors, Private sector, and Research and
Higher learning institutions. ...etc.) and others.
e Reguiatory Framework /" Agencies "\ =

/ Government Official \
T ) [ Media \

| Desig treact r‘ Business |
= ¥ .\ Residents, Elderly, /

\_ Children Visitors ,

_® Mandate

Institutional
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:f \5.;. Central, Provincial, |
| Local Government J

. Agencies ;

* National Data and
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* Operating System
* Data Analysis Software
* Data Integration Software ===
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: FAX
INTERNET
Ea rth issemination | EMWIN

RANET

pnd Notification
M —
R SADIS

* Models
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* Inundation Impacts _ |

& other
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A functional and end-to-end early warning system requires addressing the following four key
components according to a training material obtained from ADPC. Each of these blocks require detailed
planning and expertise.
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MONITORING &

RISK KNOWLEDGE WARNING SERVICE

Systematically collect data and

undertake risk asssssments Develop hazard monitoring and

early waming services

DISSEMINATION &
CONMMUNICATION RESPONSE CAPABILITY

Bulld national and community
Communicate risk information response capabilities

and early warnings

However, do not forget to start with what you already have in place. One of the good practices in
developing early warning is to understand the major hazards in your country, compiling data from earth
observation and data from the different sectoral ministries and non-governmental offices relevant and
related to hazards and risk.

3.5.3 Components of Early Warning System

There are four components needed for an effective early warning: Detection, monitoring and
forecasting the hazards; Analyses of risks involved; Dissemination of timely warnings - which
should carry the authority of government; Activation of emergency plans to prepare and
respond. These four components need to be coordinated across many agencies at national to local
levels for the system to work. Failure in one component or lack of coordination across them could lead
to the failure of the whole system. The issuance of warnings is a national responsibility; thus, roles and
responsibilities of various public and private sector stakeholders for implementation of EWS should be
clarified and reflected in the national to local regulatory frameworks, planning, budgetary, coordination,
and operational mechanisms.

Component 1: Detection, monitoring and forecasting the hazards

The first part of Module 3 of this training material covers detailed techniques, concepts and steps in
hazard assessment which is meant to detect and identify the hazards. It is this assessment and baseline
data that will constitute the monitoring of hazards based on indicators and thresholds we set for certain
geographical area, as discussed under module 3. Forecasting parameters like rainfall helps to give
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Monitoring based Drought early warning Model based flood early
warning

Sever  Danger m Warning = Normal @ South Fastern Hill 8 Ganges @ Meghna B Brahmaputra Unit (mPWD)
Ruver Rased Map | Division esed Map | istrict Baved Map | Google Map.

Measurement/model based flood early warning (Bangladesh, http://www.ffwc.gov.bd/?id=riv)

Component 2: Analysis of risks involved

Detailed data on what we call “elements at risk” is used to map the scope and extents of the risk involved
during a disaster. In flood hazard and risk assessment, for instance, once all the extent and severity of
the flood is identified the next step is to overlay elements at risk which includes settlement areas, key
infrastructure, crop fields, key grazing areas...etc. The choice of the elements at risk depends on the
nature and magnitude of the hazard, objective of your risk assessment, data availability and other
factors to mapping risk. Once you are able to produce risk maps and able to validate the final product
you should clearly see the elements at risk and level of risks involved. Based on this information, you
should be able to produce early warning information aimed at taking actions that would reduce the risk,
mitigate the impacts, or build the resilience capacity of the communities at risk. Your early warning
information contains several layers of information but needs to be clear on the type and level of risks
involved (to life, property...etc) with coverage/location information, guideline on what to do for the
responders (the community is the first responder), and so on. The experiences from early warning
systems and practices reveals the strong need for people centered early warning systems.
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One of the main features of early warning is timeliness. The more time we give the warning the better
for planning and preparation. The dissemination of early warning information can use different stages
and platforms. Some of these platforms can be summarized as follows; automatic or manual alarms,
text messages, email groups, activation of emergency systems, high level meetings...etc. depending

on the nature (quick onset or slow onset) of the disaster.

New Message

To:

This is an activation of the Middle
Creek Warning System for a dam

faillrc Im lunem' your evacutaio
| ?'I‘an and move away
Middle ka to high ground.

Early Warning Network

1992 2003 9110 ST TTME IO S

Water Level of Babai River at|
Chepang at 2017-08-13 14:00:00 is
falling [8.22 m| and Higher Than
Danger Level

Water Level of Rapti River at Kusum
at 2017-08-12 14:25:00 is falling |
{3.37 m] and Below Warning Level

Water Level of Narayani River at |

at 2033-06-30 19:25:00 is
falling (3.37 m] and Below Waming
return s i
Vadb e ¥ i i Enrs i

Anjan, CSDR, Krishna, PGVS, PGVS Dr. Bha..

/\ EMERGENCY ALERTS

Emergency Alert
BALLISTIC MISSILE THREAT INBOUND TO

HAWAII. SEEK IMMEDIATE SHELTER. THIS IS
NOT A DRILL.

Slide for more

Component 4: Activation of emergency plans to prepare and respond

This is the critical stage of the early warning system where inaction or delayed action in the faces of
looming hazard would result in loss of life and damage to property. Timely early warning system helps
to activate an emergency plan well in time which in turn allows for sufficient time to prepare and

effectively respond to a disaster.
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3.5.4 Monitoring and Forecast Based Early Warning Systems

Monitoring based early warning systems
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The advantage of monitoring based early warning system (EWS), as compared to forecast based EWS
is its higher level of confidence and lesser uncertainty. However, monitoring requires continuous follow

up of the situation starting with historical records.
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Source: Saifeldin Abdulrahman and Ahmed Amdihun, 2017

3.5.5 Forecast based early warning systems

The forecast based early warning system, in this context refers to a situation where daily, decadal,
monthly or seasonal forecast of input parameter is used to deduce about a future situation or develop
a future scenario. For instance, ICPAC produces seasonal forecast of rainfall and temperature and if a
rainfall anomaly is calculated based on this forecast, we can qualify this as forecast based early

warning.

However, it is important to note that both monitoring and forecast based early warning might not have

clear boundary as both might use models and predictors or indices.
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The GHACOF exercise you finalized over the last two days is a forecast based early warning system
which mainly bases on expert opinion and consensus on what to expect for the coming season.
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3.6 Flood Monitoring and Early Warning

Many of low land areas are prone to flooding than highlands, the establishment of flood warning
systems near any major waterway or body of water provides critical information that can protect
property and save lives. Most effective flood warning methods extend beyond the installation of gages
and telemetry equipment, and employ qualified staff and carefully designed procedures to provide the
earliest warning about whether a flood should be expected, when it will occur, and how severe it will
be. This guide offers instruction to individuals, communities, and organizations interested in
establishing and operating flood warning systems.

CELLULAR TELEMETRY
COVERAGE

)

Flood Risk Early Warning

An effective flood warning system is based on the regular collection of rainfall data within the basin,
stream level, and stream flow data. This is achieved through routine monitoring using an automated
communications process by which measurements and other data are collected at remote or
inaccessible points and transmitted to receiving equipment for monitoring, and then disseminating the
warning.

Automated flood warning systems may utilize radio, mobile phones, or satellite telemetry to
communicate with a host computer or network. Most used methods to disseminate the warning are
Global System for Mobile Communications (GSM) and web-based flood monitoring system.

Web-based flood monitoring system

This section will highlight what ICPAC does at regional level in terms of flood early warning. Flood
warning should be location based, specific in time and give the extent of coverage to assist timely
actions to save lives and properties.
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The approach used at ICPAC
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Interaction with ICPAC web-based platform (underdevelopment)
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You can interact with the portal from the link: 41.215.21.156

Dissemination portal — Mike operations (Underdevelopment)

Reference:
Zogg Jeffrey and Kevin Deitsch, 2013. The Flash Flood Potential Index at WFO Des Moines, lowa,
NOAA and National Weather Service Report.
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4 Final Group Exercises (Floods and Droughts)

41.1

Group Exercise on Flood / Drought:

Task: Design and Implementation of Flood / Drought Risk using EO Data
The patrticipants in each group should discuss among themselves and come out of with
answers / make a presentation for the following questions.

1.

Keeping in view of the flood/drought issues in Sudan, design a Flood/Drought Risk
Assessment plan using EO Data and other database.

Develop a work plan to access / download the freely available and required data
(satellite and GIS database) for Sudan.

Generate a work plan for analysis of satellite data for flood / drought hazard
assessment

Develop a work plan for exposure assessment due to flood / drought hazard
Develop strategy for vulnerability and risk assessment of exposed elements for flood
/ drought.

Identify the suitable national institutions/departments/ organizations who can support
the government in defor various components of risk assessment.

Do you see any additional support / requirement to develop a national strategy for
flood and drought risk assessment in Sudan?
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DRAFT PROGRAMME OF THE TRAINING

In-Country Technical Training on Hazard Assessment Using Earth Observation and

GIS for Sudan, 21-25 October 2018, Khartoum, Sudan

Day One: Sunday, 21* October 2018
TIME ACTIVITY Responsible
08:30 - 09:00 Arrival and Registration ICPAC
Welcoming Remarks HAC/IGAD
09.00 - 09:30 Introductions
Training workshop objectives and Expected Outcomes Dr. Ahmed Amdihun
Programme of Work Dr. Hari Prasad
MODULE-1: Introduction to Earth Observation and GIS Dr. Hari Prasad
09:45-10:30 (Theories and Concepts) Mr. Jully Ouma
10:30 - 10:45 Health Break (Group Photo)
Applications of Geospatial Technology in Disaster Risk Dr. Ahmed Amdihun
11:00 - 13:00 Reduction (Flood and Drought) Ms. Rispa Gicheha
HAC Presentation HAC-Representative
13:00 - 14:00 Lunch Break
Mr. Jully Ouma
14:15-15:30 i
Introduction to ArcGIS Ms. Rispa Gicheha
15:30 - 15:45 Health Break
Mr. Jully Ouma
15:45-17:00 Working with Baseline Data in GIS

Ms. Rispa Gicheha

Day Two: Monday, 22" October 2018

TIME ACTIVITY Responsible
08:30 - 09:00 Recap ofday 1 Volunteer

Dr. Ahmed Amdihun
09.00-10:30 Basic Geoprocessing and spatial analysis tools Dr. Hari Prasad
10:30-11:00 Health Break

Dr. Ahmed Amdihun
11:00 - 13:00 Basic Geoprocessing and spatial analysis tools Dr. Hari Prasad
13:00 - 14:00 Lunch Break
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Ms. Rispa Gicheha

14:00 - 15:30 | MODULE-2: Earth Observation Products and Processing | Mr. Jully Ouma
Satellite Image Pre-processing (Download, Composing, Mosaicing
and Clipping)
15:30 - 15:45 Health Break
Satellite Image Pre-processing (Download, Composing, Mosaicing | Ms. Rispa Gicheha
15:45-17:00 Mr. Jully Ouma

and Clipping)

Day Three: Tuesday, 23" October 2018

TIME ACTIVITY Responsible
09:00 - 09:15  Recap of day 2 Volunteer
Image Processing Ms. Rispa Gicheha
09.15 -10:30 (Unsupervised and Supervised Classifications) Mr. Jully Ouma
10:30-11:00 Health Break
Ms. Rispa Gicheha
11:00-13:00 Exercise 2.1: GIS Mr. Jully Ouma
Exercise 2.2: Remote Sensing
13:00 - 14:00 Lunch Break
14:00 - 15:30 | MODULE-3: Concepts and Terminologies in Disaster Risk | Dr. Ahmed Amdihun
Hazard Assessment (Drought)
15:30 - 15:45 Health Break
15:45-17:00 Hazard Assessment (Drought) Dr. Ahmed Amdihun
Mr.Jully Ouma
Day Four: Wednesday, 24® October 2018
TIME ACTIVITY Responsible
09:00 - 09:15 Recap of day 3 Volunteer
09.15-10:30 Dr. Ahmed Amdihun
Drought Vulnerability and Risk Mapping Mr. Jully Ouma
10:30-11:00 Health Break
11:00-13:00 Drought Vulnerability and Risk Mapping Dr. Ahmed Amdihun
Mr. Jully Ouma
13:00 - 14:00 Lunch Break
14:00 - 15:30 Hazard Assessment (Floods) Dr. Hari Prasad
Ms. Rispa Gicheha
15:30 - 15:45 Health Break
15:45-17:00 Flood Hazard Assessment Dr. Hari Prasad

Ms. Rispa Gicheha
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TIME ACTIVITY Responsible
09:00 - 09:15  Recap of day 4 Volunteer
09.15-10:30 Flood Vulnerability and Risk Assessment Dr. Hari Prasad
10:30-11:00 Health Break
11:00 - 12:15 Flood Vulnerability and Risk Assessment Dr. Hari Prasad
(Theory and Exercises)
12:15-13:00
Hazard Monitoring and Multi-hazard Early Warning Dr. Ahmed Amdihun
Systems
(Presentation and Discussion)
13:00 - 14:00 Lunch Break
14:00 - 15:30 Dr. Ahmed Amdihun
Final Group Exercise Dr. Hari Prasad
(Droughts and Floods using real life examples - Remote sensing, GIS, Hazard/Risk Assessment) Mr. ]u]]y Ouma
Ms. Rispa Gicheha
15:30 - 15:45 Health Break
15:45-17:00 Discussion and Way forward HAC
IGAD
Closing Remark Participants
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